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Speedstack specifications

Maximum layer count
Via rules
Materials library

Post press compensation
Finished thickness compensation
Cu thickness calculation

Board thickness calculation
Design rules check

Si8000m/Si9000e integration
Flex-rigid modelling

Controlled impedance structures

Symmetrical stacks

Loss/Frequency dependent
modelling/graphing

Frequency dependent calculations
(causal interpolation of dielectric
constant)

Result presentation
Display series

Surface roughness compensation
User library

Save builds

File import

File export

64+
Conventional, blind and buried

Foils, Cores, RCC foils, Non-copper cores,
Prepregs, Solder masks, Flexible cores, Bondply,
Adhesive, Coverlays, Ident inks, Peelable masks

Yes (user defined)

Copper coverage/simple percentage
Yes

Yes

Design logic, symmetry, copper balance, board
thickness, manufacturing tests, resin starvation

Bi-directional copy/paste structure parameters

Mesh/crosshatch ground plane modelling in
conjunction with Si8000m/Si9000e

110 structures supported with impedance goal
seeking and structure validation

Structure mirroring for symmetrical stacks

Differential, Odd mode, Even mode graphed over a
user-specifiable frequency range

Single frequency Er causal modelling using
interpolation of Er v frequency employing
Svensson-Djordjevic method

Length of line, Inches, Metres

All Losses, Impedance Magnitude, Inductance,
Resistance, Capacitance, Conductance, Alpha,
Beta

Smooth, Hammerstad, Groisse, Huray
Online and on premises
Yes

IPC-2581 Rev B, Ucamco Job file, Ucamco
Integr8tor and Ucam (.ssx), XML, Zuken CR-8000

CGen Coupon Generator, CITS File, DXF, Gerber,
Stackup Image (JPEG, BMP, TIFF), Cadence
Allegro (IPC-2581 Rev B), CSV, IPC-2581 Rev B,
Mentor Graphics, XML file, Zuken CR-8000,
Zuken DFM Center, Ucamco Integr8tor and Ucam
(.ssx),
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Personal computer requirements

Computer IBM PC compatible

Processor Pentium 1GHz or better

Operating system Windows 7 or later

Environment Requires .NET Framework v2.0 or above

System memory required 2GB recommended

Hard disk space required 200MB (min.)

Video standard FHD (1920 x 1080*) recommended
2 FHD (1920 x 1080*) monitors recommended for
Speedstack

* Note: refers to effective resolution (some
systems automatically apply scaling to render text
readable — i.e. effective resolution refers to the
screen resolution after scaling.)

Licensing Electronic: local FlexNet license
Fixed: Parallel/USB key

Floating FlexNet license
(Windows servers only)
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Guide to the manual

Introduction

Getting started with
Speedstack

Configuring Speedstack

Using Speedstack

Design rule checking

Adding controlled impedance
structures

Frequency dependent
calculations (Speedstack Si)

Si Projects

CITS test files
Speedstack Flex
Speedstack HDI

The Speedstack materials

libraries

Printing stackup reports

Introduces Polar Instruments Speedstack.

Steps through the process of creating a simple stack
from a set of manufacturer's data.

Setting up the Speedstack environment including
license options, crosshatch and structure defaults, goal
seeking parameters and file locations.

Discussion of the Speedstack user interface; creating
and editing stackups.

Using Virtual Material mode; using Material Library
mode

Using the Speedstack Design Rule Checker to correct
stackup design errors.

Working with the Si8000m/Si9000e field solvers to add
controlled impedance structures to the stackup model.
Using the goal seeking facilities of the field solver to
obtain the correct impedance for a structure.

Working with frequency dependent calculations to
produce graphs and tables of insertion loss v frequency
for each stack substrate.

Using causal modelling
Using surface roughness compensation

Working with Si Projects in Speedstack with Si8000m
and Si9000e

Creating CITS test files for controlled impedance
structures in the stack

Working with flex-rigid stackups — using the Speedstack
Flex navigator

Working with HDI builds — sequential lamination

Using the Speedstack materials libraries, creating new
libraries, adding material to the library. Accessing the
online libraries

Printing Speedstack technical reports; using the stack
data tables, drill data tables, controlled impedance data
tables, bill of materials tables and frequency dependent
tables and loss graphs
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Introduction to Speedstack

Speedstack PCB Stackup Builder

Polar Instruments Speedstack PCB Stackup Builder is
designed to accelerate the PCB stack design process and
deliver significant reductions in the amount of time consumed
in PCB stackup documentation and control. Given designer
specifications the PCB fabricator can use the Speedstack
Stackup Builder to create in just a few steps the most cost
effective stack for the range of available materials.
Speedstack offers interconnect designers (PCB layout
engineers), PCB front-end engineers and fabricators a fast
and professional solution to layer stackup creation.
Speedstack provides formal documentation for everyone
involved in ensuring the correct materials are used in the
build process.

Speedstack PCB

Speedstack is a versatile PCB layer stackup design tool
featuring powerful and easy to use graphical stackup editing
capabilities. For PCB fabricators Speedstack PCB interfaces
with the industry standard Polar Si8000m PCB Controlled
Impedance Field Solver. It includes a link and license for the
Si8000m, using the proven Polar Si8000m multiple dielectric
boundary element field solver to provide the impedance data
for the stack. In addition, Speedstack PCB licence holders
have full access to the stand alone Si8000m Quick Solver.

Speedstack PCB is especially tailored for PCB fabricators
and PCB brokers — anyone with a requirement to design or
communicate controlled impedance PCB stackups.

Speedstack PCB customers are able to share stackups and
read impedance requirements from designers who are using
Speedstack Si.

Speedstack Si

For electronic engineers involved in stackup design
Speedstack Si interfaces with the Polar Si9000e PCB
Transmission Line Field Solver. Both Speedstack Si and
Speedstack PCB are able to directly output controlled
impedance test files associated with each stackup. For the
fabricator this is an ideal way to link the impedance test
requirements to a particular job. For the OEM this offers a
clear method of sending impedance test specifications out to
suppliers or brokers. Designers and fabricators can work
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together and select the best material combinations for
minimising build costs. Fabricators can share their in house
material libraries with OEMs and ensure the most effective
material choice is employed in the build.

Frequency dependent calculations

Speedstack Si caters for frequency dependent calculations
and adds comprehensive insertion loss calculation capability
into Speedstack; insertion loss can be graphed over a user-
specifiable frequency range. Frequency dependent structure
properties allow for insertion loss calculation: trace
conductivity, frequency range and result presentation mode.
Loss results can be shown in dB/m, dB/inch or dB/LL (length
of line.)

Causal modelling

Frequency dependent parameters include length of line,
trace conductivity, dielectric constant and loss tangent,
frequencies of interest and causal extrapolation points for
each substrate and also support amalgamated dielectric
structures. Frequency dependent calculations employ causal
interpolation of dielectric constant using Svensson-Djordjevic
modelling. Library materials tables include dielectric constant
and loss tangent fields and substrate causal extrapolation
reference points values may be set either manually or
automatically from the library (virtual material mode supports
loss tangent in laminates and soldermask.)

Surface roughness modelling

Speedstack includes surface roughness compensation in
frequency dependent calculations, supporting Hammerstad,
Groisse and Cannonball-Huray surface roughness modeling
methods.

Bidirectional copy and paste between Speedstack and the
Si9000e transmission line field solver allows for quick
transfer of structure parameters.

Technical reports optionally include insertion loss graphs for
user-nominated structures.

Speedstack Flex

Speedstack Flex allows OEM designers to create accurate
and efficient flex-rigid PCB stackups in just a few minutes,
with error-free documentation for tighter control over the
finished board. For PCB fabricators, Speedstack Flex
provides the flexibility to quickly calculate the impact of
substituting alternative materials to improve manufacturability
and reduce cost while maintaining the specified parameters
and performance of the board. Speedstack Flex can be used
in conjunction with the Si8000m and Si9000e field solvers
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when modelling and documenting mesh/crosshatch ground.
Structure data and mesh geometry can be readily shared
between Speedstack and the field solvers. The Navigator
provides a clear contextual view of the rigid and flexible
stacks within a flex-rigid build and allows easy alignment of
displayed materials between stacks. The associated
technical report also supports different materials on the same
dielectric layer, improving the clarity of documentation
between the stackup designer and fabricator.

Speedstack HDI

Speedstack’s Navigator quickly guides you through the
sequential sub-stack lamination sequence and presents the
complete assembly in a parsed graphical display that shows
each phase of the multi-step lamination sequence of an HDI
PCB. There is no limit to the number of press cycles that can
be documented.

Resin check / excess resin algorithms determine the order in
which the materials are pressed together and return useful
resin percentage information that can be used to determine
potential de-lamination problems.

User-definable settings within the navigator allow engineers
to display layers in transparent, invisible or 3D mode.
Speedstack HDI makes re-ordering and renaming sub-stacks
quick and easy with the Navigator. This is especially useful
for HDI constructions.

Rapid stackup creation

Users may specify the stackup semi-automatically with the
powerful Stackup Wizard or alternatively build the stack
manually, layer by layer. Speedstack is flexible and allows
full manual editing of stacks created by the Stackup Wizard.

Easy stackup editing

The Speedstack allows the user to view stackup in 2D or 3D
format. Layer and material annotation is clear and easy to
read and each layer may be selected and queried to display
the associated material type and properties, including the
associated data file. Visible drill information ensures that
designers instantly know which layers support conventional,
blind and buried vias.

Speedstack allows you rapidly to build and share stacks and
verify via aspect ratios and track spacing rules. The stack file
contains base material information combined with layer
description and a complete listing of transmission line
structures deployed in the stack. Keeping all stack
information in one file ensures that manufacturing data is
accurately shared between original designer and fabricator.
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Speedstack’s Stack Editor provides efficient and time-saving
features such as Copy/Paste Material properties so the stack
designer can copy all properties from a selected material and
then paste user-selectable property groups to other materials.

Speedstack allows the designer to retain and re-allocate
structures when changes are made to the electrical layers of
the stackup. This enables reallocation of structures after the
following stackup changes:

Adding and deleting foils and/or cores — increasing or
reducing the layer count

Moving foils and cores, — maintaining the layer count
Exchanging two different thickness cores within the stack

Copying and pasting foils or cores — increasing the layer
count

High quality documentation and file format

Speedstack saves the stack in efficient electronic format and
outputs stack graphics in a variety of formats to suit your
requirements. Stack data may be output in GERBER, DXF,
BMP, JPEG, TIFF and XML. In addition, the stack data can
be exported in comma-separated form for inclusion in other
systems. Speedstack’s high quality customisable printouts
make it easy to discuss alternate builds and pricing impacts
with fabricators.

Applications engineers, front end and production engineers
benefit from receiving stack information in an intuitive, easy
to understand format. The Speedstack .sci file contains full
details of the layer stackup of a particular job. If changes are
necessary or preferred stacks are to be shared with
customers, Speedstack can cut the time for documentation
and information sharing to a fraction of the time taken when
employing traditional methods such as spreadsheet, word
processor or presentation software.

Integration with the Si8000m/Si9000e

Speedstack is fully integrated with the Polar Si8000m
Controlled Impedance and the Si9000e PCB Transmission
Line Field Solvers so the user can quickly add controlled
impedance structures to layers in the stackup. The designer
or board fabricator can use the Goal Seek facility of the
Si8000m/Si9000e field solvers to arrive rapidly at the
controlled impedance structure parameters to produce the
target impedance.

Materials library

The Speedstack supports a flexible materials library. This
allows the designer to use standard materials data and also
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provides the facility to create new material libraries. PCB
fabricators can also build libraries of commonly stocked
materials to give interconnect designers visibility of the
materials held in stock. Speedstack thus supports three
types of library — custom user libraries of materials, generic
designer libraries of materials of given dielectric
characteristics (for example, thicknesses) along with a
comprehensive set of materials libraries from PCB base
material suppliers who are members of the Polar Speedstack
Material Partner program.

Online / on-premise materials libraries

The Speedstack Material Library includes an online library to
allow users to download material library MLBX files from the
Polar website. The online material libraries feature provides
the user with a list of available library files; on selection the
file is downloaded and is either appended to the existing data
or replaces the existing data.

Speedstack also includes an on-premise option to allow for
users who cannot connect to the online library due to
network security restrictions

Speedstack's Virtual Material mode

Speedstack provides Virtual Material mode allowing you to
build and experiment with stackups (for example to examine
the effects on impedance structures of different trace widths
or dielectric heights) without requiring real materials to be
entered into a materials library.

In Virtual Material mode you will use the Stackup Wizard to
enter a few details about the stack, the number of layers,
overall board thickness, plane and mixed layers, etc., along
with solder mask and copper thickness and build type (foil,
core or HDI.) and drills Speedstack will then build a stack to
the specified board thickness by equally distributing the
dielectric regions. If a preferred core thickness is specified
the software will maintain the dielectric thickness for core
regions but then equally distribute prepreg regions to reach
the target board thickness.

Preferred builds

PCB fabricators are able to create and share preferred builds
and exchange the associated information with designers.
Build data also includes blind and buried via specification.
This simplifies the task of sharing stackup and drilling
information between board shops and the design community.

Dimensional information

Finished board thickness is a critical dimension in many
applications; Speedstack keeps track of the finished PCB
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thickness and tolerance and allows fabricators the flexibility
of adding in-house post-press thickness for prepreg layers.
Additionally, Speedstack takes into account plating thickness
where appropriate.

High layer count boards

On boards with high layer counts it can be very easy to make
a change that would produce a non-symmetrical stack. The
Speedstack Design Rules Check monitors symmetry across
the stack, and ensures that material symmetry is maintained.
Speedstack also makes it easy to set the symmetrical build
mode to ensure that any changes you make are applied
equally across the stack.

Supplier management

When multiple-sourcing PCBs or when moving from
prototype to volume production, the stack and fabrication
design rule checks ensure that the manufacturing capabilities
of your chosen suppliers are not overlooked. In addition the
professional documentation output ensures that layer stack
information is accurately conveyed to PCB suppliers.

Graphical interface

Speedstack offers an easy to interpret graphical interface.
Clearly showing the layers supporting blind and buried vias,
Speedstack also records the data file for each layer
(including ident and peelable mask layers). The graphical
interface is especially designed to simplify the process of
communication between interconnect designer and
fabricator. OEMs who need to manage boards sourced from
multiple suppliers will also find this facility invaluable. In
addition to physical layers Speedstack adds mask and
notation for electrical layers.

Interfacing with other systems

Speedstack is able to load an XML file on launch. If an XML
file (.stkx) filename parameter is specified on the command
line it will import this file into Speedstack.

Speedstack can call an external program / utility / script via
the External Utilities menu options. The menu items are
configured within the Configuration option.

Importing and exporting stackup information
IPC-2581 Rev B
Speedstack incorporates Import from and Export to IPC-

2581 Rev B option with interactive interface, supporting stack
up material and structure information
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Ucamco

Speedstack incorporates the facility to read in files in XML
format and Ucamco Job File format, providing comprehensive
integration with Ucamco and will import files from and export
to both Ucam and Integr8tor.

Zuken

Speedstack integrates directly with the Zuken CR-8000
Design Force and Zuken Design Force DFM Center PCB
manufacturing pre-processing and CAM system, simplifying
material communication in the supply chain. Designers can
define layers in DFM Center then export to Speedstack to
define materials and provide a fully documented stackup in a
format widely recognised by both PCB supply chain
managers and fabricators.

Stacks may be exported to the Polar CGen Coupon
Generator for subsequent processing into test coupons.

The Export CITS File option will create test files for Polar
CITS controlled impedance test systems.

Speedstack can generate printed output in DXF, Gerber,
CSV and XML, as well as graphic image formats JPEG, BMP
and TIFF.

Export options also include Cadence Allegro, CSV, IPC-2581
Rev B and Mentor Graphics.

Import / export XML file formats support frequency
dependent structure properties.

Converting imported electrical layers to cores

When importing stackup data from some CAD / CAM
systems only the electrical layers are defined, so copper
layers may appear adjacent each other. Speedstack allows
conversion of two adjacent electrical layers into core or
flexible core materials using the Convert to Core function.

Structure net classes

Speedstack is able to import and store up to five net class
names with each structure. These net class names provide a
link to the matching impedance nets inside the ECAD PCB
layout system.
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Installing Speedstack

Installing and activating Speedstack

It will be necessary to install and activate the product license
and set operating options prior to building stacks or
performing calculations with Speedstack. See Configuring
Speedstack]Licensing to select the associated field solver
and purchased options.

Obtaining a Speedstack license

Speedstack is license using the FlexNet Publisher licensing
service. Contact Polarcare@ polarinstruments.com for
installation/activation directions.

Download the software from the supplied link. Unpack and
save the installation file to a suitable folder then run Setup.

Uninstalling the software

Caution: Prior to uninstalling, make a copy of the Speedstack
folder structure and data files and store in a safe place.

To uninstall the Speedstack software:
Windows 7/8/10

Choose Settings|Control Panel; select Programs and
Features and right click Speedstack and choose Uninstall.
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Getting started with Speedstack

Online tutorial guides

Polar’s web site provides online downloadable quick start
and version specific user guides to familiarize users with the
operation and features of the software.

From the Help menu choose Speedstack Help to download
the Getting Started guide, along with tutorials for stack
editing, managing materials libraries, manufacturing
constraints and controlled impedance structures:

https://www.polarinstruments.com/help/speedstack/tutorials/

Download the user guide for your Speedstack version:

https://www.polarinstruments.com/help/speedstack/Nrmstart.htm

Stackup Templates

Polar’s web site provides online downloadable prebuilt
sample templates and associated technical reports (suitable
for Speedstack 2019 or higher) to familiarize users with the
operation and features of the software.

https://www.polarinstruments.com/support/stackup/templates.html

The stackup templates listed include materials and drills are
typical of standard stacks used in PCB construction and can
be used as a starting point when building your own stacks.
Stackup samples include core and foil build models in both
material library and virtual library modes (see Creating and
editing stackups) for rigid stackups, flex-rigid stackups and
multiple press cycle HDI stackups.

Click on the link to the stackup template page and download
the Speedstack template project (.sci) file; save to a
convenient location and the use the Open Project command
in Speedstack to view and edit the stackup. Note that the
sample stackups are shown with dimensions in microns.
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Using Speedstack Stackup Builder

Speedstack Stackup Builder

Double-click the Speedstack icon to start the Speedstack
program and display the Stack Editor.

The Stack Editor

The Stack Editor screen displays all details of the stack,
including copper and prepreg materials, solder masks and
ident layers, drilling information, controlled impedance
structures and design rule check results.

Controlled impedance structure data may be transferred
between Speedstack and the associated Polar Si8000m or
Si9000e field solver to goal seek for the target structure
dimensions.

3E Polar Speedstack PCE Stack Up Builder:  Stack : Eval Imperial vi3.stk  Project : Eval Imperial v13.sci - O X

File Edit View Tools Units External Utility Help

o pmm
i ﬁ'—l Frare
= T

Esd D=0 xXO ===

F7F7T AT g o Al

Stack Up Editor | DRC: 0 Controlled Imped

XX STEAEL=w@nx

[l
> B
8

Al JI<| <1 of4 >| 3l
Eag strp 18

4.000

4200
- SM Liquid Photolmageable Mask

Fail Caopper Foil 0.700 4200

PrePreg 1080 3.000

4.200
000 Substrate 1 Height

1400 4.200 Substrate 1 Dielectric
3.000 4200 Lower Trace Width
Upper Trace Width
6.000 4200 Trace Separation
6000 Trace Thickness
A7 Coating Above Substrate
Coating Above Trace
4.200 Coating Between Traces
5.000 4570 Coating Dielectric
6.000 7T Differciial Impedance zd[i003s
) Target Ipedance 00,00
2000 Target Tolerance % oo

e
1.400 ALY
3.000
1.400
3000 4.000

& Fail Coppe 0.700
- SM Liquid Photolmageable Mask

[Target Stack Up Thickness = 60.0000 _[Stack Up Thickness = 53.4600 [Stack Up Thickness with Soidermask = 614600 |Beta V.. 17.08.20188

[ [Mils/ Thous

The Stack Editor screen

The Speedstack Stack Up Editor screen comprises:

e The Menu bar — drop-down context sensitive menus
containing all the Speedstack Editor commands

e The Tool bar — incorporating short cut tool buttons to
the most common menu commands
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The Stackup Build and Construction Window — where
the board stackup is built and edited

The Controlled Impedance window displaying the
controlled impedance structures (if any) for the
selected layer.

Stack Up Editor/Notes tab— a free form text area for
explanatory or commentary notes

Design Rules Check (DRC) tab — allows design rules
and manufacturing constraints to be specified and
violations displayed

Stack Up Information properties area — table
containing information related to the whole stackup

Selected Item Information area — properties table
containing the attributes of the layer currently selected
in the stackup

The Controlled Impedance Results tab — summarizing
the controlled impedance structures within the stack

The Speedstack menu system

The File menu

The File menu allows for creation of new stackups and
projects and opening, saving, printing, importing and
exporting existing stackups and projects and data files from
companies providing data exchange with Speedstack.

Save Project As  Ctrl+5Shift+5
Save Stack

Save Stack As

Export 3
Import 3
Print 3
Properties Ctrl+|
Recent Files 3
Exit Crl+

e

| New » | Stackup Wizard Ctrl+N
Open Project Ctrl+ 0 Ermnpty Stackup  Ctrl+Shift+M
Open Stack Ctrl+5Shift+ 0
Search Ctrl+F
Save Project Ctrl+5
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Opening projects

Stackups that incorporate controlled impedance structures
are saved as projects. Click Open Project and navigate to
the project folder; projects are saved as .sci files. The
stackup along with all its design rule checking settings and
controlled impedance information is loaded.

Saving stackups

Click the Save button to save the stackup. Users are
recommended to save the stackup frequently during the
stackup creation process to avoid data loss; stackups are
saved as .stk files.

Saving projects
Use the Save Projects command to save a stackup and its
controlled impedance structures.

Searching for stackups and project files

When creating new stackups and projects it will often be
found convenient and timesaving to reuse an existing stack
or project, modifying as required and the saving as a new
stack or project. From the File menu choose Search and
click Change Folder to navigate to the collection of stacks.

§§ Select 5earch Folder(s) - O *x

File Types

Stack (stk)

Stack with Controlled Impedance ([ .sci) [v

Diefault Path
C:\Program Files (x36)\Polar'Speedstack\Samples

Change Folder

Search Sub Folders v

Apply | Cancel |

A

Choose from stacks and/or projects (stacks with controlled
impedance;) with the folder chosen, click Apply.
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Supplying search criteria

The stackups and projects within the chosen folder structure
are displayed. If appropriate supply criteria, layer count,
board thickness, etc. and click Filter.

a5 Search Existing Stackup Files — O %

rFilter
Layer Count r Number Of Layers Ig

Board Thickness r Minimum Thickness Iﬂ‘ Macdmum Thickness ID

Clear Filer | Fiter |

Mumber Of Layers  + | Actual Thickness | Flanes | 0.50z/18microns | Toz/3Bmicrons | 2Zoz/T0microns | File Name | Fil_+ |
12 59.8 2571 1,23, 45678 Doublet-2.sci cil
12 59.8 25711 1,23 45678 Doublet-Simple.sci CA—
12 9.8 2571 1,2,3,45678 FlexRigid_12Layer_Stepl.sc i
12 88.14596 4679 Qualcomm vi14 test.sci CAl
10 [~ 3568 1,2,9.10 345678 10-layer-segquentiallam-mil-i |
10 52.9724) 3.5.6.8 1.2.9.10 345678 10-layer-seguentiallam-mm-i C:\l
10 425197 3,568 1,23 45678 AP523_HDl.sci fostl]
10 60.8582 3.5.6.8 1.2.9.10 3.456.7.8 fred.sci cil
10 60.8582 3,568 1.2.9.10 345678 HDI_PressCycles_mm_CuFi C:\l
10 60.8582 3568 1.2.9.10 345678 test.sci CAl
2 646 4.5 1.8 234567 &-Layer-sample sci Al
] 626772 36 2,367 AP528-real sci Cu =
o £ RO0A T C NDETID VKARA Al i)

« | _lJ

Target Value | Upper Signal Layer | Single Ended | Differential | Coplanar | Broadside | Trace Width | Trace Thickness
E: 1 v r r r 12 0.7087

100 1 r v r - i 0.7087

50 4 v r r r [ 1378

100 4 r v r r 4 1378

50 7 v r r r & 1378

100 7 r ICd r r 4 1378

50 10 v r r r 12 0.7087

100 10 r IEd r r 8 0.7087

Cancel Lead File

Step through the list, choose the matching stack or project
and click Load File.
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Importing Stackup information
Speedstack incorporates the facility to read in files in:

IPC-2581 Rev B format

Ucamco Job File format

XML format

Zuken CR-8000 format

Ucamco Integr8tor and Ucam format

Import | IPc-2581RevB
| Ucamco Job File L | lrmport
XKML File (.stha) Clear Rules
Zuken CR-8000
Ucameco Integrdtor and Ucam (.s5x)

IPC-2581 Rev B

Speedstack can import stack up and impedance structure data
using the IPC-2581 Rev B XML file format. Use the IPC-2581
Rev B command to import IPC-2581 Rev B (XML) files using
the interactive interface. The stack shown below displays
both stackup material and structure information. The foil,
prepreg, core and solder mask material data grid colours are
determined by the Speedstack Configuration,

Import IPC-2581 Rev B - m] X
—IPC-2581 File il —Software Package (that generated the file) |
Filename [C:\Pragram Files (xB6]'\Polar\Speedstack\Samples\AP517.xm Name Polar Instruments Ltd Speedstack y ' P _2 581
Revision B Revision 17.1.21725 il
Units Vendor
INCH Poler Instruments Ltd Noes:0 | CONSORTIUM
—Import Options —Display Options
[V Assign IPC-2581 as Material Supplier € Al (Stack Up and Structure Data)
[¥ Assign IPC-2581 Layer Name(s) as Material Type & Stack Up Data only
W Calculate Upper Trace Widths (2] using Default Eich Factor (2.000um) " Structure Data only
Assign imported Loss Tangent to Notes field - Mane - To edit the data displayed below select the row, right-click menu and choose the
appropriate function
Speedstack P Layer . - Resin Dielectric | Loss
Number Layer Name Speciication Name Function Side Thickness | Sequence | Material Description Content Constant Tangent
STACKUP THICKNESS 0.068600

LEGEND_TOP LEGEND_TOP_SPEC LEGEND oP 0.002000
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The dialog above provides user guidance through the import
process.

The IPC-2581 File Information pane displays useful file data
including the file name, revision and units. IPC-2581 supports
inches, millimetres and microns.

The Software Package pane details the application (including
the revision and vendor) that generated the IPC-2581 file.

Setting import options
Set the import options to control how the IPC-2581 data is
allocated in Speedstack:

Import Options
Iv Assign IPC-2581 as Matenal Supplier
[v Assign IPC-2521 Layer Name(s) as Material Type
[v Calculate Upper Trace Widths (W2) using Default Etch Factor (3.000pm)

Assign imported Loss Tangent to Notes field : |m ...l

The material type can optionally be derived from the layer
name and the upper trace width can be derived from the
given trace width and default etch factor.

The loss tangent imported can be assigned to one of the five
Notes fields using the associated drop-down.

Setting display options
From the Display Options dialog pane choose to display all
data or stackup or structure data only

Display Options

" All (Stack Up and Structure Data)
{* Stack Up Data only
(" Structure Data only

Sorting layer information

The stackup imported from the IPC-2581 file is shown in data
grid form. Data can be sorted by column — click on each
column header to sort in ascending or descending order by
sequence, layer number, layer name, etc.

Assigning layer functions

During the import process it may be necessary to consult the
board authority or design documentation to ascertain the
function of each layer, signal, plane, dielectric, core, etc.; the
Layer Function determines the layer / material type.
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Right click each layer and use the Set Layer Function to
assign the layer its designated function.

| Set Layer Function to L | SIGMAL

Set Dielectric Constant / Loss Tangent values PLAME
MIXED

DIELCORE
DIELPREG
DIELADHY

SOLDERMASK

Setting loss values

Dielectric constant and loss tangent values can be set for
each layer; select the layer (it will highlight in blue) and then
right click the layer, the dialog should show the current
values; enter each value and click Apply.

Set Dielectric Constant / Loss Tangent Yalues n

Diglectric Constant |4_2.|]1] Apply
Loss Tangent IDII],'EI.H Cancel

With all the editing completed, click Import to bring the file
into the Speedstack Editor.

~ 4.000
LEGEND_TOP 2.000

4.200
SOLDERMASK_TOP

4.2
L1 1.400 G

DIELECTRIC_1 3.400 AZTT

DIELECTRIC_2
4.200

L2/ DIELECTRIC_3/L3 2000 4200

PP CTRIC_4 AT

PP 405 3.600
4200
1.400
Care 8.000 4.9
1.400 G

PR : 4200

PP CTRIC_8 3.600
4200
1.400
L6/ DIELECTRIC_9/L7 §.000 4.
2100 4200

DIELECTRIC_10 3.400
4.000
DIELECTRIC_11 3.400
L8 1.400
SOLDERMASK_TOP

The imported stack can be processed using the Speedstack
editing functions.
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Ucamco Job Files

The .Job file format contains a varying amount of stackup
information depending upon the how the system has been
configured by the Ucam user.

Speedstack will import files from both Ucam and Integr8tor.

Choose File|]lmport|Ucamco Job File|iImport and select the
Job file and click Open. The Ucamco .Job File Import dialog
is displayed:

Ucamco Job File Import

Flease map each .Job layer / dnll class assignment to the eguivalent
Speedstack matenal type:

1. Select a class from the rnight-most list
2. Click the button to nominate the material / layer type

— Job Extra Assignments
Solder Mask | | -]
Idents | -]
Peclables | | |
~ Job Layer Assignments
Signal | |
Mixed | -]
Power | | =]
Hatched | | -]
AJob layer classes that are unassigned will be imported as Signal
~ Job Drill Assignments
s |] 5] [
Flated | | |production
Nonplated | | |
Reset fpply | Cancel

The .Job file contains user-definable material / drill class

definitions so it will be necessary to map these definitions to

the various Speedstack material and drill types.
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To apply assignments select the class from the drop down
list then click the associated button to nominate the material
or layer type. Click Apply.

Note: Where stack data are not included in the .job file it will
be necessary to include or update properties (for example,
solder mask properties such as thickness and dielectric
constant) before adding impedance structures.

Integr8torJob files

When Integr8tor files are imported the Ucamco .Job File
Import dialog is displayed as shown below.

Ucamco Job File Import

Flease map each .Job layer / dnll class assignment to the eguivalent
Speedstack matenal type:

1. Select a class from the rnight-most list
2. Click the button to nominate the material / layer type

.Job Extra Assignmenis
Solder Mask | | ~| == -
Id - "II-:
=t | J :::llderrnask
Peelables | | |
.Job Layer Aszignmenis
Signal | j IE j
Mizxed | j |inner
Power | j
Hatched | |

Aaob layer classes that are unassigned will be imported as Signal

_Job Drill Assignmenis

Laser | j -
Flated | | |rout

Monplated | j

Reset Apply | Cancel

Select the assignment options as described above and click
Apply. Click Reset to clear the assignments.
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Clear Rules

The Clear Rules command will delete all previously learned
rules.

XML files
Choose File|lmport|]XML File (.stkx), select the .stkx file for
import and click Open.

Zuken CR-8000
Choose File|lmport|Zuken CR-8000 format, select the .stkx
file for import and click Open.

Ucamco Integr8tor and Ucam format (.Ssx)
Choose File|]lmport|Ucamco Integr8tor and Ucam format,
select the .ssx file for import and click Open.

Converting imported electrical layers to cores

When importing stack up data from some CAD / CAM
systems only the electrical layers are defined. In this case
copper layers may appear adjacent each other in the
Stackup Editor. Speedstack allows the user to quickly
convert two adjacent electrical layers into Core or Flexible
Core materials using the Convert to Core function.

Select the adjacent layers within the stack — Speedstack
adds the Convert to Core command to the Edit menu.

| Convert To Core k | Core

Flexible Core

Select the Core type — Speedstack displays the core library;
select the core — the layers are converted into the selected
core; note that when converting two foils to a single core
material the lower copper trace will be shown inverted.

Consider the stack below. Using ‘Convert to Core’ alongside
other Speedstack editing functions, an electrical layer only
stackup can be converted into a useful fully defined stackup
containing full definitions of foils, prepreg and core materials.

0.0000
0.0000
0.0000
0.0000
0.0000
0.0000
0.0000

0.0000

Add a prepreg layer between layers 1 and 2.
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Repeat for layers 3 and 4, 5 and 6 and 7 and 8.

Select layers 2 and 3 and convert to a core.

Repeat for layers 4 and 5, 6and 7.

The resulting stack should appear similar to the stack below.

Copper Foil 1.4000
PrePreg 1080 4.200/0.0195 3.0000
1.4000

Core FR4 Core 4.200/0.0195 8.0000
1.4000

PrePreg 1080 4.200/0.0195 3.0000

0.7000
Flex Core 4.200/0.0195 4.0000
0.7000
PrePreg 1080 4.200/0.0195 3.0000
1.4000
FR# Core 4.200/0.0195 8.0000
1.4000
PrePreg 1080 4.200/0.0195 3.0000

Copper Foil 1.4000

Exporting stackup information

Speedstack incorporates the facility to export stack data to
external programs. From the File menu choose Export and
choose the format from the Export sub-menu.

Coupon Generator (CGen)
CITS File

DXF

Gerber

Stackup lmage

Cadence Allegro 3
C5V...

IPC-2581 Rev B

Mentor Graphics k
XML File (.sth) 3
Zuken CR-8000 k
Zuken DFM Centre 3

Ucamco IntegrBtor and Ucarn (\ssx) 3

Exporting to Coupon Generator (CGen)

Stacks may be exported to the Polar CGen Coupon
Generator for subsequent processing into test coupons. Click
Export To | Coupon Generator — open the file in CGen.
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Export CITS File

Use the Export CITS File to create test files for Polar CITS
controlled impedance test systems. Supply board details via
the Board Details dialog.

Board Details

Customer [¥Z Boards
Board Type |Main Contraller
Part Number |MC 1234
Revision Number |Rev il

Notes

MakeFiIe| Cancel |

Click Make File to generate .cif files (CITS test files).

Generating printed output

Speedstack can generate printed output in DXF, Gerber,
CSV and XML, as well as graphic image formats.

DXF, Gerber, CSV and XML files
Choose DXF..., Gerber..., CSV... or XML File and navigate
to a suitable folder, name the file as appropriate and save.

Stackup images
Speedstack can export stackup images in JPEG, BMP and
TIFF file formats. Select from 2D or 3D displays.

iE Export StackUp Image
QOutput Selection Format
& Flex-Rigid Overview (All Stacks) ' JPEG " BMP " TIFF
(" Current Stack Shown in Editor
Low Quality High Quality
Mode J
gl el " 100%
Output Path and Filename
Path
SaveFile |  Cancel |

The Low Quality — High Quality slider specifies JPG quality.
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Choose the Flex-Rigid Overview (if appropriate) to display

the master stack and associated sub-stacks or Current Stack

Shown in Editor. Specify the destination folder and file name

and save.

Cadence Allegro (IPC-2581 Rev B)
Speedstack supports reading/writing in IPC-2581 Rev B
formatted data. Choose the Cadence Allegro/IPC-2581 Rev

B option and supply the file name and destination folder: the

Export IPC-2581 Rev B dialog is displayed.

Export IPC-2381 Rev B

~IPC-2581 File

To edit the data displayed below select the row, right-click menu and choose the
iate function

O

X

IPC-2581
CONSORTIUM

Layer Mumber
LEGEND_TOP

LEGEND_TOP_SPEC

LEGEND

Choosing export options

—Software Package (that generated the file)

Filename [c:\Program Files {xB6]"\PalarSpeedstack\Samples\CA_517:ml Name Speedstack
Revision IB Revision 18.8.26151 il
Units I Vendor

INCH Polar Instruments Ltd Notes: 0 |

—Export Options —Display Options
& Export Target Impedance as the IPC-2581 Impedance data Ml (Stack Up and Structure Data)
" Export Caleulated the IPC-2581 data & Stack Up Data only
Assign Note field value 35 Loss Tangent:  [1one - ¢ Structure Data only
Assign resin rich Dielectric Constant value : [3 5000
_somy_| oL
SLEFILREL Layer Name Specification Name FEy Side Thickness | Sequence | Material Description
Function

1| Screened Ident

Resin
Content

Dielectric
Constant

Loss
Tangent

Use the dialog to modify, if necessary, the file information
details and choose the export options.

—Bxport Options

Assign Mote field value as Loss Tangent :

¥ Export Target Impedance as the |IPC-2581 Impedance data
" Export Calculated Impedance as the IPC-2581 Impedance data

INune I

Assign resin rich Dielectric Constant value : |3

ﬁwl:r|

Specify whether Speedstack’s target or calculated
impedance is to be used to populate the IPC-2581 file.

If available, choose the Notes field containing the loss
tangent value to assign its value to the IPC-2581 file.
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Supply a value for dielectric constant and click Apply.
Click Export.

Mentor Graphics

Choose the Mentor Graphics option, choose the file version
and supply the file name and destination folder. (Note the
.ssx file extension.)

Zuken CR-8000/DFM Centre

The Zuken CR-8000 and DFM Center PCB manufacturing
pre-processing and CAM systems integrate directly with
Polar Instruments’ Speedstack PCB system. Choose the file
version, navigate to a suitable folder and save the file (XML
format).

Ucamco Integr8tor and Ucam

Choose the Ucamco Integr8tor and Ucam option and file
version and supply the file name and destination folder.
(Note the .ssx file extension.)

Assigning properties to projects and stackups

The stack file Properties dialog may be displayed
automatically each time a new stackup is created (see
Tools|Options|General) and provides a range of text fields for
descriptive information, e.g. stackup author, company name,
file create date, stackup name, version, etc.

From the File menu choose the Properties command to add
descriptive text fields — information contained in the
Properties dialog will be displayed on stackup printouts.

To display the Properties dialog each time a new stackup or
project is created, from the Tools menu choose Options and
click the check box below on the General tab

||7 Display File Properties Dialog for New Stackups and Projects |

Backing up stackups and libraries

It is strongly recommended that stackup files (assigned the
.Stk extension), project files (assigned the .sci extension) and
library files (assigned the .mlbx extension) be backed up to a
secure location.

Opening recent files
Click Recent Files to select and open a file from the most
recently used file list.
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The Edit menu

Edit
| Add > Foil
Add Cl Structure Core
Delete Del RCC
Swap Ins Mon Copper Core
Prepre
Copy Ctrl+C e
Solder Mask
Paste Above Ctrl+V
Paste Below Ctrl+Shift+V Flex Core
. ) Bondply
Properties Ctrl+Shift+|
Adhesive
Set To Signal Coverlay
Set To Plane Ident
Set To Mixed Peelable
Set To Hatched
Drrill
Hatch Profile
Move Up Ctrl+Up
Mowve Down Ctrl+ Down
FlexMav Mowve Up Ctrl+Shift+Up

FlexMav Mowve Down Ctrl+Shift+Down
Undo Ctrl+Z
Redo Ctrl+5Shift+Z
Set Stack Default Colours

Reset All NVDP Attributes

The Edit menu contains the commands necessary to create
and modify board stackups. The designer or fabricator works
within the free-form stackup build and construction window
and in Materials Library mode adds layers of foil, core,
prepreg, etc., from the materials library.

Material Library and Virtual Material modes

Speedstack provides the option to switch easily between
Material Library and Virtual Material modes allowing the
stack designer to build and experiment with stackups (for
example, to examine the effects on impedance structures of
different trace widths or dielectric heights) without requiring
real materials to be entered into a materials library.

Controlled impedance structures can be added to the stack.
When Add CI Structure is selected Speedstack switches to
the Controlled Impedance pane and allows the designer to
add structures appropriate for the selected layer. The items
that can be edited depend upon whether the Stack Up Editor
or Controlled Impedance tab is selected.
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Layers can be changed to signal, plane, mixed or hatched,
moved up or down or copied and pasted, or assigned
properties as required.

Use the Delete and Swap commands to delete materials or
swap materials from the Materials Library.

The View menu

Use the View menu to change the Stack Editor display whilst
adding or removing materials or modifying or refining the

stack.
Yiew

20 View Ctrl+Shift+2
3D View Ctrl+Shift+ 3
Zoom In Ctrl++
Zoom Cut Ctrl+-
Zoom Bxtents Ctrl+0
Default View Ctrl+9
Open Mavigator F4

Restore Mavigator
Proportional Stack Viewer F3

Open Material Library  Ctrl+L

Open User AppData Folder

The View menu allows Speedstack to display the stackup in
a 2-dimensional or 3-dimensional aspect.

Zoom In to get a close-up view of the stack or Zoom Out to
see more of the stack at a reduced size. Zoom Extents will
adjust the zoom level to display the whole stack.

Hint: Click the mouse centre button/wheel to Zoom Extents.

With the Flex / HDI option installed choose the Open
Navigator command to view the master and associated sub-
stacks. The floating Navigator window may get covered by
other application windows when switching between
programs; — use the Find Navigator to display a reduced
Navigator window at the top left screen corner.

Proportional Stack Viewer

Use the Proportional Stack Viewer to display the stack
currently selected in the Stack Editor so the material
thicknesses are shown proportional to each other. This can
be informative as a visual aid, especially when considering
the dielectric thicknesses between electrical layers.
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The Tools menu
Use the Tools menu to configure Speedstack.

Tools

Options Ctrl+Shift+ 0
Manufacturing Constraints Ctrl+ M
Set Finishing Method Ctrl+M

Set Target Stackup Thickness / Enable Finishing  Ctrl+T

Virtual Matenal Mode Ctrl+Shift+Y

Language 3

The Options command displays the configuration options,
manufacturing constraints, target stack thickness and
finishing options. See Configuring Speedstack for details.

The Units menu

Use the Units menu to select the stackup units, Microns,
Mils/Thous, Millimetres or Inches

Units

Microns Shift+F1

Mils/Thous  Shift+F2

Millimetres  Shift+F3
Inches Shift+F4

External Utility

Use the External Utility commands to start a program
external to Speedstack. The programs are defined in the
Configuration Options|External Ulilities dialog.

The Help menu

Use the Help menu commands to access the User Guide for
the current Speedstack version or tutorials relating to
common Speedstack operations.

Review the licensing terms with the License and About
Speedstack commands.
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Configuring Speedstack

When first run, the Speedstack environment is initialised to
its factory settings. These may require adjustment before
outputting a finished stackup and/or project. Default settings
are changed using Tools|Options, Tools|Manufacturing
Constraints and Tool|Set Finishing Options.

Environment and default settings

From the Tools menu choose the Options command to
display the Configurations Options dialog.

General Options

Default Stack Up View Display Data
o0 Dizplay Fields 1 and 2 are reserved for Layer Numbers and Layer Types
|Display Field 3 | Display Field 4 | |Display Field 5
S |Descriptiu:un hd |N.:.ne j |Isu:u|aﬂun Distance hd
Units
" Mils/Thous {+ Microns " Millimetres " Inches

[+ Open last used file on application start up

I+ Display File Properties Dialog for Mew Stackups and Projects

Choose the Default Stackup View — 2D or 3D; select the data
fields that will appear alongside the stack in the Stack Editor

| Display Field 3 |Display Field 4 | [Display Field 5
|Descriptil:un - |N|:|ne j |Base Thickness hd
Supplier Finished Thickness
Supplier Descrintion Base Thickness Copper Coverage
E&b Finished Thickness lzolation Distance

Copper Coverage Dielectric Constant
%;zk humber Isolation Distance Resin Content

Dielectric Constant Tg

Resin Contert Colour

Tg ¥ | [Data Filenames W

Choose the stackup units; Speedstack supports Mils/Thou,
Microns, Millimetres and Inches. Click the Open last used...
check box to specify that Speedstack should open the last
used file on start-up.

Note: Processed Thickness is the Finished Thickness for
copper layers and Isolation Distance for dielectric layers.
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Clicking the Display File Properties Dialog... will display the
File Properties Dialog each time a new stackup or project is
initiated.

Structure Defaults

Structures

W1 Default Trace Wwidth [15000 oard Thickness

W2 Default Trace \width 12500 Board Thickness [160000
G1 Default Trace Width [15000 Pes = [0
G2 Default Trace Width 12500 Minus % [10
51 Default Trace Separation IW

[ Default Trace Separation IW Drilling

01 Default Trace Offset oo Mirirom Hole Size ErT—
REr Default Resin Puddle Er +

When adding new controlled impedance structures default
values are entered for the trace widths and separations. Use
the Structure Defaults tab to specify the default structure
parameters, board thickness and minimum drill hole size.

Licensing
Use the Licensing tab to tick the purchased licensing options.

" Mo License
" Use Polar Si8000m License

+ Use Polar Si3000e Licenss

If Polar Si8000m or Si%000e has been purchased and you wish for
interactivity between Speedstack and either of these products,
select the appropriate license.

[v Speedstack Flex / HDI License (SF)
[v Hatch Mode License (XFE)
[V Speedstack Import ! Export License (10)

¥ Speedstack / Ucamco Integration License (UCAMCO)

To activate the Speedstack controlled impedance function,
ensure that the Si8000 or Si9000 is installed; from the
Licensing tab choose either Use Polar Si8000m License or
Use Polar Si9000e License option as appropriate.
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Choosing default file locations

Select default materials library file

C:\Program Files (x86)\Folar\Spesdstack\Samples\Speedstack Imperial. mibix Browse...

Select default folder to stare Stack Up ([~ stk) files

C:\Program Files [x86)\FPolar\Speedstack\Samples! Browse...

Select default folder to store Matenial Filter [*.mif) files

C:\Program Files (x8E6)\FPolar\SpeedstackiSamples'Filters Browse...

gy

Use this dialog to choose which materials library the
Speedstack uses at start-up. Click the File Locations tab and
use the Browse button to navigate to the library (.mlbx) file.

The File Locations tab provides for default locations for
stackup or project files and Material Filter (.mlf) files. Browse
to the target folders and click OK to confirm (create new
folders if necessary).

Specifying goal seeking parameters
Click the Goal Seeking tab to specify the default values for
trace widths and separations used during goal seeking.

1 Maximum Trace Width

1 Minimum Trace Wwidth

51 Maximum Trace Separation
51 Minimum Trace Separation

D1 Maximum Trace Separation
D1 Minimum Trace Separation
H Maximum Value

H Minimum Yalue

W Convergence II}5I}7
W Maximum lterations I'H}i
oo
-
oo
-
.
Er

During goal seeking the calculated value for impedance will
progressively converge upon the target value.

In the Convergence text box specify the difference between
the target impedance and the actual impedance at which
goal seeking will terminate.

Use the Maximum lIterations text box to limit the number of
iterations used during goal seeking.
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Setting user defaults
Information added to the User tab will be transferred to the
File Properties dialog and used on printouts

Enter information as appropriate into the associated text
fields; optionally, select a graphic for use as the company
logo — optimum graphic size is 180 x 32 pixels — the
graphic is printed in the preview box.

Default User Information Company Logo
Used to fill in stack property fields when starting a new stack file.
Author |J Travers
|D:'-.Pu:ular'-.Graphics'-.F'ular Logos“MewPaolarl Browse...
Company |>WZ Com Q
Recommended size for the logo is 180 pixels in width.
Department |Engineering Large images will be scaled down.
Site [North Bridge|
o D loe
| |
Specifying default CITS test file parameters
Speedstack allows the user to generate a CITS test file for
each controlled impedance structure within the stack.
Select the CITS Test tab to specify the default test
parameters to be used when initiating a CITS test file.
Horizontal Units Channels
Units ||""3""35 ﬂ Single Ended |Channe| i ﬂ
Test From 3 Differential |G'IEI|'II'IE| 1&2 ﬂ
Test To 7
Test Method |Absolute -]
Vertical Scale |1E' j
Diiferential Unbalanced Warning Level |15

Each test file contains the test parameters (test units,
distance, number of channels, etc.) to be used when testing
the stack’s controlled impedance structures using a Polar
CITS (Controlled Impedance Test System).

The test file may be edited via the Edit Test Data dialog.
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Choosing background and stackup layer colours
Choose the Colours tab to change stackup component

colours from their factory

defaults.

I.ﬁdhesiues ;I
Background

Bondphy

Coppers

Care Diglectrics
Coverays

Dielectrics

Flexi core

Highlighted Material
|derts ¢ Documerntation
Lager Drills NTP

Laser Drlls TP
Mechanical Drills N TP
Mechanical Drills TP

Peelables hd

I ——

—Base Colour

Change

Reset All

Click Reset All to return to cancel changes.

Miscellaneous Options

— Dielectric Differential

Maximum Recommended Differential is 1.0
Accuracy decreases rapidly above this level.

malgamated Dielectric Differential Threzhold I'I i

Mumber of Undo Levels

Maximum Laser Drilled Layers

e
e

Use the Miscellaneous tab to specify the maximum Dielectric

Differential when working

with multiple dielectric structures;

choose the number of levels of editing Undo and the
maximum number of layers a laser drill can span. (Exceeding
this number will produce a Drill not Valid error message.)

Hatch Defaults

Hatch Fitch
Hatch whdth

Copper Percentage

[433.58
[127.00

I,;f. =

o R

Use the Hatch Defaults tab to specify the default values for
Hatch Pitch and Width and Copper Percentage when setting
a plane to hatched (see Hatch Configuration.)

Configuring Speedstack e 31




Rebuild and Calculate Structures

These options control the way that the Controlled Impedance structure parameters are
updated from the stack up. When new structures are added or the Rebuild and
Calculate option is selected, Speedstack will update all structures based on the
selections below. Default : All options selected.

¥ Substrate Height (H )

¥ Substrate Dielectric (Er n)

W Trace Thickness (T1)

¥ Coating Above Substrate (C1)
¥ Coating Dielectric (CEr)

The Rebuild and Calculate Structures tab allows the
designer to specify which parameters are included when
controlled impedance structures are recalculated after
modifying the stack.

Manufacturing Constraints

The Manufacturing Constraints options consist of a collection
of manufacturing capabilities, minimum gaps and trace
widths, buried and blind via and trace aspect ratios, drill
aspect ratios, etc. that can be applied during design rule
checking (see the DRC tab detail below.)

¥ Manufacturing Tests

¥ Min. Trace \Width ¥ Min. Gap \width
Aspect Ratios
v Mechanical Drill

¥ Blind Laser Microvia

¥ Buried Laser Microvia
¥ Trace

[~ Resin Starvation

They will normally refer to differing levels of technology
offered by one or more PCB manufacturers for a range of
prices. The required information (shown in the example
below) can normally be obtained from the manufacturer.

Manufacturing Constraints

Manufacturers Name

“‘v

Polar Mils
Polar Millimetres
Polar Inches

Trace A R

Minimum Trace Width

Blind Laser ViaA. R Buried Laser ViaA. | Mechanical Drill A R.|  Minimum Gap

Mils
Millimetres
Inches

Highlight Close

"Current Active Co
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Click the Highlight button to highlight the current active
constraint; to apply a new constraint select the constraint row
and click Set New.

Editing and adding constraints
To modify a constraint or add a new constraint, double click
within the constraint row to be edited.

Edit Constraints
UUnits
" Mils {* Microns
" Inches " Millimetres
Opticn Name |F‘0Iar Microns
Minimum Gap |F"5
Minimum Trace \afidth |75
Mechanical Drill AR. 8.5
Blind Via AR. 05
Buried Via AR. 05
Trace AR. 1
1of 4 > | >
add | | Cancel
Done

Modify each setting as required; click Done to confirm the
settings and close the dialog.

To add a new constraint click the Add button, fill in the
settings fields and click Done to finish. The new constraint
will be added to the table of current constraints. Click the
Delete button to remove the constraint from the list.
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Set Target Stackup Thickness/Enable Finishing

Set the Target Stackup Thickness and tolerances via the
dialog below.

Target Stack Up Thickness / Enable Finishing

Target Stack Up Thickness &0.0000 (Mils)

Tolerance

{+ Percent " Absclute

Positive Tolerance + 100 G
Megative Tolerance - 100 G

Enable Prepreg Finishing ~

Ensble Copper Finishing [
Apply | Cancel |

Tolerance may be set in terms of percentage or absolute
values:

Tolerance

" Percent {+ Absolute

Positive Tolerance + &.0000 (Mils)
Megative Tolerance - &.0000 (Mils)

Note that positive and negative tolerance values can be set
independently. The values should reflect the currently
selected units.

To enable prepreg and/or copper finishing tick the associated
check boxes. Click Apply.

Note: Unchecking the Enable Finishing options disables the
Apply and Reset Finishing buttons. Note that these buttons
are only available in Materials Library Mode — they are
disabled in Virtual Material Mode.
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Finishing Options

From the Tools menu choose the Set Finishing Method
command to display the set finishing corrections dialog.
Speedstack offers two methods: Copper Coverage Method
and Simple Percentage Method.

JLLE
I

Set Finishing Method et

Copper Coverage Method Simple Percentage Method

Copper Coverage Method Currently
Selected

i

Each method requires that the amount of copper to be added
where plating is required be set. In addition, where the
Excess Resin design rule check is used the minimum
acceptable value must be set.

Simple Percentage Method

The Simple Percentage Method allows the user to set the
percentage of prepreg base height, which will be used to
determine the isolation distance. The percentage is set for
each electrical layer type pair.

HE Percentage Prepreg Corrections »

Prepreg
Set Finished Thicknesses of Prepreg materials (% of base material)
when prepreg is pressed between:

Signal and Signal layers W“f’,
Signal and Mixed layers W‘};
Signal and Plane layers W",’,
Mixed and Mixed layers W‘}{,
Mixed and Flane layers W‘R
Flane and Flane layers Wi’,

Copper Flated Thickness

Please enter a value of thickness that will be added to hase
thickness of copper layers when plating

Copper to be added 0.7000

Excess Resin Test

Minimum Excess Resin 15 %
Apply | Cancel
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Copper Coverage method
The Copper Coverage method allows the user to specify the
amount of copper that will be embedded into the prepreg.

This can be set as a single value for each electrical layer
type. Alternatively the amount of copper embedded will be
calculated on an electrical layer by layer basis dependent
upon the copper coverage for the layer set in the properties
window. The greater the copper coverage the smaller the
amount of copper that is embedded.

3E Copper Coverage Based Prepreg Corrections >
Percentage Copper To Be Embedded in Prepreg

* Set by Layer type

Signal Layer % |75
Mixed Layer %15
Plane Layer % |5

" Proportional to Coverage
Copper Finishing

Please enter a value of thickness that will be added to base thickness of
copper layers when plating

Copper to be Added 0. 7000

Excess Resin Test

Minimum Excess Resin %15

Apply | Cancel

Note: The two methods of finishing are not compatible with
each other. The Copper Coverage method requires that the
finished thickness of prepregs be entered in the library; that
value stays locked in the stack unless the Simple Percentage
method is set up; if Reset Finishing is then clicked the
finished thickness reverts to the base thickness.
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Virtual Material mode
The Virtual Material Mode command toggles between Virtual
Material and Material Library modes.

Note: Switching to Virtual Material Mode disables the Apply
and Reset Finishing buttons.

Note: Virtual Material mode and the Simple Percentage
method of finishing are not compatible. Speedstack displays
the message below if the two are selected simultaneously.

Speedstack >

|_ The Simple Percentage Method of finishing is not supported when

_I Speedstack is in Virtual Material Mode, Please use the Tools | Set
Finishing Method and select Copper Coverage Method.

oK

Working with external utilities

Speedstack can call an external program / utility / script via
the External Utilities menu options. The menu items are
configured via Configuration Options|External Utilities.

Choose |  Clear |
Choose |  Clear |
Choose |  Clear |
Choose |  Clear |
Choose |  Clear |

To specify a program click Choose and navigate to the
program and click Open. The program will be added to the
External Utility menu.
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The Speedstack toolbar

The Speedstack toolbar comprises shortcut links to the most
popular commands.

Ed TSl XO==R=ZRg 777717 2= W

Note: toolbar buttons will be enabled/disabled depending on
whether Speedstack is performing stack editing or controlled
impedance calculations. Pause the mouse over each tool
button to display the tool’s screen tip

File operations

ES Create new stackup

L M

E Library mode

W M

E Virtual Material mode

A Stackup Wizard

Stack building operations
[ S

Symmetrical Mode off

Symmetrical Mode on

D Mirroring Mode

L — Add layer to the stackup

Click to select the layer type. The list of layer types is
displayed in the associated sub-menu.

Layers available include:

Foil Add foil layer to the stackup
Core Add core layer
RCC Add resin coated copper layer

Non-Copper Core Add non-copper core
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Prepreg Add prepreg layer

Soldermask Add solder mask
Flexible core Add flexible core layer
Bondply Add bond ply adhesive
Adhesive Add Adhesive
Coverlay Add coverlay layer
Ident Add screened ident layer
Peelable Add peelable mask

j[f: Add mechanical/laser drill between layers

Editing the stackup

x Delete selected stackup material or drill

@ Swap selected material

Note: the Copy and Paste buttons below are only enabled for
the Stack Editor and DRC tabs — they are disabled for the
Controlled Impedance and CI Results tabs.

Copying and pasting materials

l

Copy material of the selected layer

L

Paste material above selected layer

—
i Paste material below selected layer
q y

n] |u]
':Ffﬁl Copy material properties

‘[_F_lg Paste material properties
(=] [u]

Changing plane types

Set the selected electrical layer as a signal
layer

| [

Set the selected electrical layer as a plane

The Speedstack toolbar e 39



’

7

Set the selected electrical layer as a mixed
signal/plane layer

Set the selected electrical layer as a hatched
plane

Note: the Move Selected Layer buttons below are only
enabled for the Stack Editor and DRC tabs — they are
disabled for the Controlled Impedance and CI Results tabs

1
¥

Move selected layer up one layer

Move selected layer down one layer

Display properties dialog for the selected layer
or drill

Note: the Apply and Reset Finishing buttons below are only
enabled for the Materials Library Mode with the Prepreg and
Copper Finishing Options checked (see Set Target Stack
UpThickness/Finishing Options) — they are disabled for the
Virtual Materials Mode.

Applying finishing

) |

Apply finished thickness

Reset finished thickness

Changing the stackup view

LR [Ny

Display 2-dimensional view

Display 3-dimensional view

Proportional Graphics View

Managing the materials library

Go To/Display materials library
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Exchanging data with the Si8000m or Si9000e Field solver

Copy controlled impedance data to field solver

Paste controlled impedance data from field solver

’% Copy to Si8000m or Si9000e Project

The Speedstack toolbar e 41



Creating and editing stackups (Virtual Material mode)

Material Library and Virtual Material modes

Speedstack provides the option of switching easily between
Material Library and Virtual Material modes, allowing the
stack designer to build and experiment with stackups without
requiring real materials to be entered into a materials library.

In Virtual Material mode the Stackup Wizard allows rapid
entry of stack details, the number of layers, overall board
thickness, plane layers, solder mask and copper thickness.
Speedstack will then build a stack to the specified board
thickness by distributing the dielectric regions equally. If a
preferred core thickness is specified Speedstack will
maintain the dielectric thickness for core regions but equally
distribute prepreg regions to reach the target board
thickness.

This section will describe the steps to construct an 8-layer,
symmetrical FR-4 stack to the specification below using
Speedstack’s Virtual material Mode.

Thickness: 60 mil

Signal layers: 1,3,6,8

Plane layers: 2,4,57

Er: 4.2

Preferred core thickness: 8 mil

Copper (all layers): 1loz./1.4mil

LPI Mask: 1 mil

PTH drill passes: Layers 1 -8

Laser microvia passes: Layers1-2,8-7

Impedance structures: SE 50 Ohm Layer 1, Diff 100 Ohm Layer 1

From the Units menu choose Mils/Thou, from the Tools
menu toggle Virtual Material Mode On.

Manufacturing Contraints Ctrl+5Shift+E
Set Finishing Options

Set Target Stack Up Thickness / Finishing Options

Virtual Material Mode
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é Library/Virtual Material mode indicates Virtual Material
mode.

Using the Stackup Wizard
From the File menu chose New|Stackup Wizard.

Setting basic stack data
Fill in the dialog as shown below.

Stack Up Wizard (Virtual Material Mode)

L e :|v Nominal Diglectric Constant 42
Target Stack Up Thickness &0.0000
Pasitive Tolerance % 10 Solder Mask Top v
Megative Tolerance % 0 Solder Mask Bottom v
Symmetrical v Solder Mask Dielectric Constant 3
Plane Layers Mixed Layers Solder Mask Thickness 1.0000
| ‘12 Preferred Core Thickness Select j |2.0000
3 3 Copper Thickness 1.4000
4
5 .
3 3 Build Type
-
] ] * Fail " Core " Seguential/HDI
Mext = Finish Cancel

Click Next to add drills.

Adding drills

Select Column 1 and specify the First Electrical Layer as
Layer 1 and the Second Electrical Layer as Layer 8; choose
Mechanical, Through Plated with No Fill and click Add to add
the first drill to the stack.
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Add Drills

— Electrical Layers R
Column First Electrical Layer No Second Electrical Layer No
I = D = s =
— Dnill Informat —Hole Information—————
% Mechanical Fill Type Hole Count
1 lnser No Fil E2RRAL]
" Laser (Stacked) Different Hole Sizes
ID
[¥ Through Plated
) Minimum Hole Size
Data Filenames
I ID.DDDD
Delete Last | Delete Al =
<Previous_| Finished |  Cancel |

Adding microvias

Choose Column 2, specify the First Electrical Layer as 1 and
the Second Electrical layer as 2; choose Laser with No Fill
and click Add. Repeat the process to add another microvia to
Column 2 between electrical layers 8 and 7 (shown below.)

Click Finished.

The Stackup Wizard displays the New Stackup File
Properties dialog; enter the (optional) stackup properties.
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MNew Stackup File Properties = B
The fields below are optional
Descriptive Stackup MName |M-Board V Stack
Stack Top Side Label |
Stack Bottom Side Label |
Date Created j070s2m3
ersion IF{ev 000
Rewvision Show/Hide Revision Information
Author Jm
Company IF‘oIar
Department IEngineenng
Site |Morth Ind Estate
Associated Documents

ok | skip |

Click OK to close the dialog and edit the stack. Speedstack
builds the stack to achieve the specified board thickness.

Click the 2D button to assist in visualisation while editing the
stack.

Use the View menu to zoom in and out of the stack.
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Zoom In
Zoom Out
Zoom Extents
Default View

Hint: Click the mouse wheel in the Stack Editor (Zoom
Extents) to view the entire stack.

The Stackup Editor displays summary information for the
whole stack and for items within the stack as they are

selected.

Stack Up Information

Field Walue
Electrical Layer Count 2

Stack Up Cost 0.00
Copper Thickness 11.0236
Dielectric Thickness 21.9635
Solder Mask Thickness 1.9635
Target Stack Up Thickness BZ.9521
Stack Up Thickness &2.9521
Stack Up Thickness with Scldermask 645606

Selected Item Information : Dirill

Field Value
First Electrical Layer No 2
Second Electrical Layer No 7
Mechanical Dirill False
Laser Onll True
Fill Type Ma Fill
Diata Filenames

Heole Count 0
Different Hole Sizes 0
Minimum Haole Size 0.001
Minimum Allowable Hole Size 152000

Editing the stack

With the “virtual” stack in the Stack Editor the stack can be
changed as required.

Changing material properties

To change the properties of a material, right click the
material in the stack and choose Properties; fill in the text
fields with the associated information and click Apply. Most
material properties can be changed, including the material
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descriptions, base and finished thickness, dielectric
constants, drill parameters along with the graphical colours.

Choosing Symmetrical mode

Stackups are often designed symmetrically to prevent
[ warping and twisting — using similar materials in the top
Wi and bottom halves of the stack.

~ | Symmetrical OFF

Clicking the Symmetrical button will toggle the Symmetrical
mode on or off. In Symmetrical mode the stack editing

“" | Symmetrical ON  functions will process materials in the upper and lower
halves of the stack simultaneously.

Changing the material description

In this example stack, ensure symmetrical mode is selected
then right click the solder mask material in the stack to
display the Solder Mask Properties dialog.

Solder Mask Properties
Main l Notes ] Attributes

General Information Apply
Supplier |POIar Samples Close
Supplier Description [sm/001
Description |Liquid Photolmageable Mask Cost IW
Stock Number 500-001
Type |50Iderfv1ask Lead Time W

Solder Mask
Thickness W Mask Colour W
Dielectric Constant W Graphical Celour _
Less Tangent ’F
Data Filename |

Change the Solder Mask Description to Liquid Photo
Imageable (LPI).

Description ||Jquid Photo Imageable (LPI)

The change on the Description in both solder masks is
reflected in the Editor window.

Liguid Photo Imageable (LPI) 1.000

Liguid Photo Imageable (LPI) 1.000
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Changing electrical layers

Electrical layer types may be changed from plane to signal,
mixed and hatched. Right click the layer to be changed and
choose from Signal, Plane, Mixed or Hatched.

Set to Signal
Setto Plane
Set to Mixed
Set to Hatched

Speedstack will take the designated layer type into
consideration when adding controlled impedance structures.

Setting hatched planes

With the XFE option Speedstack supports hatched planes,
— implementing the same crosshatch calculation technique
Ve used in the Si8000m / Si9000e. If a crosshatch plane is
Set Layer to Hatched  required click Set Layer to Hatched Plane —use the Hatch
Plane Configuration dialog to set hatch pitch and width or set the
hatch width by percentage copper area. Click Apply.

Hatch Configuration Hatch Fitch wp  [17.0701 ——
"\H =} HW Hateh Width W[5 -

i\ —Set Hatch \Width for desired Copper Area %

.00

Copper Area %

MNon Copper Area % Cancel

Adding controlled impedance structures

To add controlled impedance structures, click the Controlled
Impedance tab, select the copper layer (in this example,
Layer 1) and click the Add New Structure button.

Stack Up Edtor | DRC : 3 [ Controlled Impedance || C1 Resuts |

+

|F\.dd Mew 5tructure|

Speedstack suggests structures valid for the layer based on
the plane layer types.
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Structure Control

—MNumber Of Signal
Tracks Apply |
¥ Single Trace Apply Al |

" Differential Co Ed1hE11im p
E Advanced |

Coated Coplanar
Strips With Low...

For this example, choose a 50 Ohm single ended coated
microstrip; leave the tolerance at 10%; click Apply then Done.

- The new structure is shown in the stack, highlighting the
| Structure on Layer  materials employed by the structure.

The structure also appears in the Controlled Impedance
panel, along with its parameters.
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Stack Up Editor | DRC: 0 Controlled Impedance | CI Resuts |

303 L= 5

Coated Microstrip 168

Substrate 1 Height H1 [63500
Substrate 1 Dielectric Er1fa2000
Lower Trace Width W1 |9.8425

Upper Trace Width w2 [97244
Trace Thickness T [o7000
Coating Above Substrate cifoooo
Coating Above Trace c2 [foooo
Coating Dielectric CEr|4.0000

Impedance Zoloo0
Target Impedance W
Target Tolerance % W

Calculating the structure impedance

Parameters calculated from the stack materials, such as the
substrate height and dielectric are read only and shown
greyed out; other parameters may be edited. If the editable
parameters are known they may be entered directly.

For example, modify W1 to read 10.5 and W2 to read 9.5
and click the Rebuild and Calculate All Structures.

The impedance is calculated as 51.94 Ohms

Goal Seeking the target impedance

Speedstack can adjust one or more structure parameters to

@ Goal Seek button achieve a specified target impedance. Leave the Target
Impedance at 50 Ohms and click the Goal Seek button

From the Set Up Goal Seek dialog choose W1/W2 only
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Set Up GoalSeek

N

Goal Seeking Farameter(s)

{* W12 only
~

H1 Only

i IR B B B B

oK | Cancel |

Click OK — Speedstack adjusts trace width (below) to
achieve the target 50 Ohm impedance.

Substrate 1 Height H1 |6.2000
Substrate 1 Dielectric Erifa2000
Lower Trace Wwidth w1 10.7037
Upper Trace \idth w2 97037
Trace Thickness T1 |1.4000
Coating Above Substrate C1 |1.0000
Coating Above Trace C2 [1.0000
Coating Dielectric CEFW
Impedance Lo W
Target Impedance W
Target Tolerance % W

With the impedance in tolerance the navigation buttons
display green.

Mirroring structures

This example stack is symmetrical so structures may be
copied to the lower half of the stack (i.e. on the lower outer
layer.) Click Mirror Structures if Stack Symmetrical.

The impedance structure on Layer 1 is copied to Layer 8.

Rebuilding the stack

During stack editing changes to the stack (for example,
inserting prepreg materials into a layer or altering the existing
material thickness) will affect the impedance value of one or
more structures. If Speedstack senses that an impedance
structure has changed it issues a Rebuild alert.
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Stack Up Editor | DRC : 0 Controlled Impedance | CI Resuts |
* +. IJ |.”| — ) . Hz
3= X 3¢ »Q&j FA L RO
MII—I—"—I—'—I‘-’—nt\—I—\'—I—‘_
Rebuild and Calculate All Structures

Click Rebuild and Calculate All Structures — Speedstack
recalculates the impedance for the new parameters. If the
impedance value is out of tolerance the structure browse
control changes colour to red.

Virtual Material mode allows the designer to experiment with
material properties to examine the effects on impedance
structures of different trace widths or dielectric heights, etc.
Materials may be added, moved, copied, pasted or removed
and the properties of materials changed — Speedstack will
sense the changes and allow the “generic” stack to be rebuilt
and recalculated.
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Creating and editing stackups (Material Library mode)

This section describes creating stackups using the Material
Library mode. Stackups may be created manually using the
Stackup Wizard or using the editing window. Ensure Tools|
Virtual Material Mode is toggled Off.

Using the Stackup Wizard

p: %

Stackup Wizard button

The Stackup Wizard guides the user through the process
of creating complex stackups in only a few steps. Click the
Stackup Wizard button or choose Stackup Wizard from the
File|New sub menu. The stackup editing window is cleared
and the Stackup Wizard displayed.

General

AL stack Up Wizard (Material Library Mode) — d x

Planes and Mixed Layers

Stack Up Thickness: 0 (Mils)

Layer count - ¥ Symmetrical
) Plane Layers Mixed Layers
Build Type | ﬂ
Materials
Soldermask |
Foil |
Prepreg | Clear Clear
Frepres | Drillin
Prepreg | J Q a
Core | [ Through-Plated I Mon Through-Plated

Apply | Cancel |

Stack Up Thickness with Soldemaskc: 0 (Mils)

Using the Wizard the user can specify the layer count and
build type, stackup materials, planes and drill types in a
single operation.

Electrical layer count

Begin by specifying the electrical layer count — up to 64
electrical layers may be specified. Choose the number of
layers from the drop down list box.

Build type

Choose the build type (Foil or Core) from the drop down list
box. Core builds contain only core materials; most builds will
be foil builds — containing internal layers of cores with two
outer foils.
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General

Layer count

Build Type

ER -

| Fail

=

7

Choosing stackup materials

Note; if Core build type has been specified the Foil material
control will be disabled.

The Wizard allows for a stack comprising solder mask, foil,
and cores with up to three prepreg materials between.

,‘. Stack Up Wizard (Material Library Mode)

Soldermask ||Jquid Photolmageable Mask SM;

Foil |Copper Foil FO./002
Prepreg |PrePreg 1080 PP/0D1
Prepreg |PrePreg 1080 PP/0D1
Prepreg |

Core |FR4 Core CO/017

Stack Up Thickness: 59 2 (Mils)

General

Layer count 2 -

Build Type |Fail |
Materials

Clear
Clear
Clear
Clear
Clear

Clear

T

Stack Up Thickness with Soldemmaskc: 61.2 (Mils)

Planes and Mixed Layers
¥ Symmetrical

Plane Layers
1

3

Clear

Drilling

[+ Through-Plated

I Mon Through-Plated

— O *
Mixed Layers
1
2
3
4
5
6
8
Clear
Apply | Cancel |

The Wizard displays a running total of the stackup thickness
in the Wizard’s status bar.

Adding layers
To include a layer (in this example a foil layer) click the
Foil Add Material button; the library of foil materials is
displayed. Choose the foil material from the list and click
the Add Material Above button; the material is added as a
foil layer to the stackup.

ENT +Y Y

[ | - Y4 VX
Supplier Supplier Description| Description Stock Number | Cu Base Thickness | Type

» PolarSamples FOWD04 CopperFoil0.7 100-004 0.7 Copper
PolarSamples FO#002 CopperFoil 1.4 100-002 1.4 Copper
PolarSamples FOA003 CopperFoil2.8 100-003 2.8 Copper
PolarSamples FO#005 CopperFoil0.Y 100-005 0.7 Copper
PolarSamples FO/008 CopperFoil1.4 100-006 1.4 Copper
PolarSamples FO/006 CopperFoil2.8 100-006 2.8 Copper
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Repeat the procedure for prepreg and core materials and the
(optional) solder mask layers. Use the Clear button to
remove a layer from the stackup.

Materals

Soldermask  |Liquid Photolmageable Mask SM, | Clear |
Foil [Copper Foil FO/002 | Clear |
Prepreq [FreFreg 1080 PP/001 |  clear |
Prepreq [FreFreg 1080 PP/001 |  clear |
Prepreg | | Clear |
Core [FRé Core CO/017 .| clear |

Nominating power planes and mixed layers

Use the list boxes to specify planes as power planes or
layers as mixed layers. Select all planes as required. To
remove a plane from the list select the plane number from
the list and click Clear.

Planes and Mixed Layers
v Symmetrical
Flane Layers Mixed Layers
1 1
2
3 3
4
h
& G
g 8
Clear Clear

The dialog above shows Layers 2, 4, 5 and 7 specified as
power planes

Adding drill information

To add a drill between electrical layer 1 and the last layer
click the Through-Plated and Non-Through-Plated check
boxes as required.

Drilling

W Through-Plated ™ Non Through-Plated @

With all build options specified click Apply to complete the
stackup. The finished stackup appears in the Editor window.
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The example stack below includes two prepreg materials
between layers.

1.000

3.000
Liquid Photolmageable Mask
Copper Foil SALLL

PrePreg 1080 8.000
PrePreg 1080

3.000
FR4 Core 3.000
PrePreg 1080 8.000
PrePreg 1080

3.000
FR4 Core 3.000
PrePreg 1080 8.000
PrePreg 1080

3.000
FR4 Core 3.000
PrePreg 1080

1.000
PrePreg 1080

Copper Faoil

Liquid Photolmageable Mask

Summary information is shown in the Status Bar and
includes the units in use, the target stackup thickness and
the stackup thickness without and with soldermask.

MilsiThous |Tﬂrget Stack Up Thickness = 60.0000 |Stack Up Thickness = 59.2000 |Stack Up Thickness with Soldermask = 61.2000
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Changing the stackup view

2 For many editing operations changes to the stack may be
d _ easier to visualize when shown two-dimensionally. Click
See 2D View the See 2D View button

Liquid Photolmageable Mask 1.000
Copper Foil
PrePreg 1080 3.000

PrePreg 1080 3.000

FR4 Core 8.000

PrePreg 1080 3.000

PrePreg 1080 3.000

FR4 Core 8.000

PrePreg 1080 3.000

PrePreg 1080 3.000

FR4 Core 8.000

PrePreg 1080 3.000

PrePreg 1080 3.000

Copper Foil

Liguid Photolmageable Mask 1.000

Filtering Materials

When adding or swapping materials, available materials
(foils, prepregs, etc.) are listed in the associated material
library dialog.

Lists can be filtered for materials matching desired
parameters (dielectric thickness, Er, etc.) See Using
Speedstack Materials Libraries.

Saving stackups
It is strongly recommended that users save work frequently and
maintain safe backups of stackups and projects.
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Creating stackups manually

Go To Materials Library

Speedstack allows the designer to add or edit stackup layers
in any order, from top to bottom, bottom to top or from the
centre layer outwards. This example will create a four-layer
stackup, starting at the centre core layer and adding layers
above and below.

Editing the stack

When editing the stack it will probably be most convenient to
right click an object in the stack and select the associated
command from the context menu. The menu will reflect the
commands available for the selected object — commands
that are not appropriate for the object are greyed out.

Add 3 Foil
Core

RCC

Add C.I. Structure

Full Stack Up Editor Mode
Flexible Core
Set to Signal

Bondply
c
Setto Plane Adhesive
Set to Mixed

Prepreg
Set to Hatched Non-Copper Core
Yiew Hatch Profile Soldermask
Edit Hatch Profile Coverlay
Copy Ident
Paste Above Peelable
Paste Below Drill
Delete
Swap
Maove Up
Move Down
Properties
Flexi-Rigid »

Alternatively, select the object (copper, prepreg, core, etc.)
with the left mouse button and choose the command from
the Speedstack toolbar.

Adding layers to the stackup

Items added to the stackup are added from the currently
open materials library. Speedstack opens Program
Files\Polar\Speedstack\default.mlbx if it exists; if a different
library is required, open it via Go To Materials Library.

Note: Speedstack does not ship with the default.mlbx library.

For this discussion open one of the two sample library files,
Speedstack Imperial.mlbx or Speedstack Metric.mlbx (stored
in the Program Files\Polar\Speedstack\Samples folder at
installation time for a default installation.)
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Consistency of units

When defining dimensions for a stackup (for example, layer
thicknesses) ensure that all measurements are defined using
the same units (mils, mm, etc.) throughout the structure and
its libraries.

Note: the libraries supplied for these examples are preloaded
with sample data only.

Click the File|]New command to clear the stackup screen and
notes and information text areas.

Click the File|Save Stackup or Save Project command to save
the stackup or project. Users are recommended to save
stackups or projects frequently during the stackup creation
process to avoid data loss. Stackup files, project files and
library files should be backed up to a secure location.

Adding a core layer

+ Click the Add Layer Material button and choose Core...the

= Core library is displayed
Add Layer Material y play

The Core library contains full details of the core material,
including base and finished thicknesses, dielectric constant,
and upper and lower copper thicknesses.

Supplier Description | Description | Stock Mumber Dielectric Base Thickness | Dielectric Finished Thickness | Dielectric Constant UpperCu Base Thickness | Lower Cu Base Thickns
SO0 FR4 Core 2 400-001 2 2 4.2 0.7 07
CO/002 FR4 Core 2 400-002 2 2 4.2 1.4 1.4
CO/003 FR4 Core 2 400-003 2 2 4.2 2.8 2.8
Co/o04 FR4 Core 3 400-004 3 3 42 07 07
C0/005 FR4 Core 3 400-005 3 3 4.2 1.4 1.4
Click on any of the column buttons to sort the library list by
the selected column.
— Choose a core type from the list of cores and click the Add
|| . .
Add Material above  Material Above button. The core is added to the stackup

screen. When editing a stack this button adds a core above
the selected layer.

Stackup core layer

J— Layers may also be added below the selected layer. The
— Add Material below Add Material below button adds a core below the selected
layer.

As each layer is added the stackup information table is
updated to reflect the current status of the stackup.
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Stack Up Information

Field Walue
Electrical Layer Count 2

Stack Up Cost 0.00
Copper Thickness 11.0236
Dielectric Thickness 51.9635
Solder Mask Thickness 1.9685
Target Stack Up Thickness &2.9521
Stack Up Thickness 62 991
Stack Up Thickness with Scldermask 645606

Stackup information table

Note: The Stackup Information is printed in red when the
stack thickness is outside its tolerance.

With the core selected, the Selected Item table displays the
properties of the core.

Selected ltem Information : Core

Field Walue -
pper Cu Base Thickness 35.00
pper Cu Finished Thickness 35.00
|pper Copper Coverage 0
Minimum Trace Width 75.00
Diata Filenames

Dielectric Base Thickness 100.00
Dielectric Finished Thickness 100.00
Dielectric Constant 42
Loss Tangent 0.0195
Resin Content 53

Tg 180
Td 0

CAF Resistance 0

Z Awis Expansion 0
Excess Resin 0.00
Isclaticn Distance 100.00
Lower Cu Base Thickness 35.00
Lower Cu Finished Thickness 35.00
Lower Copper Coverage 0
Minimum Trace Wdth 75.00

Core layer information

To observe the properties of any material, click the material
in the stack and read off the properties in the Selected Item
Information panel.
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Editing the selected layer properties

To change the properties of the selected object (for example,
to modify the dielectric constant or the value for the finished
thickness of the dielectric), right click the object in the
stackup and choose Properties from the shortcut menu; in
this example the Core Properties dialog is displayed.

Note that the Enable Finishing setting in the Tools|Set
Stackup Thickness/Finishing Options dialog must be
unchecked to enable the Finishing Thickness to be specified
manually.

Change the value to the corrected value and click Apply.

Core Properties

Main | Notes | Atributes

General Information
Supplier

Supplier Description
Description
Stock Number

Type

Upper Copper
Base Thickness
Finished Thickness

Data Filename

Finishing Applied
Dielectric

Base Thickness

Finished Thickness

Dielectric Constant

Less Tangent

Resin Content %

Tg

Lower Copper

Base Thickness
Finished Thickness

Data Filename

Finizhing Applied

Apply
|Pc-|a|' Samples Exchangs Copper | Close
[FR4 Core Cost 8.00
[400-008 Tolerance  [10.00
|FR4 Lead Time  |0.00
35.00 Copper Coverage % 0.00
35.00 Graphical Colour
- Remaove Copper r

(dizabled if structures or sub-stacks exist)
-
100.00 Td 0.0
100.00 CAF Resistance 0.0
4.2000 Z fas Expansion 0.0
0.0195 Excess Resin 0.00
53.00 Isolation Distance 100.00
180.0 Graphical Colour
35.00 Copper Coverage % 0.00
35.00 Graphical Colour
i Remowve Copper w
(dizabled if structures or sub-stacks exist)
~

Adding data file names
If available, add the data file name(s) to the upper and lower
copper layers and click Apply.

Close the dialog when all changes are completed.
Changes will be reflected in the Stackup Information table.
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Changing a layer function
In this example both the signal layers above and below the
core dielectric are changed to planes.

Click the lower signal layer and click the Set Layer Plane
= button. Repeat for the upper signal layer.

Set Layer to Plane The changes are reflected in the stackup window

Exchanging layers
To change just the core dielectric (leaving the copper layers
unaffected), right click the core material (for example the FR4
in the graphic above) and choose Swap from the context
@ menu or left click the core material and click the Swap
Selected Material button. Choose the new core type from the
library and click the Swap button. The layer properties will
change to reflect the new material and changes appear in the
Stackup Information table.

Swap Selected Material

Adding prepreg layers
With the core selected, click the Add Material button and
choose Prepreg...; the Add Prepreg library is displayed.

== | Add Material

Supplier Supplier Description Description Stock Mumber Dielectric Base Thickness | Dielectric Finished Thickne| Dielectric Constant Loss Tangent Resin Content
PolarSamples PPi005 PrePreg 106 300-005 50 50 42 0.0195 a0
Polar Samples PPi001 PrePreg 1080 300-001 75 75 4.2 0.0135 a0
PolarSamples PP/004 PraPreg 1651 300-004 150 150 42 0.0185 47
PolarSamples PP/D02 PraPreg 3080 300-002 75 75 42 0.0185 a0
PolarSamples PP/003 PrePreg 3113 300-003 100 100 4.2 0.0195 53
PolarSamples PP/005 PrePreg 7628 300-005 200 200 4.2

0.0135 45

The Prepreg library contains details of the prepreg material,
including base and finished thickness, dielectric constant and
loss tangent, resin content and excess resin.

Choose the Prepreg material from the database and click the
Add Material Above button.

L

Add Material Above

PrePreg 1080 i -3 . (DD

FR4 Core

The prepreg layer is added above the core.

To change the properties of the prepreg material right-click
the layer and choose Properties from the short cut menu.
Items with a white background can be modified.
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—Dielectric
Base Thickness
Finished Thickness
Dielectric Constant
Loss Tangent
Resin Content %

Ta

Td

CAF Resistance
£ Bz Expansion
Excess Resin
Isolation Distance

Graphical Colour

=

Select the Core material and click Add Material|Prepreg to
display the prepreg library and click the Add Below button. The
layer of prepreg is added below the core.

Add Prepreg Below

PP

Core

PP

FR4 Core

PrePreg 1080

PrePreg 1080

Modify the properties as necessary.

Choosing the Display Data fields
The Speedstack Stack Editor provides a range of useful data
fields for optional display alongside each material. Base and
Finish (Display Field 4) refer to thicknesses and weights and
appear to the left of the stackup graphic.

Hatch Defautts | Extemal Ltiities | Rebuild and Calculate Structures |
General | Structure Defaults I Licensing I File Locations I Goal Seeking I Auto Stack I User I CITS Test I Colours I Passwords | Miscellaneous I
—Default Stack Up View ——— [ Display Data
20 Display Fields 1 and 2 are reserved for Layer Numbers and Layer Types
Display Field 3 Display Field 4 | Display Field 5
* 3D Description ;I Baze Thickness LI Finished Thickness LI
Finished Thickness ~
. Finished Thickness Copper Coverage
[ Units Copper Coverage Isolation Distance
|sclation Distance Dielectric Constant
& Mils/Thous " Microns = Millimetres | Dielectric Constart Resin Cortert
Resin Content Tg
Ta Calour
Processed Thickness ¥ Data Filenames h
[¥ Open last used file on application start up
v Display File Properties Dialog for New Stackups and Projects
Apply | Cancel I

Display Field 5 appears to the right of the stackup graphic.
Choose the data of interest from the drop down lists.

Note: Processed Thickness is the Finished Thickness for
copper layers and Isolation Thickness for dielectric layers.
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Adding a foil layer

Select the upper layer of prepreg and click the Add Layer
Material button and choose Foil to display the copper foil

library.
Supplier Description | Description | StockMumber | Cu Base Thickness | Type | Cost | Lead Time
FCWOo1 Copper Foil  100-001 0.7 Copper 1 a
FCwon2 Copper Foil  100-002 1.4 Copper 2 a
FCWOD3 Copper Foil  100-003 2.8 Copper 3 a

Choose the foil type and click Add Above, the copper foll
layer is added above the selected prepreg layer.

PrePreg 1080

FR4 Core

PrePreg 1080

Repeat the procedure for the lower prepreg layer: select the
lower prepreg layer and add a layer of copper foil below the
layer (shown below as layer 4 in the 3D view).

S yy O 7

PrePreg 1080

FR4 Core

PrePreg 1080

Copper Foil

To alter the foil properties, right-click the foil layer and
choose Properties. Using the Properties dialog the user can,
for example, specify that the trace is shown inverted.

— Copper
Base Thickness IW Copper Coverage % IF
Finished Thickness Iﬁ Graphical Colour _
Data Filename |
Trace Inverted v Re : g2 i r
Finishing Applied v '
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Note that the stackup is being built symmetrically about the
centre layer.

Adding solder mask layers

With the upper layer of foil selected, click the Add Layer
Material button and choose Soldermask to add a layer of LPI
solder mask above the foil.

Supplier Description | Description | Stock Mumber | Mazk Thickness | Dielectric Constant | Colour | Type Cost
SN0 Liquid Photolmagesablke Mask 500-001 1 4 Green SolderMask 0.5
SMao2 Liquid Photolmegesbe Mesk 500-002 1 4 Green SolderMlask 0.6
SMO03 Liquid Photolmegesbe Mesk 500-003 1 4 Blue SolderMask 0.6
SMi004 Liquid Photolmagesble Mesk 500-004 1 4 Red SolderMask 1

Repeat the process for the solder mask material below the
lower foil layer.

Liguid Photolmageable Mask

Copper Foil

PrePreg 1080

FR4 Core

PrePreg 1080
Copper Foil
Liqud Photolmageable Mask

Adding the Ident layers

Select the lower LPI Soldermask layer and click the Add
Layer Material button and choose Ident to add a layer of
Screened Ident below the layer. The sample Ident library
includes ink thickness and colour

Supplier Description | Description | Stock Mumber | Ink Thickness | Colour | Type | Cost

1Cv001 Screened [dent §00-001 2 White Ident 0.1
IDv002 Screened dent  §00-002 2 YWellow Ident 0.1
1DvD03 Screened ldent S00-003 2 Bleck Ident 0.1

Repeat for the upper layer.
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Screened |dent
Liqud Photolmageable Mask

Copper Foil

PrePreg 1080
FR4 Core

PrePreg 1080
Copper Foil

Liqud Photolmageable Mask

Screened |dent

Adding a drill

T
AddDrill

To add a drill between layers click the Add Drill button; the
Add Drill dialog is displayed.

i Add Drill
— Elecincal Layers
Column First Electrical Layer No Second Electrical Layer No
|1 = =l s |
— Dinll Informabion —Hole Informahon
' Mechanical Fill Type Hole Count
" Laser Mo Fill =l (o
" Laser (Stacked) Copper Different Hole Sizes
Resin
v 0
[¥ Through Flated o sk |
Data Filenames [F:Jz:izﬁ:ctwe Minimum Hole Size
Sintering Paste Iﬂ.ﬂ-l]'
Copper Paste

Add Close

Select the column in which to place the drill. Choose the first
and second electrical layer numbers (layers 1 and 4 in the

example).

Specify the drill type, mechanical or laser and whether

through plated.

Note that with laser drills the order of drill layers is important,
e.g. layer 1 and 4 is different from layer 4 and 1.

Choose the Fill Type from the dropdown list of fills.
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Screened [dant

Optionally, add the NC drill data filenames.

Optionally, add the hole count, number of different hole sizes
and the minimum hole size. Click Add and close the dialog.
The drill information is added to the stackup. The example
below contains through plated and laser drill information.

Deleting drills

To delete a drill right click the drill and from the context menu
choose Delete. To delete all drills choose Delete all Drills —
confirm via the dialog below.

Speedstack =

You are about to delete ALL drills from the stack. Do you wish to continue?

Yes Mo Cancel

All drills will be cleared from the stack.
The finished stackup is shown below

Liquid Photolmageable Mask

Copper Foil

PrePreg 1080

FR4 Core

PrePreg 1080

Copper Foil

y

Liquid Photolmageable Mask

Screened [dent

Adding stack vias

Speedstack can add stack vias to the stackup in a single
operation. To add stack vias between layers 1 and 5 in the
stackup below, select layer 1 and click Add Drill.
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1.000

Liguid Photolmageable M
Copper Foil
PrePreg 3113

PrePreg 1651
[3|:||:||:|E:r Fail

PrePreg 1651

Copper Foil &.000

PP PrePreg 1651

5627

Core FR4 Core

Specify the column number and electrical layers 1 and 5 and
choose Laser (Stacked) — from the Fill Type drop down list
choose Copper. Click Add.

f Add Drill *
— Electncal Layers
Column First Electrical Layer No Second Electrical Layer No
[ =l |1 I -
— Drill Information —Hole Information
" Mechanical Fill Type Hele Count
 Laser Copper ;I ||]
' Laser (Stacked) Different Hole Sizes
W Through Plated o
Data Filenames Minimum Hole Size
0.0020
Add | Close

The stack vias are added to the stack (below.)

Note: The drill properties (i.e. Drill Information and Hole
Information) are retained between each Add Drill operation.
This can speed up the process of adding drills, especially
when multiple drills of the same type are being added to the
stackup.
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PP

Core

X

Material

1.000

Liquid Photolmageable Mask

Copper Foil
PrePreg 3113
Copper Foil
PrePreg 1651
Copper Foil
PrePreg 1651
Copper Foil

PrePreg 1651

FR4 Core

Delete Selected

Copy Selected Material

om0

COPY

Copy Material

Properties

5627

5627

2.000

5627

Deleting a layer
To remove a layer from the stackup select the layer and
click the Delete button.

Copying a layer
With layers defined it will often be found more convenient to
copy an existing layer and paste it into the stackup than to
create a new layer “from scratch”. Select the layer to be
copied and click the Copy Selected Material button. Click the
layer nearest the destination location and choose Paste
Above or Paste Below as appropriate

Note: when modifying the stackup it may be necessary to
redefine the drill information to reflect the changes.

Copying material properties

Speedstack can copy material properties from one material
in the stackup and paste them onto multiple materials
simultaneously.

For example, to replace the three prepreg materials below
Layer 3 in the stackup below with the Layer 1 material,
PrePreg 1080, select the source material (shown
highlighted below) and click Copy Material Properties
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1.100

Liquid Photolmageable Mask

& & O 50

Copper Foil C

-
PrePreg 3080

PrePreg 1651 12.000

PrePreg 1651
Select the three target layers

1100

1.950
Liguid Photolmageable Mask

i - .-l/ oy SId
Copper Fail C A 3.100
= ‘

PP PrePreg 1080

Core FR4 Core

PP

12.000

Eﬁ Click Paste Material Properties — the Paste Material
omo

Paste Material Properties dialog is displayed.
Properties
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Paste Material Properties

Flease select the Property Groups that you wish to paste to the selected matenals:

General Properties (All Matenals)
[v General Information (Supplier, Description, Stock Mumber etc)

[v MNotes (5 x Mote properties)

[v Colour (Draw colour)

Conductor Propertes (Faoil, Core, RCC, Flex Core)
[v Copper (Base and Finished Thickness, Copper Coverage etc See Note 1)

MNote 1: Layer Numbers and Layer Types assigned to Copper layers are not copied.

Dielectric Properties (Core, RCC, Prepreg, Flex Core, Bondply, Adhesive)
[v Diglectric (Base and Finished Thickness, |solation Distance, Diglectric Constant etc)

Solder Mask Properties (Solder Mask)
[v¥ Solder Mask (Thickness, Dielectric Constant etc)

Coverlay Properties (Coverlay)
[v Coverlay (Base and Finished Thickness, Dielectric Constant etc)

Ident Properhes (ldent)
[v I|dent (Thickness tc)

Peelable Properhes (Peelable)
[v¥ Peelable (Thickness etc)

¥ Select/ Deselect All ooy | cancel |

Select the property groups that are to be applied to the target
materials and click Apply. Properties that do not apply for a
material type are ignored.

1.100

1950
Liquid Photolmageable Mask

Copper Foil C : 3100

PrePreg 1080

FR4 Core

12.000

In this example all material properties have been applied to
the three target materials.

Note: When changing multiple materials simultaneously it is
important to review the resulting stackup. It will probably be
necessary to recalculate any associated controlled impedance
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i |

Move Selected Material Up

1

Move Selected Material Down

e

Apply Finishing

KL

Reset Finishing

20

See 2D View

Screened [dent

structures, especially if dielectric height and copper thickness
parameters have changed.

Moving materials

To move materials within the stackup use the Move

Selected Material Up and Move Selected Material Down
buttons.

When a material is moved it is exchanged with the layer
above or below, respectively.

Applying finishing
To apply the finished thickness factor throughout the board,
click the Apply Finishing button with no material selected.

To reset the finished thickness back to the original base
thickness of the materials throughout the board, click the
Reset Finishing button with no material selected.

Note: when applying or resetting finishing, if a material is
selected it will be necessary to specify whether finishing is to
be applied to the selected material only or the whole stack.

Displaying the stackup in 2-dimensional view

To change the view of the stackup from its default 3-
dimensional aspect, click the See 2D View button. The
stackup is displayed in 2-dimensional view.

Liguid Photolmageable Mask

Copper Foil

PrePreg 1080

FR4 Come

PrePreg 1080

Copper Foil

Liguid Photolmageable Mask

Screened [dant

See 3D View

Click the View 3D button to restore the 3 dimensional view.
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Symmetrical Builds

Mirror Build

Mirror Build allows the designer to consider the stack in two
halves, designing and building, for example, just the top half
and mirroring the structure into the lower half.

Build the top half of the stack, including any controlled
impedance structures and click the Mirror Build button;
specify whether the current set of layers is the upper or lower
half of the stack. To maintain symmetry, Speedstack will add
a layer of material as appropriate to the stack;

Mirror Build

Which half of the new stack is this7
Bottom

[t will b2 necessary to add another prepreg to Cancel
complete the Mirrored stack.

i

the stack is reflected symmetrically into the lower half.

In Symmetrical Build mode the Speedstack maintains stack
symmetry as the stack designer creates or edits a stack.
Changes in one half of the stack are reflected in the opposite
half of the stack to ensure a symmetrical stack.

This example considers an 8-layer stack — beginning with
three cores and then using Symmetrical Build.

Creating a new stack
Create a new empty stackup and add three cores.

S I ST

y P 7P 77/
y 77 777774

When constructing complex structures it will often be found
easier to use the two dimensional aspect.
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20

View 2D button

To change the view of the stackup from its default 3-
dimensional aspect, click the See 2D View button. The
stackup is displayed in 2-dimensional aspect.

Symmetrical OFF

Symmetrical ON

FR4 Core

FR4 Core

FR4 Core

Adding a prepreg layer in Symmetrical Mode
In this example it is necessary to add prepreg layers
between cores to achieve the required dimensions.

Switch to Symmetrical Mode and work in the top half of the
stack — in Symmetrical Mode as layers are added to the top
half of the stackup the Speedstack will add layers to the
lower half of the stackup to maintain stack symmetry.

To add a layer of prepreg between Layers 2 and 3 select
Layer 3 (the selected layer is shown highlighted in the figure
below.)

Click the Add Material button and add a layer of prepreg
above Layer 3 (shown highlighted in the figure below).

In Speedstack’s symmetrical mode the prepreg layer is
automatically reflected in the lower half of the structure.
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FR4 Core

FR4 Core
PrePreg 1080

FR4 Core

Adding a second prepreg layer

Now add a second layer of PrePreg 1080 above the layer
just added; the new prepreg layer is reflected in the lower
half of the stack as shown below.

FR4 Core

FR4 Core

PrePrg 10
PrePreg 1080

FR4 Core

Next, add a layer of prepreg above layer L1 in the upper half
of the stackup.

Speedstack in symmetrical mode automatically maintains
stack balance by adding the corresponding layer below L6.

FR4 Core

PrePreg 1080

PrePreg 1080
FR4 Core

PrePreg 11
PrePrag 1080

FR4 Core

PrePreg 10
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Adding foil, LPI Mask and Ident layers
Next, add a foil layer (L1 below) which is mirrored as L8; as
part of the process Speedstack inverts layer L8.

FR4 Come

PrePreg 1080

Copper Foil

Next, LPI solder mask is applied to the top side of the
stackup and reflected on the bottom side.

Copper Foil
FraFrag 1384

FreFreg 1000
Copper Foil
Liquid Photolmageable Mask

Ident layers (which are not considered components of
electrical symmetry) will not be automatically reflected by
Speedstack as they are added and must be applied
separately to each side of the board.

Select the upper solder mask and add an Ident material
above; select the lower solder mask and add an Ident
material below.

Secreened Ident
Liguid Photolmageable Mask

Copper Foil

Copper ol

sk
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Assigning ground planes
With all the material in place, assign ground planes; begin
with layer L2 — it’s reflected in layer L7. Right click the

Set Layer To Plane  ¢copper (L2) in the top core and choose Set Layer to Plane.

PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080

PrePreg 1080

FR4 Core

Repeat the process for the other ground plane layers; layer
L4 is designated a ground plane, the change is reflected in
L5 in the lower half of the stack.

PrePreg 1080

FR4 Core

PrePreg 1080
The completed stack is shown below

Screened Ident
Liquid Photolmageable Mask
Copper Foil

PrePreg 1080
FR4 Core

PrePreg 1080

PrePreg 1080
FR4 Core

PrePreg 1080

PrePreg 108

FR4 Core

PrePreg 1080
Copper Foil

Liguid Photolmageable Mask
Screened Ident
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Design rule checking

Speedstack includes facilities to check for errors in stackup
design, such as layers placed in invalid order or
asymmetrical structures. The condition of the design rule
checkboxes is carried over from session to session.

The Design Rule Checker (DRC) displays results in the DRC
dialog. As each design rule is broken the Speedstack
increments the error count on the DRC tab.

Viewing design rule errors
Click the DRC tab to view errors.

Stack Up Edtor DRC:0 lCu:untn:uIIed Impedance ] Cl Results ]
DRC Test Selection
[+ Design Logic v Symmetry [ Copper Balance

[v Board Thickness

[v Manufacturing Tests

¥ Min. Trace Width [+ Min. Gap \Width
Aspect Ratios

v Mechanical Drill [+ Buried Laser Microvia
[+ Blind Laser Microvia v Trace

[ Resin Starvation

The Design Rule Checker checks include checking for:

Two adjacent copper layers

Resin coated copper on internal layer

External prepreg layers

Internal solder mask material

Internal ident material

Internal peelable mask

Symmetry — different material types

Copper not balanced

Board thickness (if the board is outside tolerance the

Stack Information in the Stack editor is displayed in red)
Manufacturing tests

Minimum trace width (the test is carried out when
calculating controlled impedance)

Minimum trace separation (the test is carried out when
calculating controlled impedance)
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Drill aspect ratios for plated holes
Track aspect ratio
Excess resin test (Resin Starvation)

If the Resin Starvation check box is ticked values are shown
as below; scroll through the layers as required

Layer Resin !
R
| 10134.3%
_ 2
3
2757.1%
4 v

Note: If the Resin Starvation check box is ticked, all prepregs
must include valid values for the excess resin field.

Polar Application Note AP509 includes a discussion on
calculating excess resin.

Users can choose to display all errors or to select from a
combination of design errors, symmetry errors and copper
balance errors, etc.; check the boxes as required.

Click on the errors shown in the list to highlight the errors in
the stackup screen.

Resin Level Low:

Resin Level Low: -100.0%
Resin Level Low: -100.0%
Resin Level Low: -100.0%

Errors are highlighted in red.

Fail Copper Fol 1.400

PP PrePreg 1080 3.000 s 3000

Core FR4 Core 2.000 2.000

O
0.700

Correcting design rule errors

Users are strongly recommended to work through and
correct errors in the order in which the errors are listed. Note
that clearing each error may clear other errors in the
process.

Manufacturing tests should be fixed before sending the PCB
for manufacture. Hole sizes should be adjusted to comply.
Failures with track and gap should be corrected, possibly by
changing prepreg thickness and/or dielectric constants.

A collection of manufacturing constraints can be defined and
the required one selected.
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Creating and using manufacturing constraints

From the Tools menu, select Manufacturing Constraints: the
Manufacturing Constraints window opens, displaying any
manufacturing constraints added.

Manufacturing Censtraints

Manufacturer's Mame Blind Laser ViaA. R.| Buried Laser ViaA. | Mechanical Drill A. R. Minimum Gap Minimum Trace Width Trace A R.
Polar Mils . . . Mils
Polar Millimetres . . . Millimetres
Polar Inches . . . 1 1 Inches

Lo

Highlight Set New Close

"Cu'rent Active C

By default there will always be at least one. It is important to
always have one constraint set active.

Editing constraints

Double-click on a constraint row will bring up the Edit
Constraints dialog; use the dialog to add, delete or edit
constraints (gaps, trace widths, aspect ratios, etc.)

Edit Constraints

Units
 Mils " Microns
" Inches " Millimetres
Oiption Name IF‘oIar Microns
Minimum Gap |75
Minimum Trace \width |75
Mechanical Drill AR. |8.5
Blind Via AR. [0.5
Buried Yia A R. 0.5
Trace AR. |1

< < 1of 4 > =2

Add | Delete |
Done |  Cancel

80 e Speedstack PCB Stackup Design and Documentation



To edit a constraint set, use the navigation buttons to select
the set to be modified, change the values as required and
then press Done.

To delete a constraint set, use the navigation buttons to
select the set, then press Delete.

To add a new constraint set, press the Add button, this will
add a new (empty) constraint row, enter the name and
constraint values and press Done.
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Adding controlled impedance structures

Speedstack incorporates the facility to add controlled
impedance structures to a layer in the stackup.

Speedstack is integrated with the Polar Instruments
Si8000mM/9000e controlled impedance field solvers so
impedance values for a structure may be calculated at the
click of a button.

Structure parameters may be copied to the field solver for
processing (for example by the Si8000m/9000e Goal Seeking
function) and calculated values pasted back into Speedstack
for insertion into the stackup.

Each structure can be assigned up to five net class names.
These net class names provide a link to the matching
impedance nets inside the ECAD PCB layout system.

Speedstack Si caters for frequency dependent calculations,
adding comprehensive insertion loss capability into
Speedstack. Bidirectional copy and paste from Speedstack
Si into Si9000e includes all the relevant loss tangent,
roughness and roughness modeling methods along with
frequencies of interest.

Adding a controlled impedance structure

For the example stack below, add a controlled impedance
structure to signal layer 4.

2.000
s 1.000
Screened |dent 21000

3.000

Liguid Photolmageable Mask |
: ) i ) / / / / / .
Copper Fail 0. 8.000

PrePreg 1080
3.000

FR4 Core 8.
u. M 8.000

PrePreg 1080

sy

FR4 Core ’
8.000

PrePreg 1080

FR4 Care /’ ’ / l "/ / 3.000
EreF'rize-gH:.lED ! :I II,
~opper Foil )

hotolmageable Mask

Sample stackup (showing signal layer 4 selected)
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Note that in this example Layer 5 is a mixed signal/plane
layer. Potential reference planes for Signal Layer 4 are
therefore Plane Layer 2, mixed Signal/Plane Layer 5 and
plane Layer 7.

With Layer 4 selected, click the Controlled Impedance tab.
The Add Structure button is displayed.

Stack Up Editor | DRC: 1 Controlled Impedance | CI Resuts |

+

Click the Add Structure button; the Structure Control dialog is
displayed containing the controlled impedance structures
applicable to the selected layer in the stack. Choose values
for the target impedance and tolerance. If necessary, resize
the Structure Control dialog to view all structures.

—MNumber Of Signal ——

Tracks - e |
" Single Trace soplyall |
o ) Edge Coupled

Differential Offset Stripli...
" Broadside —— Advanced_ |
Edge Coupled
Cffset Stripli...
_ Dif Ofset. "
Target Impedance |1DD.D
Target Tolerance % I'lﬂ.ﬂ
Total of Structures Added o
Primary Reference Flane IE =k I
Secondary Reference Plane |? Cancel |

Click the Single Trace, Differential or Broadside option button
as appropriate (in this case, choose Single Trace|Offset
Stripline 1B1A with a 50 Ohm impedance.)

Note: Broadside only appears as an option where the signal
trace is between two reference planes and Differential is
selected.

Specify the values for Target Impedance and Tolerance.
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Choosing reference planes

As there are multiple reference planes available (layers 2, 5
and 7, it will be necessary to specify which planes to use for
this structure. Click Advanced.

Plane(s) Above Signal Layer

Signal Layer = 4

Plane(s) Below Signal Layer

Caution: When using this option,
please ensure that the electncal
effects of any intervening power |
mixed planes are taken into
consideration

ok |  cancel |

Choose a reference plane from the list of available planes. In
the example structure plane layer 2, mixed plane 5 and plane
layer 7 are available for reference.

Note: if plane layer 7 is chosen as reference, it will be
necessary to take into account the electrical effects of mixed
signal/layer plane 5.

In this example choose mixed signal/plane layer 5. Press OK
to confirm. The chosen reference planes are shown below.

Tetal of Structures Added |1
Primary Reference Plane |2 Done |
Secondary Reference Plane |5 Cancel |

Repeat for all structures to be added. Click Apply for each
structure then click Done to finish. In this example, choose a
single structure.

- Layers with controlled impedance structures are indicated
[ | by a red Ohms symbol.
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8.000

3.000

Core FR4 Core

8.000

BE PrePreg 1080

Vy & V9 I9F

Core FR4 Core

The stackup window changes to reflect the selected signal
layer and its associated reference planes. The applied
structure is displayed in the Controlled Impedance pane.

Offset Stripline 1B1A

Substrate 1 Height H1[eooo0
Substrate 1 Dielectric Er1]4.2000
Substrate 2 Height Hz2 [io000
Substrate 2 Dielectric Er2|4.2000
Lower Trace Width wil59055
Upper Trace Width W2 149213
Trace Thickness T1 [o7000 |
Impedance Zo[o.00
Target Impedance 50.00
Target Tolerance % fooo

The window displays the parameters of the controlled
impedance structure. Fields shown "greyed out" are values
derived from the choice of materials in the stackup. For this
structure, enter the appropriate values for lower and upper
trace widths.

Click the Calculate Displayed Structure button to display the

*='| Calculate Displayed impedance value of the structure with the current parameters.

Structure The parameters may then be varied to alter the value of the
final impedance. In the example above the trace width can be
fine-tuned in order to approach the value of the target
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impedance; other parameters are changed by modifying the
stackup dimensions (for example, core thickness, H1.)

Hint: clicking Apply All in the Structure Control dialog adds a
single instance of all structures matching the stackup layer
and the chosen criteria; the designer can then choose the
structure producing the value nearest the target impedance
and delete the structures that are not needed.

Controlled impedance toolbar

Controlled impedance operations are performed via the
Controlled Impedance toolbar.

Add controlled impedance structure to current layer

Delete structure from current layer

x Clear all structures from current layer
.
-

Rebuild and recalculate all structures

Calculate displayed structure

%z
l-] Mirror structures

Goal seek

|
EE|  Set CITS test

Free hand notes

Structure layer properties

Structure validation

Structure Net Classes

Frequency Dependent Properties

Use the structure browse control to display the structure on
each layer and navigate through the structures

L:4 | I« <'1Df1 = | =l
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Changing parameter values

Clicking the Calculate function yields a value for impedance.
Parameters (for example, the dielectric height) may be
amended to yield a value for impedance closer to the target
impedance.

For this example, select the core layers; click the Swap
Selected Material button and choose a different core (ensure
the same dimensional units are used throughout the
structure) and click the Refresh and Calculate Impedance
button. The impedance is recalculated to its new value.

To achieve an impedance acceptably close to the target
impedance, use the goal seeking function of the Si8000m to
alter other parameters (in this case, change the upper and
lower trace widths).

Goal seeking with Speedstack

Speedstack provides the facility to solve for horizontal
parameters (e.g. trace width and separation, ground strip
separation, etc.) to produce the target impedance (or
calculate that the target impedance is unachievable with the
current values).

Click the Goal Seek button to display the Set Up GoalSeek
dialog; the options available will depend on the controlled
impedance structure.

Set Up GoalSeek
Goal Seeking Farameter(s)
{* W12 only
~
~
~
" H1 Only

" H2 Only
~

r~

Ok Cancel

Click OK; the Speedstack attempts to arrive at the target
impedance by iteratively modifying the specified parameters.
It may be necessary to add or delete prepregs to achieve the
target impedance.
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Goal seeking with the Si8000m/9000e

Speedstack Stackup Builder is fully integrated with the
Si8000mM/Si9000e Controlled Impedance Field Solvers.
Users can transfer Stackup layer dimensions to the Field
Solver, solve for stackup parameters to produce the target
impedance (or calculate that the target impedance is
unachievable with the current values) then transfer the
solved dimensions back to Speedstack.

Ensure the Field Solver is running and that its units match
the Speedstack units.

With the stackup parameters displayed in the Controlled
Impedance window, click To Field Solver to transfer the
To Field Solver current Speedstack parameters to the Si8000m/Si9000e.

Switch to the field solver and click the Paste from

= Speedstack button to load the parameters into the
— Paste from associated field solver fields. The field solver reflects the
Speedstack structure and parameters of that selected in Speedstack.
Tolerance  Minimurn b aximurn
Offset Stripline 1B1A Substrate 1 Hflght . H1 B.uunnjtl 00000 | 60000 EO0O0 Caloulse
Substiate 1 Dielectric Ert [ 42000 =} *[ 00000 [ 42000 [ 42000 Caloulate
Substrate 2 Height HZ | suuunjﬂ 00000 | 90000 | 90000 Caloulate
Substrate 2 Dielectric Bz | 4.2oonjt| 00000 | 42000 | 42000 Caloulate
Lower Trace Width Wi 5.99?8jt| 00000 | 59978 | 69978
Upper Trace Width we [TEmas-=-t[ om0 [ 5036 [ 503 Caleulate
Trace Thickness T [Torooo-<+[ ooooo [ o700 [ 07000 Caleulate
Impedance Zo | E000 [ 5000 [ B000  Calculste
More...

For the data shown above seek a final value for impedance of
50 Ohms; H1, Erl and T1 are fixed, so goal seek on W1,W2.

Click the Upper Trace Width (W2) Calculate button to goal
seek on trace width. The field solver returns new values for
trace width to produce 50 Ohms final impedance.

Lawer Trace Width LA E.ESD?jtl 00000 | 69907 | 59907
Upper Trace Width we | 4_aan?jt| 0.0000 | 49907 | 49907

Click the Copy to Speedstack button, switch to Speedstack
and click the From Field Solver button to display the solved
Copy to Speedstack parameters for the target impedance.

Note: it may be necessary to round some dimensions (for
example, the dielectric heights) to the nearest practical
values and recalculate the impedance.

“ 1IN

From Field Solver
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Changing layer functionality

It is often convenient to base a new design on an existing
stackup and then add or remove electrical layers to create
the new stack, leaving the previous existing structures intact
or to switch between layer types (Signal, Plane, Mixed,
Hatched) without removing structures.

Speedstack allows the designer to retain and re-allocate
structures when changes are made to the electrical layers of
the stackup. This enables reallocation of structures after the
following stackup changes:

Adding foils and/or cores — increasing the layer count
Deleting foils and/or cores — reducing the layer count

Moving foils and cores up and down, even beyond
another copper layer — maintaining the layer count but,
for example, exchanging two different thickness cores
within the stackup

Copying and pasting foil or core — increasing the layer
count

Changing layer type — signal to plane, plane to signal,
mixed to signal or plane, signal to hatch, hatch to signal

Deleting a rigid core and adding a flex core — to maintain
layer count but swapping material type

Deleting a rigid core and adding two foils — to maintain
layer count but switching to an HDI type build

For the following examples, consider the stack below.

Liquid Photolmageable Mask 4000
Copper Foil 0.700

PP PrePreg 1080 4200 1850
Core FR4 Core 4200

PP PrePreg 3080 4200
PP PrePreg 1651 4200

PP PrePreg 1651 4200
Core FR4 Core 4200

PP PrePreg 1651 4200

PP PrePreg 1651

PP PrePreg 3080
Caore FR4 Care

PP PrePreg 1080 4.200 1.950
Co pper Foil 0700

Liguid Photolmageable Mask 4.000
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Switching layer types and reallocating structures

saa === =a= ===  Gwitch signal layer 2 to a plane layer and plane layer 3 to
’ a signal layer. Speedstack issues a warning indicating that
continuing with the change will require the existing
structures to be re-allocated.

Set Layer To Plane

Speedstack

I.-”"_"\-. This acticn will invalidate some or all existing structures. You will be

WY ableto check and re-allocate them afterwards using the Structure
Validation and Structure Layer Properties options. Do you wish to
proceed?

Yes Mo

Select Yes to confirm the change to the stackup. The stack
editor reflects the change in the stackup, layer 2 is a plane
layer and layer 3 a signal layer.

Liquid Photolmageable Mask 4.000

Co pper Foil 0.700

PrePreg 1080 4200 1 ’ ________________________________________________________________ 1.950

FR4 Core

PrePreg 3080

PrePreg 1651

Speedstack also displays a flashing Rebuild indicator; due to
the changes to the stackup it is necessary to refresh the
structures.

Stack Up Editor | DRC: 1 Controlled Impedance | CI Resuits |

XX EEL =w@n

o+ Click the Rebuild
> and Recalculate
Rebuild icon —
and Speedstack
Recalculate displays an

information dialog
indicating which
structures need
re-allocating.

90 e Speedstack PCB Stackup Design and Documentation




& The following structures require attention. Please re-allocate each
' structure using the Structure Layer Properties option.

Layer: 1, Edge Coupled Coated Microstrip 18, 100 ochms
Layer: 1, Coated Microstrip 1B, 73 chms

Layer: 4, Edge Coupled Offset Stripline 1814, 100 chms
Layer: 4, Offset Coplanar Strips 1814, 50 chms

Click OK then click the Structure Layer Properties icon to
reallocate the structures to the correct signal and plane
layers.

Stack Up Editor | DRC : 3 Controlled Impedance | CI Resuts |

XX cEOEE =ML

Al | Ir-tl = |F{ebmld > | Structure La:,rerPru:lperties|
|

The Structure Layer Properties dialog includes two layer
columns, the Current layer column and the New layer
column. The Current column shows the Signal / Plane
stackup layers assigned to the structure before the stackup
was changed.

The New column allows the structure to be re-allocated to
reflect the new stackup layer types.
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Structure Layer Properties

pper Signal Layer |-| |-|

Lower Signal Layer I I

|Ipper Flane Layer |3 |2

Ll Lef L Lo

Lower Plane Layer I I

Structure Inverted IFalse
Mumber of Structures on same Ig [v Maowve All

Signal / Plane Layers

Apply | Cancel |

In this case notice the Upper Plane Layer is changed from
layer 3 to layer 2.

In many cases multiple structures will have the same Signal /
Plane layer assignments. In the example above Speedstack
indicates that there are two structures affected. Click the
Move All check box to re-allocate all matching structures in a
single operation then click Apply.

- Rebuilding the

- stack indicates

Rebuild that other

and structures (i.e.

Recalculate the two
structures on
layer 4) also
require layer
reallocation.
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PP PrePreg 1651

Caore FR4 Care

PP PrePreg 1651

Layer: 4, Edge Coupled Offset Stripline 1814, 100 chms
Layer: 4, Offset Coplanar Strips 1814, 50 chms

&_3 Use the structure
selection arrow

Structure keys to step

Layer through to the

Properties structures on layer
4 then click
Structure Layer
Properties.

Structure Layer Properties

Upper Signal Layer [+ B -]
Lower Signal Layer | | E
Upper Plane Layer 3 2 E
Lower Plane Layer 6 B -]

Structure Inverted IFalse
Mumber of Structures on same Iz v Move Al

Signal ! Flane Layers

Reallocate the layers as required then click Apply. With the
structures re-allocated Rebuild and Calculate the structures
as describer earlier.

Note that structure Trace Width and Separation parameters
are retained at their original values together with the Target
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Impedance and Tolerance. (Depending upon how the
structures have been re-allocated it may be necessary to
goal seek the trace width and separation parameters to meet
the target impedance.)

Increasing the layer count

It is a common requirement for designers to base a new
design on an existing proven stackup and then add or
remove electrical layers to create a new stack, leaving the
previous existing structures intact.

Consider the 8 layer stack below.

Liquid Photolmageable Mask 4.000
[:I:IFIFIEF Foil

PrePreg 1020
FR4 Core

PrePreg 3080
PrePreq 1651

PrePreq 1651
FR4 Caore

PrePreq 1651
PrePreq 1651

PrePreg 3080
FR4 Core

PrePreg 1080 4200

Copper Foil

Liquid Photolmageable Mask 4.000

For this example, add a core between layers 5 and 6.

Speedstack will display a warning that proceeding with the
change will require the existing structures to be reallocated.

@e% This action will invalidate some or all existing structures. You will be
| .
WY able to check and re-allocate thern afterwards using the Structure
Walidation and Structure Layer Properties options. Do you wish to
proceed?

es Mo

Click Yes to proceed.

In order to maintain a symmetrical stack, delete the Prepreg
3080 materials and add Prepreg 1651 materials to create a
symmetrical 10 layer stack.
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Liguid Photolmageable Mask 4.000
Copper Foil
PP PrePreqg 1080 4200

Core FR4 Core 4200

PP PrePreg 1651 4200
PP PrePreg 1651 4200

Core FR4 Core 4200

PP PrePreq 1651 4200

PP PrePreqg 1651 4200

Core FR4 Core 4200

PP PrePreg 1651 4200
PP PrePreg 1651 4200

Core FR4 Core 4200

PP PrePreq 1080 4200

Copper Foil
Liquid Photolmageable Mask 4.000

- M Click Rebuild and
Rebuild Recalculate
and

Recalculate

Speedstack displays an information dialog indicating the
structures that need reallocating.

Speedstack >

I.-”'- -'\-I The following structures require attention. Please re-allocate each
W' structure using the Structure Layer Properties option.

Layer: 4, Edge Coupled Offset Stripline 1B14A, 100 chms
Layer: 4, Offset Coplanar Strips 1814, 30 chms

oK

Click OK.

Use the structure navigation buttons to select the structure
layer then click the Structure Layer Properties button to
display the Structure Layer Properties dialog.
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Structure Layer Properties

Edge Coupled Offset Stripline 1B1A

S

5 w2
——

Upper Signal Layer [2 [2 B
Lower Signal Layer | | J
Upper Plane Layer B 3 E
Lower Plane Layer B E E
Structure Inverted [Fale
Number of Structures on same 2V Movedl

Signal / Plane Layers

Apply | Cancel

Note that for the modified stack the lower plane layer has
been reallocated to layer 8.

Click Apply and then Rebuild and Recalculate.

If necessary, goal seek on line widths to bring the impedance
within specification.

For the above stack edit the Drill Properties to finalise the
stack changes.

Repeat the procedure for each structure as necessary.

Structure net classes

Speedstack allows up to five Net Class names to be stored
with each structure. These net class names provide a link to
the matching impedance nets inside the ECAD PCB layout
system. Net classes are supported in Speedstack’s import /
export file formats.

Net class columns can be selected for display on the
technical report.
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i

Net classes

Select Impedance

To display the Structure Net Classes dialog click the Net

Classes button

Enter the net class names in the text boxes and click Apply.

Structure Met Classes

Met Class 1 T
Met Class 2 TX1
Met Class 3 RXD
Met Class 4 RX1
Met Class &

Cancel |

Apply |

Up to five net class names may be stored with each structure.

Click the Select Impedance Columns button and Select the
Net Class columns to display the net classes on the

Speedstack technical report.

Columns
g= Select Controlled Impedance Table Columns — O X
Selected Columns Ayailable Columns
Impedance Signal Layer ~ < |
Ref. Flane 1in Layer Broadside 2nd Layer
Ref. Flane 2 in Layer . Trace Pitch {51+ W1)
Lower Trace Width (W1) o Lower Ground Strip Width (1)
Upper Trace Width (W2) Upper Ground Strip Width (G2)
Trace Separation (51) Up | Trace Offset {O01)
Target Impedance Ground Strip Separation (D1}
Tal {+/- %) o Substrate 1 Height (H1)
Calculated Impedance own | Substrate 2 Height (H2)
Substrate 3 Height (H3)
NetClass2 Delete | Substrate 4 Height (H4)
MNetClass3 Substrate 1 Dielectric (Erl)
NetClass4 Clear Al | Substrate 2 Dielectric (ErZ)
NetClassh v Substrate 3 Dielectric (Er3) b
oK | Cancel |
The chosen columns are displayed in the selected order.
Lowsr | Upper T —— ]
Impadance | Red, Raf. Trace | Troce Trace
impedance | Swructure | Signai | Piane 1| Plane2 | width | Width | Separation| Target | Toi e/ | Calcuisted /
iD Image Layer | inLayer| inLayer| oW1y | w2) (81} P %) HoiCiass1 | HoiCiassZ | MeiCiased | MetCisssd | MeiClases

3

a

BI2a T2 a.3m 100,000 10,000 5830

=0
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Working with Si Projects in Speedstack and Si8000m/Si9000e

Si Projects

The Si Projects feature incorporated in Speedstack and
Si8000mM/Si9000e allows for easy transfer of controlled
impedance structures from the Speedstack stackup design
tool into the Si8000m and Si9000e field solvers.

Si Projects allows groups of structures to be saved and
recalled in Si8000m/Si9000e and entire stackups of
structures to be pasted from Speedstack into Si8000m and
Si9000e with just a few clicks of the mouse.

5 The To Si Project
P toolbar icon copies a
To Si group of structures

from Speedstack and
places them onto the
clipboard, these
structures can then
be pasted directly into
the Si8000m or
Si9000e Project

group

Project

Transferring structures from Speedstack to the field
solver

- The stackup below in Speedstack's Stackup Editor contains
controlled impedance structures in the layers indicated by
the Ohms symbol.

Liguid Photolmageable Mask 4.000

PrePreg 1080 4.200
FR4 Core 4200

PrePreg 3080 4200
PrePreg 1651 4200
PrePreqg 1651 4200
FR4 Core 4200

PP PrePreq 1651 4200
PP PrePreq 1651 4200
PP PrePreg 3080 4200

Core FR4 Core 4200

PP PrePreg 1080 4.200

Copper Foil

aM Liguid Photolmageable Mask 4.000
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Click Speedstack's Controlled Impedance tab and use the
structure navigation controls to step through and display the
structures.

Al | I= =:'|1 of 4 }l}ll

5 Use the Si Project
P .= toolbar buttons in the
To Si Speedstaclf and the
Project Si8000mM/Si9000e

interface to transfer
the structures via the
Windows clipboard
to the field solver.

Switch to the field solver and paste the structures from the
clip board into the field solver Si project.

Al

|Paste?ru:ur‘r1 Speedstack into 5i Project

The complete set of structures appears in the field solver's
Project window.

The Si Project window lists the transferred structures in layer
order, showing the layer number and value along with a
thumb nail graphic indicating the structure configuration.
Right click on a structure in the structure list to view the
structure options.
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Add Structure to Project
Delete Structure from Project

Rename Structure within Project

Mowe Up

Mowe Down
Duplicate Selected Structure
Clear Project

Demo Mode : Load Sample Structures into Project

Adding/deleting and modifying structures

Selecting each structure displays its associated graphic in a
grey background.

L1100 ahmz (1]

L1 75 ahms [£]

L4 100 ohs [3]

L4 50 ahms [4]

L& 75 ahms [5)

Click the + and — buttons in the structure graphic to add
additional structures from the Si structure library or remove
selected structures from the Project folder. Click the Rename
Structure (the pencil icon) to assign the structure a
descriptive name.
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L1 100 ohms (1)

With a structure selected the structure parameters can be
modified as required and the impedance recalculated.

Frequency dependent loss calculations (Speedstack Si only)

)
€T
3]

7

Frequency Dependent
Properties

Note: Frequency dependent loss calculations are available in
Speedstack only when used in conjunction with the Si9000e
Transmission Line Field Solver.

Speedstack Si (Speedstack stackup builder plus Si9000e
transmission line field solver) provides for calculations of
frequency dependent loss given the information applicable to
loss in the transmission line structure. The information
includes material properties, comprising dielectric constant and
loss tangent, conductor properties such as trace conductivity
and surface roughness and the frequency range over which the
transmission line structure will operate

Graphing against frequency is provided for impedance
magnitude, conductor loss and dielectric loss (with or without
roughness compensation,) inductance, capacitance,
resistance, conductance and skin depth. Graphing for
differential structures include differential, odd and even
modes.

Each structure in the stack includes a set of frequency
dependent properties.

Click the Frequency Dependent Properties icon to load the
Frequency Dependent Properties dialog.
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Frequency Dependent Properties - o X
. Result Presentation
Edge Coupled Coated Microstrip 1B Length of Line L i Langih ok L8 © Jin Citm Close
T Conductivity (S/ TC
tovs oy Gy 2800507 Substrate Causal Extrapolation Reference Points e i
Frequency Minimum (MHz)  FMin  [500.0000 [¥ Set Dielectric Constant (Er) from Stack Up materials ﬂ
Frequency Maximum (GHz)  FMax [10.0000 Set. IV Set Loss Tangent (TanD) from Stack Up materials
ety o P 0 o Freq (Hz) Ref Er Ref TanD
4.2000 0.0195
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Print Settings
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Graph | 0dd Mode | Even Mode | Surface roughness compensation models
5 s Graph Settings
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S —
& 2 < —
=3 Maximise Print Export
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Frequency - MHz

The Frequency Dependent Properties dialog includes:
the structure image of the selected structure

frequency dependent parameters for the user defined
frequency range and frequency of interest

a table of substrate causal extrapolation reference points
for each substrate dielectric/region

surface roughness compensation model selection
between Hammerstad, Groisse and Cannonball-Huray
methods

the loss v frequency graph showing the data series for
conductor and dielectric losses and total attenuation

interactive graph setting with data point selection allowing
drilling down to the underlying loss data

data tables for the selected frequency range
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Graph Odd Mode | Even Mode ]

s impedance | mpedance | Impedance | 4 T e R Skin Conductor | Dickectrie | pyer | Conductor | fgenuaton | =4
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3.000E+09 5.069E+01 1.765E-01 5.055E-01 3.036E-08 6.112E+00 1.186E-11 3.950E-03 4.750E-05 -5.247E-01 -8.677E01 -1392E+00 |-1.036E+00 |-1.504E-00 (€
3.500E+09 5.061E-01 1574601 5.061E-D1 3.034E-08 6.558E-00 1.184E-11 4.608E-03 4.358E-05 -5.662E-01 -1013E+00  |-1579E+00  |-1120E-00  |-2133E-00 €
4.000E=09 5.063E+01 21438 5.063E-01 3.032E-08 7051E+00 1.183E-11 5.267E-03 4114E05 -6.048E-01 -1158E+00  |-1763E+00  |-1.798E-00  |-2356E+00 |€ |
4.500E+09 5.065E+01 225501 5.065E+01 3.031E-08 7.572E+00 1.181E-1 5.925E-03 3.879E-05 6492601 -1303E+00  |-1953E+00  |-1287E=00  |-2591E=00 €
5.000E+09 5.067E+01 2.374E01 5.067E+01 3.029E-08 7.985E+00 1.180E-11 6.584E-03 3.679E-05 -6.843E-01 -1.449E+00 |-2133E+00 |-1.358E+00 |-2807E=00 €
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Frequency dependent parameters

Speedstack Si runs a detailed analysis of the transmission line
structure for controlled impedance and insertion loss. Each
structure in Speedstack can store a complete set of
frequency dependent parameters: Length of Lines,
Frequency Minimum, Frequency Maximum, Frequency
Steps, substrate data, surface roughness and loss budget.
Supply the values in the dialog below.

Length of Line HE A000.0000
Trace Conductivity (S/m) TC 5.300E+07
Freguency Minimum (MHz)  FMin

500.0000

FMax  [10.0000

FsStep |20
Freq  [5000.0000

Calculate

Specify the line length and trace conductivity along with the
frequency range and frequency of interest.

Freguency Maximum (GHz)

Freguency Steps
Frequency of Interest (MHz)

To specify the frequency range click the Set... button and
enter the minimum frequency (in MHz) and maximum
frequency (in GHz); specify the frequency increment (in MHz)
then click Apply.

FMin  |500 0000 Apply |

FMax  [10.0000 Cancel
100.0000

Frequency Entry

Frequency Mimmum (MHz)

Freguency Maximum (GHz)

Freguency Increment (MHz)  Flnc

With all parameters entered, click Calculate. Results are
displayed in graphical and tabular form.

To provide for applications where the insertion loss
requirements or loss budget specifications are needed for a
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given frequency the results for the specified frequency of
interest are highlighted in green in the table of data.

Presentation of results
Use the Result Presentation dialog to choose units in which
to present plots and tables of results.

Result Presentatio

" Jin

The graphs are able to display results in dB/line length,
dB/inch or dB/metre.

Click the unit of choice and click Calculate to refresh the
graphical display of data.

Graph settings

Use the Graph Settings dialog to choose the display series.

Speedstack Si graphs All Losses — conductor loss, dielectric
loss and total attenuation.

Display Series
<

Impedance Magnitude

Inductance

Resistance

Capacitance

Conductance

Skin Depth

Alpha hd

If roughness compensation is applied the data series
conductor loss with roughness and attenuation with
roughness are added to the graph.

Edge Coupled Coated Microstrip 1B

Odd Mode

=

N Conductor Loss BB Dielectric Loss MBS Attenuation [——3 Conductor Loss with Roughness
== Attenuation with Roughness

ra

h-&
- - e —

do

i

——— .
- M""‘"‘-\_‘

All Losses with Roughness - dB/line
T

in

1000

2000

3000 4000 5000

Frequency - MHz

6000 7000 8000 3000 10000

All losses with roughness
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Speedstack charts are interactive. Click on a point on the
data series of interest to display the data point value in the
Picked Data Point Information text box

Edge Coupled Coated Microstrip 1B
Differential
055 BN Attenuation 2 Conductor Loss with Roughness
-__T—-l-—...‘____ .
T . . X Ficked Data Point Information
HR—.__H:_-‘“-—— ’ d Frequency (MHz) : 9500.000
i -....______-__ Dielectric Loss (dB) : -2.760
‘-\-
-‘_\
IS I [N [ Y S N S [ I A S [ N A S S N S O A A Ay W |
4000 5000 6000 7000 8000 9000 10000
Frequency - MHz
The range of data series includes losses, impedance
magnitude, inductance, capacitance and skin depth: Choose
the data series from the Display Series drop down.
Edge Coupled Coated Microstrip 1B
Differential
61.8
51.5? \\
© 614 f
Loz f
§61 0 &
g F ~
ésu.a ; \:...,___._
60.6-
60.4 &
N Y I [ S A A A A A S I Iy |
1000 2000 3000 4000 5000 6000 7000 8000 9000 10000

Frequency - MHz

Graph of inductance v frequency

Displaying the loss budget

A value for loss budget can be added to a graph. A loss
budget line will allow losses that exceed the budget to be
easily identified.
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Graph Settings

Edge Coupled Coated Microstrip 1B Display Series

Differential [ail Losses -

mm Conductor Loss B Dielectric Loss WSS Attenuation C——— Conductor Loss with Roughness
== Attenuation with Roughness E==A Loss Budget

Differential
|Diﬁerentia| j

w__?h_-n-__._

Less Budget (dB)

20,0000

I e et

................. Picked Data Point Information

All Losses with Roughness - dB/m
T

l__.

Maximize | Print Export

1000 2000 3000

4000 5000 6000 7000 8000 9000 10000
Frequency - MHz

The plot above indicates that the loss budget is exceeded by
the total attenuation (cyan) beyond 8000Mhz (8GHz.)

Setting the Loss Budget stores the value with the structure
for future use. This would prove useful if the stack up is
changed and it is necessary to ensure that the structure still
meets the loss requirements after the changes.

Material and surface roughness properties

The Speedstack graph above charts all losses, the dielectric
loss and the significant increase in the overall loss due to
surface roughness, allowing the materials supplier to isolate
the contributions of the different loss mechanisms.

Dielectric loss
In order accurately to calculate dielectric loss it is necessary
to understand the material / substrate properties.

Speedstack Si allows substrate properties including dielectric
constant (Er) and loss tangent (TanD) to be specified for
each structure substrate region.

Substrate Causal Extrapolation Reference Points

v Set Dielectric Constant (Er) from Stack Up materials

[v Set Loss Tangent (TanD) from Stack Up materials
Freg (Hz) Ref Er Fef TanD

H1  [1000E+09  |4.2000 0.0195

N | |

T

| | |

| I |

REr | | |

CEr  [1000E-09  |4.000C |0.0195

Speedstack Si causally extrapolates Er and TanD over the
specified frequency range using a single value of Er and

TanD to enable Svensson-Djordjevic frequency dependent
permittivity modelling for each dielectric layer in the current
controlled impedance structure. The table above therefore

106 e Speedstack PCB Stackup Design and Documentation




provides the ability to specify the extrapolation reference
points for each substrate region; the reference point data is
usually available from the material supplier data sheets. The
values of Er and TanD can, optionally, be derived from the
materials in the stack. (See the Polar Application Note
AP8184 or the Si9000e User Guide for a more detailed
discussion of causally extrapolating substrate data.)

The fields shown active in the table in the dialog reflect the
structure selected; inapplicable fields are shown greyed out.

The fields shown above allow values to be specified for the
frequency of interest, the dielectric constant, Er, and loss
tangent, TanD for the prepreg dielectric and the coating.
Enter the parameters and click Calculate to refresh results.

Conductor losses — surface roughness compensation

In order to provide good adhesion between copper and
dielectric materials in core layers PCB materials vendors
control the roughness of the associated copper layers
(typically by chemical treatment). Speedstack Si provides
industry standard methods of compensation for surface
roughness in frequency dependent calculations; the
compensation methods include:

Smooth copper, (no compensation for Cu loss at all)
Hammerstad modelling

Groisse modelling

Huray modelling

Speedstack charts dielectric losses along with conductor
losses and attenuation values that optionally include
compensation for surface roughness. Roughness is a
random quantity and is commonly specified in terms of the
rms (root mean square) height h of the surface unevenness
for the Hammerstad and Groisse compensation methods.
Huray modeling is based on a non-uniform distribution of
stacked copper nodules shapes resembling “snowballs”.

Surface roughness compensation methods
Accurate calculation of conductor loss requires the surface
roughness parameters for each method:

The Smooth copper option provides for no compensation for
copper loss.

Hammerstad modelling is a proven technique that has stood
the test of time but has practical limitations when used over
4GHz as the model tends to saturate.

Groisse modeling can, with care, be used to extend the
modelling up to 7 to 10 GHz before saturation in the model
blunts its accuracy.

Frequency dependent loss calculations (Speedstack Si only) e 107


http://www.polarinstruments.com/support/si/AP8184.html

Hammerstad/Groisse methods
To specify the roughness parameters for the Hammerstad or
Groisse methods, click the option button for the method:

Surface Roughness Compensation

" Smooth

¥ Hammerstad -
" Groisse ]7 el
™ Huray — Edit..

Click the Hammerstad/Groisse Edit button.

Surface Roughness Compensation - Hammerstad / Groisse n

Surface 1 Roughness (RMS)  R1 0.2000) Apply |

Surface 2 Roughness (RMS)  R2 |D_ZDD|]
Cancel |

Surface Roughness Compensation

Enter the values for roughness in the R1 and R2 fields and
click Apply. Click Calculate to refresh results.

Huray method
Huray modelling extends the roughness modeling validity up
to 40 to 50GHz (and possibly beyond).

Click the Huray option button:

Surface Roughness Compensation

" Smooth

" Hammerstad )
" Groisse ]7 Edit..
% Huray _ Edit. .

Click the Huray Edit button and specify the parameters for
the Huray spheres (snowballs.)
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Surface Roughness Compensation - Huray El

Ratio of Areas 1.0000 Apply |
Effective Ball Radius (um) |0,7500

Cancel |
Area of Ball Count (sg pm) |90,0000
Number of Balls in Area |32

Enable Cannonball-Huray [~

—Matte-Side Roughness
Rz Matte (um) |4_4430 =]

Drum-Side Roughness
( Rz Drum (um) |3_0480 m

Courtesy of Bert Simonovich, Lamsim Enterprises Inc ~ Application Note

Supply the values in the associated fields and click Apply.

If the Huray values are not available, click Enable
Cannonball-Huray and supply the Rz values for matte and
drum side roughness and click Calculate to populate the
Huray fields, then click Apply.

Click the Application Note link to access the paper Practical
Modeling of High-speed Channels Based on Data Sheet
Input (Bert Simonovich, LamSim Enterprises Inc.) which
includes a description of roughness modelling using the
Cannonball-Huray Model.
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Edge Coupled Coated Microstrip 1B
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s Conductor Loss Emmmmm Dielectric Loss EEEEEE Attenuation T——= Conductor Loss with Roughness
== Attenuation with Roughness

Frequency - MHz

g T e i
T -0 D e e ——
£-20 e ---_-__—-"-"‘-n____‘ -
N ) R
& 30 MH“—*MM
: w07 [ —
3 -50
= L
-60 + + + + + + + + + + + + + } } } } } } }
1000 2000 3000 4000 5000 6000 7000 8000 9000 10000
Frequency - MHz
Speedstack charts a range of data series, including losses,
impedance magnitude, inductance, resistance, capacitance
and conductance; for differential structures select the
transmission line mode, differential, odd or even mode.
Differential
~]
Differential
Odd Mode
Even Mode
Click on the Display Series drop down to select the data to
be charted.
Display Series
[Skin Depth =]
Impedance Magnitude ~
Inductance
Resistance
Capacitance
Conductance
Skin Depth
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Beta b
The chart below displays skin depth v frequency
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Printing the technical report

The Speedstack Si technical report includes the stackup with
its stack data, the controlled impedance structures and
structure data, the drill data and loss data for each structure
in the stack.

Displayed loss data for each structure reflects the structure
type, the frequency dependent parameters, the substrate
causal extrapolation reference points, the surface roughness
method and settings, frequency of interest and associated
loss values for dielectric and conductor losses and total
attenuation and losses with roughness.

Edge Coupled Coated Microstrip 18

NI

Length of Line: 25 4

Frequency M
Frequency Steps: 20

Causal Points Surface Roughness Compensation: Huray
Freq (Hz) RefEr | RefTanD Ratio of Areas: 1 Frequency of Interest: 1000 MHz
Trace Conductivity: 5.8E+07 S/im H1 1.000E+08 | 4.2000 0.0195 Effective Ball Radius: 0.75 um Canductor Loss: -3.003E+00 dB/m
Frequency Minimum: 500 MHz H Number of Balls in Area: 32sq pm Dielectric Loss: -2.840E+00 dBfm
10 GHz :l Area of Ball Count: 90 Attenuation: -5.843E+00 dBim
REr Conductor Loss with Roughness: -4.479E+00 dB/m
CEr T.000E+08 | 4.2000 0.0195 Attenuation with Roughness: -7 319E+00 dB/m

Click File|Print|Print Technical Report, Speedstack refreshes
the loss data results and displays them in high quality
graphical form.

Step through the pages to view the stack, impedance and
drill data and the frequency dependent loss graphs for each

CASpeedstack\Eval Imperial v13.stk

Units: Microns

structure in sequence in the stack.
aPelar

Edge Coupled Coated Microstiip 15
AN AN

Length of Line: 101600

Frequency Steps: 20

Trace Conductivity: 5.8E+07 Sim
Frequency Minimum. 500 MHz
Frequency Maximum: 10 GHz

Substrate Causal Extrapolation Reference Points Surface Roughness : Hammerstad
Freq (Hz) Ref Er Ref TanD Surface 1 Roughness (RMS) R1: 5.08 Frequency of Interest: 1000 MHz
H1 1000E+0S |4 2000 00155 Surface 2 Roughness (RMS) R2: 5.08 Conductor Loss: -3.003E+00 dBim
:§ Dielaciric Loss: -2 840E+00 dBim
H Atenuation: -5.843E+00 dB/m
RET Conductor Loss with Roughnass: -3.776E+00 dB/m
CEr 1.000E+08 [42000 0.0185 Anenuation with Roughness: -8 615E+00 dB/m

All Losses with Roughness - dB/line

R
o

[

mm—— Conductor Loss s Dielectric Loss s Aftenuation &==== Conductor Loss with Roughness === Attenuation with Roughness

40
45
50
TN T T N T T - L YIRS SN TR T S N S VN Y Y NN T IS TN N N N T N T TN T AN O N T B
1000 2000 300 4000 5000 6000 7000 8000 9000 10000
Frequency - MHz
Revison Wedincaton Date of Revision: Editor
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Speedstack Si to Si9000e data transfer

To Field Solver

From Field Solver

iy

Paste Structure from
Speedstack

Il

Copy Structure to
Speedstack

h

To Si Project

K
I

Paste from
Speedstack into Si Project

Speedstack and Si9000e incorporate the facility to realise
bidirectional transfer of all structure parameters (i.e. both
lossless and frequency dependent) for a single structure or
all structures via the clipboard.

Parameter transfer is accomplished via the data transfer
icons:

Single structures

Use Speedstack’s To Field Solver icon to transfer the
parameters of a single structure via the clipboard from
Speedstack to the Si9000e

Use Speedstack’s From Field Solver icon to transfer the
parameters of a single structure via the clipboard from
Si9000e to Speedstack

Use the Si9000e’s Paste Structure from Speedstack to
paste the whole structure with all its parameters into the
Si9000e — the currently displayed structure will be replaced

With all calculations complete click the Copy Structure to
Speedstack to return the structure to the stackup in
Speedstack.

Multiple structures

Use Speedstack’s To Si Project icon to transfer all
structures as a project from Speedstack to the Si9000e

Use the Si9000e’s Paste from Speedstack into Si Project to
paste the set of structures into the Si9000e as a project.

Sharing structure properties

Each structure in Speedstack can store a complete set of
frequency dependent parameters, so each structure can

have its own Length of Line, range of frequencies (FMin,

FMax, FSteps and Frequency of interest) substrate data,
surface roughness compensation and loss budget.

Using the data transfer icons within Speedstack allows a
selected set of structure properties to be shared between
other structures on the same electrical layer on the stackup.

To share parameters between structures, select the source
structure (structure 1, Edge Coupled Coated Microstrip 1B.)
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5E Polar Speedstack PCB Stack Up Builder:  Stack: Eval Imperial v13.stk  Project: Eval Imperial v13.sci - O X

File Edit View Tools Units External Utility Help

Esd

@0

SUXO == %

7777 2T gl 20 UB

Stack Up Edtor | DRC 0 Controled Impedance | CI Resuts |

X EOEE =@
| e ||

4200

Substrate 1 Height H1[6129
GHz Select the Frequency Dependent Properties button to
A Frequency Dependent  display the frequency dependent properties.

Properties

Frequency Dependent Properties - u] X
. . ) Result
Edge Coupled Coated Microstrip 1B Length of Line: L 000000} IV(: Length of Lins @ i ® i | Close
Trace Conductivity (Sim)  TC  [FB00E07
N2 X e : 5800807 [~ Substrate Causal Extrapolation Reference Points
i Frequency Minimum (MHz) ~ FMin  [so00000 Clear Results
[¥ Set Ervalues from Stack Up materials
Frequency Maximum (GHz) FMsx [f00000 et Frea (H2) e Ferr
Frequency Steps FStep [20 H1 1.000E+09 [4 2000 0.0195
Frequency of Interest (MHz) Freq  [10000000 K2 I [
Calculate B [ I
w [ [
REC | T I
CEr [1.000E+03 [4.0000 0.0195
~Surface Roughness C
' Smocth
& Hammerstad -
 Grisee ==
© Huray —  Ei. |

Print Settings
[¥ Include Loss Graph for this structure on the report |

All the structure’s properties, including all the frequency
dependent parameters, will be available for sharing with the
target structure.

Close the dialog and click the To Field Solver button to copy
the parameters to the clipboard.

To Field Solver

Select the target structure (in this example, structure 2,
single ended Coated Microstrip 1B as shown below) and
click the From Field Solver button.

From Field Solver

Frequency dependent loss calculations (Speedstack Si only) e 113




Coated Microetrip 18

R
L

-

Substrate 1 Height H1 [161.29
Substrate 1 Dielectric E1|4.2000
Lower Trace \Width W1 |114.30
lUpper Trace \width w2 13830
Trace Thickness T1 [17.78
Coating Above Substrate C1|25.40
Coating Above Trace C2 |25.40
Coating Dielectric CEFIW
Impedance Zo W
Target Impedance W
Target Tolerance % W

Speedstack displays the Paste Structure Properties dialog

Paste Structure Properties

Please select the Property Groups that yvou wish to paste to the selected structure: Apply
[ Impedance Parameters (H1, Er1, W1, W2, 51 etc)
[ Freguency Dependent Parameters (LL, TC, FMin, FMax etc)

|+ Substrate Causal Extrapolations Reference Points (Ref Freg, Ref Er, Ref TanD)

Cancel

it

[v Surface Roughness Compensation (Hammerstad, Groisse, Huray)

Select the properties to be pasted — in this case, the
impedance parameters are unchecked as the source
structure’s 100 ohm differential impedance does not apply.

The frequency dependent parameters, along with the causal
extrapolation reference points (frequency, Er and TanD) and
surface roughness compensation method are applied to the
target structure.
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Transferring structures between Speedstack and Si9000e

Speedstack Si is fully integrated with the Si9000e
transmission line field solver.

Users can transfer structures to the field solver for
processing then transfer the solved properties back to
Speedstack Si.

Transferring a single structure

Ensure the field solver is running. Select the structure to be
copied to the Si9000e

Stack Up Edtor | DRC: 0 Controled Impedance: | C1 Resuts |

XIS E D& w5

a | <f3ora =]
Couy B1A

FR4 Care

PrePreg 1651

PrePreg 3080

Click the To Field Solver button to transfer the structure
and all parameters to the Si9000e.

# |76 Field Solver

Switch to the Si9000e.

Click the Si9000e’s Paste Structure from Speedstack
ﬁ% button to paste the structure complete with all impedance

Paste Structure from ; ;
Speedstack and frequency dependent parameters into the Si9000e.

The Si9000e displays the Paste Structure Properties dialog.

[E Paste Structure Properties >

Flease zelect the Property Groups that you wizh to paste to the selected stucture: _ ;
v Impedance Parameters [H1, Er, w1, W2, 51 ete] Cancel
Iv Freguency Dependent Parameters [LL, TC, Fiin, Fhax etc]

[v Substrate Cauzal Estrapolations Reference Points (Ref Freq, Ref Er, Ref TanD)

[v Surface Roughness Compenzation [Hammerstad, Groizse, Huray]

Choose which groups of properties are to be pasted into the
field solver and click Apply. The impedance, lossless and
frequency dependent properties are pasted into the field
solver for processing. The units setting in Speedstack will
replace the setting in Si9000e.
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Solving for impedance

With the structure loaded into the Si9000e switch to the
Lossless Calculation tab to display the structure graphic and
lossless parameters.

Tolerance  Minimurn M aximum

H Substrate 1 Height H1 [gszgro0 -+ [ 00000 [6925700 [6329100 Caloulats |
Edge-Coupled Offset Stripline 1B1A Substrate 1 Dielectric En [ az000-4 —' +[7 00000 [ 42000 [ 42000 Caloulate |
Substrate 2 Height H2  [3se1100—=*[ 0.0000 [3881100 [3881100 Caloulate |
Substrate 2 Dielestric B2 | 42000 j +[ 00000 [ 42000 [ 42000 Caloulats |
Lowier Trace Width Wl [131.8893 - £ [ 0.0000 [191.9693 [191.9653
Upper Trace Width w2 [1ee5e93 - [ 0.0000 [16E5633
Trace Separtion 51 [z5.5000 -+ 00000 [215.9000 [2159000 Caloulate |
Trace Thickness T [smse00 -+ [ 00000 [ 355600 [ 355600 Caloulats |

Differential Impedance  Zdiff I 100.00

Specify the target impedance then click the Calculate button
for the parameter to be used in the goal seek (e.g. trace
width); with the target impedance reached switch to the
Frequency Dependent Calculation tab.

Running frequency dependent calculations

Enter the frequency dependent parameters, the extended
substrate data settings, the surface roughness compensation
method and values and click Calculate to refresh the results.

Paramster Entry Uriits
=] =] 7_. "
= =] 8 DIQ 2= 2| podlped| || st | | 25| EIEE BEIE| B EI AlEaES _=|

. Frequency Data
i EA | g of Line (T =TT (r et © e ‘ Mo Data Inported Options.
Suface Micrastip Edge-Coupled Offset Stripline 1B1A on i T BB0E+07 — 5;,' Result P . - : ] P pn——
18 oss Tangent D [ O015 — GoelSeek| | O Lenghoilie /i @ /m
Rise Time (ps) T l—w Extended Substrate Data——— - 5-Parameter Configuration
E Frequency Mirimum (MHz) — FMin [~ 500000 ; EZZE:TEEJ;;;DE bten T Freuuenzcnyuﬁte_usj—
Suiface Microstip e VEmnERE) (e 0000 = Set.. || Mol Er/ Terd) _Ed | _il Souce and Laad Impedsncs (0hms)
b Fisquency Steps Foteps Surfore . ; Souce  Load
E I Auto Cale Colults  Smouth 5000 [ 50.00
 Hammerstad 5 Nurbering Mods
¢ Groisse [EE | & Modem (" Classic
Coated Micrastip & Huray Edit _il _il
1B
Graph | 0dd Mode | Evenbods | SPICE RLGC| 4 Pon S-Patameters - Graph | 4 PortS-Paramsters -Dsts | Mived Madls S-Parameters - Graph | Mt Mods S-Paramsters -Dsta | Crasstalk| Measursmert Dats |
T ~ Graph i
E Edge-Coupled Offset Stripline 1B1A Doy S
Coated Mimastip Differential £ Losses -
iz} mmmm Conductor Loss B Dielectric Loss —EEESSSE Attenuation C——— Conductor Loss with Roughness [E===5 Attenuation with Roughness
Difererial
] | Differenial =l
< — e S— Loss Budget (d8)
Dual Coated g i ""\_:"\ ) . [ 00000 _Fetiesh | |
Mictostip 18 I - —— - .
E 3 -2 \‘ P — * g  Picked Data Point Information |
= [ ——
g, \"'--..._ T
'aual Cioalgg = ‘"""---.._________
icrostip = -\-____
z -4 ""'-—“-—-..-.___\- Maximise Fiint Export
Emberded ES
Mictastip 1B14 .
| S [ | ] N | | | N T | ] N | ] T | N N | | -1 | B -
E 1000 2000 3000 4000 5000 6000 7000 8000 9000 10000
Frequency - MHz
Embedded
Mictastip 1824
v Lossless Calculation I, Frequency Dependent Calculation | Sensitivity Analysis | Via Checks
For detailed Si9000e operation see the Si9000e User Guide.
With all calculations complete click the Copy Structure to
E= H
= Speedstack to return the structure to the stackup in
Copy Structure to
Py Speedstack.
Speedstack

The Paste Structure Properties dialog is displayed.
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Paste Structure Properties

¥ Impedance Parameters (H1, Erl, w1, W2, 51 etc)
¥ Freguency Dependent Parameters (LL, TC, FMin, FMax etc)

Cancel

Flease select the Property Groups that you wish to paste to the selected structure: Apply |

¥ Substrate Causal Extrapelations Reference Points (Ref Freg, Ref Er, Ref TanD)

¥ Surface Roughness Compensation (Hammerstad, Groisse, Huray)

Choose which properties are to be updated and click Apply.

Rebuild and calculate the structure in Speedstack. The
structure reflects the updated values.

Eile Edit View Jools Units

ﬁ.ﬂ-ﬁa
LY

External Utility  Help

Sl XO =& =ER 5 777727

Stack Up Edllurl DRC:0 Controlled Impedance |CI Hasuns|

XS EODL=w@nX
an|ie] <[3ota 55|

B

Substrate 1 Height
Substrate 1 Dielectric
Substrate 2 Height
Substrate 2 Dielectric
Lower Trace Width
Upper Trace Wwidth
Trace Separation

Trace Thickness

Differential Impedance
Target Impedance
Target Tolerance %

H1 |692.9
Er1]4.2000
H2 (388

Er2|4.

Wi
w2
S1
T

191.97

166.57

215.50

3556

100.00

100.00

10.00

[Master [Microns [Target Stack Up Thickness = 152400  [Stack Up Thickness = 1510.28 [Stack Up Thickness with Soldermask = 1561.08  [Beta V : 17.08.15343 A

Transferring multiple structures via Si Projects
To transfer all the structures in a stack use the Si Projects
transfer function incorporated in Speedstack Si and Si9000e.

Si Projects allows for transfer of all controlled impedance
structures along with all lossless and frequency dependent
parameters from Speedstack Si into the Si9000e field solver.

Si Projects allows groups of structures to be saved and
recalled in Si9000e and the updated structures pasted back
into Speedstack.
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The stackup in the example below contains four structures.

HE Polar Speedstack PCE Stack Up Builder  Stack : Eval Imperial v3.stk  Project : Eval Imperial v13.sci

File Edit View Tools Units Exernal Utility Help

EsdTO=0

XO === AL

7777 LT g oD E
Stack Up Editor | DRC: 0 Controlled Impec;
X [E:

Al < <l1ol4

Substrate 1 Height
Substrate 1 Dielectric
Lower Trace Width
Upper Trace Width
Trace Separation

Trace Thickness
Coating Above Substrate
Coating Above Trace
Coating Between Traces
Coating Dielectric

Differential Impedance
Target Impedance
Target Tolerance %

[Microns [Target Stack Up Thickness = 152400 [Stack Up Thickness = 151023

|Stack Up Thickness with Soldermask = 1561.08  [Beta V : 17.08.1

5
’ETO

Si Project

L

4
Paste from
Speedstack
into Si
Project

Use the To Si
Project toolbar
icon to copy the
group of four
structures from
Speedstack Si
and place them
onto the
clipboard; these
structures can
then be pasted
directly into the
Si9000e as a
new project.

Switch to the
Si9000e and use
the Si9000e’s
Paste from
Speedstack into
Si Project to
paste the set of
four structures
into the Si9000e
as a project.
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E Polar 519000 PCE Transmission Line Field Selver - [C:\Users\Ralph\Desktop\5i%000 v18.x Beta 170ct2017\Untitled.5i9] [C:\Users\Ralph'DesktophSi%000 v18.x Beta 170ct2017\Untitled.51P]
File Edit Configuration Help

] § =] o D 2 ) %3 I A ] P

i Frequency Distribution
E Length of Line L ,m " Logarithmic e Linear
L1100 ohm (1] L1 100 ohms |1 ) Trace Conductivity [S/m) TC 580E+07 —  Set. | Result P P
1 Lass Tangent Tanl [ 01595 — GoalSeek. {* Length of Line © tin Cm
T l ;“,—.!l:_____l Rise Time [ps) T ,—m Extended Substrate Data
E — 1 FreauencyMiimun il - Fin | 500000 © CanelyErapaae 1 /T _E:

Freguency Maximum [GHz) Fhdax 10.000 } Set... " Multiple Er / TanD Edit. i
Frequency Steps [Feficpe 20 Surface Roughness Compensation
[~ AutoCale i EfeH " Smooth

+ Hammerstad

" Giroisse }M

" Huray Edi... ﬂ

Graph ] Odd Mode | EvenMods| SPICE RLGE| 4 Pont 5-Parameters - Graph | 4 Port S-Parameters - Data | Mised Mode 5-Parameters - Graph | Mived Mode §-Parameters - Data | Crosstalk | Messureme

L1 76 ohms (2]

I

L4100 ohrs (3)

E L1 100 ohms (1)

L& 75 ahms (4] Differential

The Si9000e and Speedstack should automatically switch to
the units that were in use when the structure was copied.
(For instance, if Speedstack is in Mils and Si9000e is in
Microns and a structure is copied from Speedstack to
Si9000e the Si9000e should automatically switch to Mils.)

The complete set of structures appears in the field solver’'s
Project window in the same order as shown in Speedstack.

The Si Project window lists the transferred structures in
Speedstack’s display order, showing the order number and
impedance value along with a thumb nail graphic indicating
the structure configuration.

Modifying structures
Selecting each structure displays its associated graphic in a
grey background.

With a structure selected the structure parameters can be
modified as required and all values recalculated. The
recalculated structures can be pasted back into Speedstack.

To paste a structure back into Speedstack select the target
structure in Speedstack, switch to the Si9000e, select the
structure for transfer and use the transfer icons to update the
selected structure in Speedstack.

&j Click the Rebuild and Recalculate Displayed Structure to

Rebuild and Recalculate ~ refresh the displayed structure.
Displayed Structure

Click the Rebuild and Recalculate All Structures to update all

Rebuild and Recalculate ~ Structures in the stack
All Structures

23
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Creating CITS test files

& Set CITS Test

Speedstack can create CITS test file data for each controlled
impedance structure in the stack.

Select each structure and click Set CITS Test to display the
Edit Test data dialog; specify the CITS test parameters for
each structure to be tested and click OK.

Edit Test data
— Structure Details —Channel Select
Structure Description IOﬁ'set Coplanar Strips 1B1A
| {* Single Ended Probe (D
Impedance 50.00 5 -
" Differentiz S
S endleryes | 4
—Herizontal —Vertical
i Inches -
Units | E Ohms/Division 10 -
Test From |3
— Tolerance
Test To I?
¥ Locked
Test Method [Absolute |
- Plus IW 2
p
i |1 0 3
* Default R -
= User

Exporting the CITS test file

With the test data specified for each structure, from the File
menu choose Export To|Export CITS File. Add descriptive
Board Details and notes as required.

Customer IF‘uIar

Board Type IGEDE back plans
Part Mumber I-IEB'll

Revision Mumber IHE"" &

Click Make File and navigate to a suitable folder and save the
CITS (.cif) test file.
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Working with flex-rigid stackups

Speedstack Flex

Speedstack Flex allows PCB fabricators and OEM engineers
quickly to create and document accurate and efficient flex-
rigid PCB layer stackups.

The graphical stackup display

The Speedstack Flex Navigator enables the board designer
to link and document as many cross sections as necessary
in order to fully document a flex-rigid build up.

Speedstack Flex supports documentation of common flex-
rigid constructions, including doublets where stacked pairs of
flex link two rigid sections of the flex-rigid construction
together (see graphic below.)

Speedstack’s Navigator works from a master stack
comprising the full set of materials used in the final stackup
and documents each rigid and flex-rigid section with as many
"sub-stacks" as needed for the design. There are no limits to
the number of sub-stacks or layer count of the total build.

A range of materials including flexible adhesives, bondply
and FlexiCore can be enabled or disabled for each layer, and
impedance structures can be added to each sub-stack.
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PP

PP

Core

PP

PP

Core

PP

PP

Mesh / Crosshatch ground planes

When used with Polar’'s Si8000m and Si9000e field solvers,
Speedstack Flex permits modelling and documenting
mesh/crosshatch ground planes from within the Speedstack
Flex environment. Mesh geometry and structure data can be
easily shared between Si8000m and Si9000e.

Internal Coverlays

Advanced rules allow impedance structures to be added
when coverlays exist internally within a stack. When a
coverlay is beyond the outer copper it will behave like a
coating, when internal it will behave like a bondply or prepreg.

Definable colours per material

Speedstack Flex can set and store individual material
colours via the material Properties dialog. This will help
ensure that special build requirements are obvious during
fabrication. This will be found useful for documenting plated
layers or highlighting specific material usage such as no-flow
prepregs and flexible cores.

Enabling Speedstack Flex/HDI
To enable Speedstack Flex/HDI select Tools|Options and

ensure the Licensing pane purchasable option Speedstack
Flex/HDI License check box is ticked.

Adding a flexible core
Create and save a symmetrical 6-layer stackup as shown in
the sample stack below

Liquid Photolmageable Mask 1.000 1.000

Copper Foil
PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080

FR4 Core

PrePreg 1080
PrePreg 1080

Copper Foil

0.700
3.000 3.000
3.000 3.000
0.700
8.000 3.000
0.700

EXVI 3.000

8.000 3.000

0.700

3.000 3.000

3.000 3.000

0.700

Liguid Photolmageable Mask 1.000 1.000
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Core

PP

PP

Core

PP

PP

Ensure Symmetrical mode is off, right click the prepreg
above Layer 4 copper and add a flexible core:

FR4 Core

PrePreg 1080

Add

FR4 Core - Add C.I. Structure Core
Full Stack Up Editer Mode | RCC
PrePreg 1080 3000 Flexible Core
Set to Signal [
~Preq 1080 ET Bondply
PrePreg 1080 3000 Set to Plane .

PrePreg 1020 3.000

Flex Core 3.000 3.000

PrePreg 1080 3.000 3.000

Using the Navigator

Press F4 to display the Navigator

. Docking

Colours

Refresh

Right click the Navigator and choose Docking|Float to allow
the Navigator window to be resized. The Navigator will move
with Speedstack’s Stack Editor. Choose Free to allow the
Navigator to move independently of the Stack Editor.
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Adding stacks

Select the stack in the Navigator window and click Add Stack
and choose Defined by Layers

Select Stack |
Add Stack J Duplicate Master
Remowve Stack Defined by layers

From the drop-down list choose Layer 4 as the Top Layer
and Layer 5 as the Bottom Layer as shown below and enter
Flex as the Substack Root Name.

Top Layer |4 LI
Bottom Layer |5 LI
Position Stack
Far Left Left Right Far Right
i [ I [
Substack Root Name IFIex
Apply | Cancel

The new stack is added to the Navigator. Each sub-stack
can be renamed individually as required.

Click the new stack — the selected stack is reflected in the
Stack Editor and listed in the status bar. Select Symmetrical
mode, in the Stack Editor click the new core and add a
coverlay above.
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Flex Core

Coverlay

3.000
2.000 2.000
The coverlays are added symmetrically about the core.
Changes made in the Stack Editor are reflected in the

Navigator. Click into the Navigator — use the mouse wheel to
resize. The Navigator can display in 2D or 3D views.

The new stack with its added materials appears in the
Navigator; clicking each stack in the Navigator displays it in
the Stack Editor and allows editing as described earlier to
add controlled impedance structures, change layer types,
add non-copper layers, etc.

Adding a new stack

Right click the Navigator and choose Add Stack|Duplicate
Master, rename the new stack and click OK.
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The new stack is added to the Navigator. Click on each stack
to display it in the Stack Editor and then edit as required.

Defining new stacks
New stacks may be added defined by layers of the master
stack. Choose Add Stack|Defined by Layers:

| Add Stack » Duplicate Master
Remowve Stack | Defined by layers |
Top Layer |3 LI
Bottom Layer Select Layer -
4
Position Stack —|5
6
Far Left 7 Far Right
g |
i 9 i
10
Substack Root Name |Master
Apply | Cancel

Choose the starting and finishing layers and specify a
position for the new stack, choose a descriptive sub-stack
root name and click Apply.

Copying and pasting stacks

To copy a stack in the Navigator select the stack, choose
Copy and Paste Stack, then from the dialog below choose
the position of the new stack
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Position new stack...

Far Left Left Right Far Right
i* i i i
Apply | Cancel

Removing stacks

To remove a stack right click the Navigator, choose Remove
Stack and select the stack to be removed.

= =

SubStack01
SubStack(?

Aligning materials in the navigator

On occasions, adding a flexible stack results in misalignment
between layer materials displayed in the navigator, for
example, between the bondply and coverlay layers and the
associated prepreg layers — see the graphic below.

To move the layers into alignment, select the stack in the
Stack Editor and use the FlexNav Move Up and FlexNav
Move Down commands from the Edit menu.

In the example above select the flexible stack in the Stack
Editor, select the upper Coverlay layer and shift the layer up
into alignment with the prepreg layer in the rigid stack (use
the Ctrl + Shift + Up arrow keys)
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Repeat the alignment for the bondply and lower coverlay
materials (using the Ctrl + Shift + Down arrow keys.) The
materials are displayed aligned in the navigator — below.

From the Edit menu Reset All NVDP (Navigator Visual
Display Position) Attributes to return the stack to its original
alignments.

The navigator display is reproduced in the Technical Report

B w
I oo

2] w
IPe7es m——

Master flex Sub_stack 3

The technical report also supports different materials on the
same dielectric layer, improving the clarity of documentation
between the stackup designer and fabricator.
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Displaying the stack in Proportional View

Speedstack can display the stackup so that the material
thicknesses are shown proportional to each other. Select the
stack in the Stackup Editor and from the View menu choose
Proportional Stack Viewer.

4.000 1.000

2.800
4.260 20.000

1.400
3.940 5.000

3.540 5.000

1.400
2.900 4.000
1.400

3.770 4.000
1.400

2.900 4.000
1.400

5.000
5.000
1.400
20.000
2.800
4.000 1.000

This visual aid will be found useful when considering the
dielectric thicknesses between electrical layers.
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Using the Ruler within Proportional view
Select the stack in the Stackup Editor

63.500

101.600

76200

101.600

7y S 7774

Switch to Proportional View and click the ruler on.

Distance: 76.29846 pm

Zoom in as required and use the ruler to measure material
dimensions, thicknesses, trace widths, etc.
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Working with HDI builds

Speedstack HDI

For HDI PCB fabricators, Speedstack HDI provides the
flexibility to quickly calculate the possible impact of
substituting alternative materials to improve manufacturability
and reduce cost while maintaining the specified parameters
and performance of the board.

Easy graphical stackup display

The HDI navigator provides a rapid guide through the
sequential sub-stack lamination sequence and presents the
complete assembly in a parsed graphical display that shows
each phase of the multi-step lamination sequence of an HDI
PCB. User-definable settings within the navigator allow
engineers to display layers in transparent, invisible or 3D
mode.

Sub-stack reordering

Speedstack Navigator makes re-ordering and renaming sub-
stacks quick and easy in HDI builds; sub-stacks can be
simply moved left or right within the Navigator window.

HDI builds
Use the Speedstack Navigator to document HDI press/drill

cycles. Speedstack can document press cycles based on foil
locations or drill start and end layers.

Sequential plan

The Sequential plan command creates sub-stacks that
represent each press cycle in a sequential lamination from
the Master stack based on foil locations.

Drill plan
Using Drill Plan, Speedstack determines the sub-stacks by
the start / end layers of the drills.

Creating the target stack with the Stack Editor

Consider the target stack below — it will require three press
cycles. Build and document the stack in the Stack Editor.

Switch to 2D View.
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Liquid Photolmageable Mask
Copper Faoil

PrePreg 1080
Copper Foil
PrePreg 1080

FR4 Core

PrePreg 1080
PrePreg 1080

PrePreg 1080
FR4 Core

PrePreg 1080
PreFPreg 1080

PrePreg 1080
FR4 Core

PrePreg 1080
Copper Foil
PrePreg 1080

Copper Foil
Liguid Photolmageable Mask

With the target stack completed use the Navigator's Add

Stack to document each press cycle, building up the stack in
the Navigator. Press F4 to start the Navigator and display the
master stack.
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Click Add Stack to copy the stack and name the new sub-
stack Press cycle 2.

Stack Name IF'I'ESS cycle 2

—Board Thickness

Target Stack Up Thickness I'EE.EEI'21
Peositive Tolerance % I'I{I'
Megative Tolerance % I'I{I'

—Copy into new stack. . . .

v Impedance Structures
v Motes

[T File Properties

Ok Cancel

The new sub-stack is copied into the navigator window

Click the sub-stack to display it in the Stack Editor. In the
Stack Editor add the drills and disable the materials that are
added in the final press cycle.
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Copper Foil
PrePreg 1080

FR4 Core

PrePreg 1080
PrePreg 1080

PrePreg 1080
FR4 Caore

PrePreg 1080
PrePreg 1080

PrePreg 1080
FR4 Caore

PrePreg 1080

Copper Foil

The Navigator displays the second press cycle alongside the
master stack.

The sub-stack can be displayed either to the right or left of
the master stack. Right click the sub-stack and from the
context menu choose Move Left.
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Sub-stack Press cycle 2 is shown to the left of the master.

Press cycle 2

To add the first press cycle right click the sub-stack and
choose Copy and Paste Stack and position the new sub-
stack to the far left.

Position new stack. ..
Far Left Le=ft Right Far Right
o i i i
fpply | Cancel |

Modify the new sub-stack in the Stack Editor as previously
described and display the completed stack in the Navigator.
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Each press cycle appears as a separate stack in the
Navigator.

In the fabrication process the manufacturer will process all
the core materials first, prior to bonding where each core is
interleaved with prepreg materials. It is sometimes useful,
therefore, to see all the core materials on a single sub-stack.

Right click the Navigator window and choose HDI
Build|Expose Cores to display the core layers.
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Using the Sequential Plan

Sequential Plan creates sub-stacks that represents each
press cycle in a sequential lamination from Master stack
based on foil locations. Consider the 14-layer stack below —
this stack will need several press cycles to manufacture.

Liquid Photelmageable Mask

Copper Fail

PrePreg 1080
Copper Foil
PrePreg 1080
Copper Fail

PrePreqg 1030

FR4 Core

PrePreg 1080

PrePreg 1080

FR4 Core

ePreg 10

PrePreqg 1080

FR4 Core

PrePreg 1080

Copper Foil

Ligquid Photolmageable Mask

Opening the Navigator will display the completed master
stack (shown below) in the Navigator window.
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Right click the Navigator window and choose HDI Build
|Sequential Plan and name the sub-stacks:

Substack Root Name |Press Cycle

Mo Blind Mechanical Vias v

fpply | Cancel

Click Apply — the Navigator displays the 4 press cycles

Choose HDI Build|Expose Cores — the cores are displayed in
the Navigator window alongside the press cycles.
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Using the Drill Plan

The HDI Build|Drill Plan creates sub-stacks that represents
each press cycle from the Master stack based on drill start-
end layers. Consider the stackup below — a 10 layer
sequential lamination construction.

Liquid Photolmageable Mask

Copper Foil
PrePreg 3
Copper Fo

PrePreg 1080

FR4 Core

PrePreg 1080
PrePreg

PrePreq 1080

FR4 Core

PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080
Copper Fo

PrePreg 3113

Copper Foil
Liquid Photolmageable Mask

Master
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The completed Master stack is displayed. Right click the
Navigator and choose HDI Build|Drill Plan.

| HDIBuild 3 Sequential Plan
. Drill Plan |

Expose Cores

Rename Stack...

Supply the Sub-stack root name — the name willl be used
when numbering the press-drill cycles.

Substack Root Name |Press-Drill Cycle |

Mo Blind Mechanical Vias v

spply | Cancel |

Click Apply — Speedstack documents the build-up stages of
the sequential lamination.

Press-Drill Cycle 02

Exposing cores
Right click the Navigator and choose HDI Build|Expose
Cores — the cores are shown alongside the press cycles.
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There are no limits to the number of press cycles that may
be documented.

Working with multiple press cycles
The stack below is a 24 layer stack with multiple press-drill
cycles. Open the Navigator, choose HDI Build|Drill Plan.
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Printing the Navigator screen

From the File menu choose Print Technical Report —
Speedstack prints the Navigator screen with its press cycles
along with individual stack data, impedance data and drill
data tables.
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Using Speedstack materials libraries

The materials libraries allow designers to manage their own
libraries of board materials. Libraries may be created and
materials added. Up to date libraries of materials may be
downloaded from the Polar Online Material Library.

Click the Materials Library button to display the Materials

_Ijﬁ Library window.

Materials Library

Working with the materials libraries

When Speedstack is started the materials library specified as
the default materials library file (via Tools|Options|File
Locations) is opened.

File Locations |

Select default matenals library file

C\Program Files (x88)\Polar\Spesdstack\Samples\Speedstack Imperial. mibi Browse...

Each library component type is accessible via its associated
tab. Click on the tab to view or edit the component type.

3E C:\Program Files (x36)\Polar Speedstack\Samples\Speedstack Metric 2.mlbx [m] X
ol B BEETE % w8

Fols | Prepregs | RCCs  Cores | Solder Masks | Ident Inks | Pelable Masks | Coverlays | Bond Ply | Adhesive | Flexibie Cores |

Suppler Suppler Desorption | Description Stack Number Dielectric Base Thickness | DiskecticF Thickne| D Loss Tangent UpperCu Base Thickness | Lower Cu Base Thickness | Resin Content

» PolarSamples C0¥001 FR4 Core 400001 50 50 42 00195 18 18 75
PolsrSamples Coigoz FR4 Core 400-002 80 80 4.2 0.0135 38 38 78
PolerSamples C0I003 FR4 Core 400-003 50 50 42 0.0135 70 70 75
PolarSamples CO/004 FR4 Core 400-004 75 75 42 00195 18 18 60
PolsrSamples CO/00s FR4 Core 400-008 75 75 4.2 0.0135 38 38 80
PolerSamples COI006 FR4 Core 400-005 75 75 42 0.0135 70 70 50
PolarSamples COi007 FR4 Core 400-007 100 100 42 00195 18 18 53
PolsrSamples Co/gos FR4 Core 400-008 100 100 4.2 0.0135 38 38 53
PolerSamples COI009 FR4 Core 400-009 100 100 42 0.0135 70 70 53
PolarSamples C0i010 FR4 Core 400010 125 125 42 00195 18 18 50
PolerSamples Coio11 FR4 Core 400011 125 125 42 0.01%5 35 35 50
PolerSamples coig12 FR4 Core 400012 125 125 42 0.0135 70 70 50
PolarSamples C0i013 FR4 Core 400013 150 150 42 00195 18 18 47
PolerSamples Coio14 FR4 Core 400014 150 150 42 0.01%5 35 35 47
PolerSamples COi015 FR4 Core 400-015 150 150 42 0.0135 70 70 47
PolarSamples C0i016 FR4 Core 400016 200 200 42 00195 18 18 45
PolerSamples Coi17 FR4 Core 400017 200 200 42 0.01%5 35 35 45
PolerSamples coio1g FR4 Core 400018 200 200 42 0.0135 70 70 45
PolarSamples C0i018 FR4 Core 400018 300 300 42 00195 18 18 45
PolerSamples C0i020 FR4 Core 400-020 300 300 42 0.01%5 35 35 46
PolerSamples C0i021 FR4 Core 400-021 300 300 42 0.0135 70 70 46
PolarSamples Coi022 FR4 Core 400022 540 540 42 00195 18 18 M
PolerSamples Coi023 FR4 Core 400023 540 540 42 0.01%5 35 35 41
PolerSamples COi024 FR4 Core 400024 540 540 42 0.0135 70 70 41
PolarSamples C0i025 FR4 Core 400025 1000 1000 42 00195 18 18 45
PolerSamples CO0i026 FR4 Core 400026 1000 1000 42 0.0195 35 35 45
PolerSamples COoi027 FR4 Core 400-027 1000 1000 42 0.0135 70 70 45
PolarSamples C0i026 FR4 Core 400028 1000 1000 42 00195 18 35 45
PolerSamples C0i026 FR4 Core 400028 1000 1000 42 0.0195 18 0 45

*

i 0|

Click on & material row to edit it
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Materials library toolbar

Use the toolbar to load and save libraries, import or export
libraries, arrange data columns and filter by data field or
access the online or on-premise libraries. The Toolbar and
button functions are shown below.

m
=
=
—

= ¥ 5 5 H &

Exit library

Clear materials library

Open materials library

Open and Append

Save materials library

Clear current data table

Kk
tt

Import CSV library

Export CSV library

Select & arrange column fields

Save column order

Load column order

Set filter

Clear filter

Library lock

Online / on-premise library
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Open Materials
Library

Open and Append
Library

= Clear Materials

Library

Save Materials
Library

Opening a library

To open, or load, a library click the Open Library icon and
browse to the library; click Open — the currently loaded
library will be replaced.

Opening and appending a library

To open a library and add the materials to an existing
library click the Open and Append Library icon, browse to
the library and click Open: the material will be added to the
existing library table.

Creating a new library

To create a new library, click Clear Materials Library; the
library is removed from the library manager. Import
materials as described below and save the library.

Click Save Materials Library and supply a name and
destination folder to create the new library. To have the
library load as Speedstack starts, specify it as the default
materials library file via Tools|Configuration Options|File
Locations

Importing material to the Speedstack materials library

Speedstack allows users to add existing material lists
(usually supplied from the material manufacturer data
sheets) to its library; material data must be arranged in the
format and order used by the Speedstack library.

Library materials can be imported from the Polar Online / On-
Premise Library or from local library files.

The Online Library comprises the most up to date copies of
the material files supplied from materials manufacturers who
are members of the Polar Speedstack Supplier Partner
program. Each new version of Speedstack adds new
materials to the Polar online library; utilisation of the online
library requires access to the internet.

The On-Premise copy of the online library is available for
Polarcare subscribers who may have restricted access to the
internet (for example, as a result of IT security policies.)

Importing from the Polar Online Library
Choose the material table tab (Foils, Prepregs, etc.) and click
the Online Library icon.
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HE C:\Program Files (x36)\Polar\Speedstack)Samples\ Speedstack Imperial. mlbx O =

ol b it e FTT %% w(@)

Prepregs ] RCCs ] Cores ] Solder Masks ] Ident Inks ] Peelable Masks ] Coverays ] Bond Ply ] Adhesive ] Flexible Cores ]
Supplier Supplier Description Description Stock Mumber Cu Base Thickness Type Cost
» PolarSamples FO/001 Copper Foil 100-001 07 Copper 1
PolarSamples FQi002 Copper Foil 100-002 1.4 Copper 2
PolarSamplas FOI002 Cappar Foil 100-003 28 Coppar 3
*
Speedstack connects to the Online Library and displays the
materials available for each file type from all the suppliers in
the Speedstack Supplier Partner program; click on a material
supplier's name in the Filter by Supplier pane to view just the
materials available from that supplier.
Online Library
Filter by Supplier File Type Library Files &vailable : All Existing Data Table
Panasonic_MEGTRON4_R_5620_1Ghz_1301 mlbx " * Clear Q

ML Al Suppliers

=Peler

A TEFHAL S FONE ELEC TROMOS

File Access Mode

& Online Polar Library { fip://polarinstruments com )

" On-Premise Mode

Foils
RCCs Panasonic_MEGTRONE(N)_R_5670(N)_1Ghz_1501.mlbx Close
eg Panasonic_MEGTRONGE_R_5670_1Ghz_15901 mlbx " Append

Panasonic_MEGTRONTN)_R_5680(N)_1Ghz_1501 mibx

SolderMasks Panasonic_ MEGTRONY_R_5680_1Ghz_1501 mlbx
Panasonic_MEGTRON_M_R_5630_1Ghz_1901.mlbx

Peelables Panasonic_STANDARD_R_1661(5Z)_1GHz_1501 mlbx

Coverlays Polar_Prepregs_1GHz_1901 mlbx
Shengyi_51000HB_1GHz_1901 mibx

Adhesives Shengyi_S51000_2MB_1GHz_1501.mlbx

FlexCores Shengyi_S51140FB_1GHz_1501 mlbx

Taconic_FR_25_10Ghz_1901 mlbx

Taconic_FR_25_27_1GHz_1501 mlbx

Taconic_FR_26_10GHz_1301.mlbx
Taconic_FR_27_10GHz_1501.mlbx
Taconic_FR_28_10Ghz_1901 mlbx

Technolam_NPG_1GHz_1501.mlbx v

C:“Users\Ralph*AppData“RoamingPolar Speedstack

Browse...

Plezse Note: This dats is accurate to the best of our knowledge, however it is provided, as is from our Matenial supplier partners. Flease feedback any errors or inaccuracies to Polarcare
and we will contact the material partner for clarification or rectification

On-Premise libraries

Where access to the online library is unavailable, a copy of
the online libraries is available on request to Polarcare
subscribers (contact polarcare@polarinstruments.com.) The
supplied libraries should be copied to a suitable local folder
with the file/folder structure preserved. Browse to the local
copy: the library files should appear as a local online library;
import library files as described above.

Downloadable mlbx files
Note that the Online Library only lists files with .mlbx
extensions and that follow the file naming conversion:

<Supplier>_<MaterialFamily>_<release>. mlbx
(No spaces are permitted in downloadable library file names.)

All .mlbx file names reflect the frequency at which dielectric
constant is specified and the Speedstack release version.

Although the .mlbx file format will support multiple material
types (Foils, Prepregs, Cores, etc.) in the same file the
downloadable .mlbx file only contains a single material type.
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Choosing material files

Browse through the list of available materials or scroll
through the list of suppliers and choose a supplier to filter the
materials by that supplier.

Choose the File Type and material. From the Existing Data
Table dialog select Clear to replace the contents of the
selected table type or Append to add the new materials to
the table.

-Existing Data Tabl [

¢ Clear

" Append iJ

Click Download; repeat for each material to be added to the
library then click Close.

Note: Many organisations connect to the Internet via proxy
servers to provide caching and controlled access. In some

cases, a proxy server may return library content in a format
that prevents successful download into Speedstack.

If your organisation connects to the internet via a proxy
server, you may need to request the MIS department to grant
address ftp://polarinstruments.com permission to bypass the
proxy server — if this is not possible the libraries can be
supplied for local download (on-premise) use.

Importing from local material files
Prior to importing the material data file ensure the file is not
open in another process (e.g. Microsoft Excel.)

Click the Speedstack Materials Library button to open the
Library, and then click Import CSV Library to open the Import
dialog.

> o

] Prepregs ] RCCs Cores I Solder Masks ] Ident Inks I Peelable Masks ] Coverlays I Bond Ply ] Adhesive ] Flexible Cores I

Suppler

PolarSamples
PolarSamples
PolarSamples
PolarSamples
PolarSamples
PolarSamples
PolarSamples
PolarSamples

Suppilier Description | Description | Dielectric Base Thickness | Dielectric Finished Thickness | Dielectric Constant | UpperCu Base Thick]

CO/001
CQ/002
CQ/003
CQ/004
CQ/005
CQ0/006
CQ/007

CQ0/008

FR4 Core 50 50 42 18
FR4 Core 50 50 42 35
FR4 Core 50 50 42 70
FR4 Core 75 75 42 18
FR4 Core 75 75 42 35
FR4 Core T 75 42 70
FR4 Core 100 100 42 18
FR4 Core 100 100 4.2 35
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When importing materials set the Import options in the Import
Library dialog: specify the units, delimiter and material type
and specify whether the material will be used to clear the
current data table or append to the existing library.

Import Library

|Inits for Import
{* Microns

" Mils/Thous
£ Millimetres

" Inches

Delimiter

File Type Exaisting Data Table Import

* Comma Fails * Clear

" Tab

RCC
PraPre C Append Cancel

" Other SolderMasks

|dents
Peelables
Coverdays
BondPly
Adhesive
FlexCaores

Replacing existing material tables

Choose the Clear Existing Data Table option and choose the
field delimiter type. The library import function can accept
files in a variety of formats, tab delimited, comma separated
and Excel worksheet and template formats but must be in
the format of the supplied sample files with columns in the
correct order.

Specify the units for import, file delimiter and choose the file
type (Foil, RCC, Prepreg, etc.) and click Import. Navigate to
the file via the Open dialog and click Open.

Repeat the procedure for every file type to be imported. Save
the file as a .mlbx library file.

Adding material data to an existing library

To add material data to an existing library table, open the
library, click Import CSV Library, click the Append to Existing
Data Table and click Import.

Navigate to the .csv or .txt file and click Open. Save the
modified library file as a .mlbx file.

Exit the library when all file types have been imported.

Adding new material to the data tables
Caution: ensure consistency of units

When defining dimensions, e.g. layer thicknesses, for a
stackup ensure that all measurements are defined using the
same units (mils, mm, etc.) throughout the structure and its
associated libraries.

Open the library to be modified. To add individual materials
to a library click the associated component type tab; click
onto a material, or empty line. An editing box will open which
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will contain the material clicked on, or the last material in that
type library.

Review/Edit Cores

Supplier

Supplier Description
Description

Stock Mumber

Type

Base Thickness
Finished Thickness
Dielectric Constant
Loss Tangent
Resin Content

Tg

Td

CAF Resistance

Z Mxis Expansion

Tolerance +-%
Upper Cu Thickness
Lower Cu Thickness

Cost
Lead Time

Planes Both Sides

Laser Drillable

Add Delete

Polar Sample

Size

[cosnz2

Mote 1

|FR4 Core

|400-022

|FR4

Mote 2

|540.00

|540.00

4.2

Mote 3

0.0195

|41

Mote 4

Mote 5

"
4

22of 29 > =z

OK

The material can be edited or deleted, or a new material can
be added. To speed up the process of adding families of
materials, when a material is added the properties of the last
material are copied to the new material. The details can then
be edited. Clicking OK will add any new materials to the end
of the list.

Importing material to the data tables

Speedstack allows users to add existing material lists to its
library; material data must be arranged in the format and
order used by the Speedstack library.

Library sample files

Sample files for all material types in comma separated value
format and Microsoft Excel spreadsheet and template
formats suitable for importing to the Speedstack are
available on request from Polar Instruments.
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ﬁqm Click the Materials Library button to open the Library, and
Import CSV Library then click Import CSV Library to open the Import dialog.

Import Library
|Inits for Import Delimiter File Type Exaisting Data Table
: |mipaort
* Microns * Comma E?:"E * Clear
C |
" Mils/Thous C Tab PrePrei " Append ﬁ
" Millimetres " (Other SolderMasks
|dents
" Inches Peelables
Coverdays
BondPly
Adhesive
FlexCaores

Choose Clear or Append to Existing Data Table as
appropriate.

Creating a new materials library table

Choose Clear Existing Data Table, click Export Library as
CSV and choose microns as units and the field delimiter type
and click Export. The data table is exported as a “template”.

Open the file in a suitable text file editor — the file below is
opened in Microsoft Excel and shows the file header rows
with the column headers in the order and format expected by
the Speedstack library manager. Add the material data to the
associated columns and save in text format. As noted above,
templates for all materials are available on request from
Polar Instruments.

H - = Foil.csv - Excel
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Muance PDF

A3 vl I
A B T D E F G H ] K L il N
1 |*Foil
2 |*Type Supplier Supplier Description Description Stock Number Cu Thickness Cost Lead Time Motes 1 Motes2 Motes 3 Motes4 Motes5 Size
3 | |
4
3
6

Empty Foils library table

The library import function can accept files in a variety of
formats, tab delimited, comma separated and Excel
worksheet and template formats.
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Sections of the sample files suitable for Speedstack are
shown below.

A B C D E F G H 1
1 "Cores!
2 |* Dielectric Dielectric
3 *Type Supplier Supplier Description Description Stock Number Upper Cu Thickness Lower Cu Thickness Base Thickness Finished Thickness
4 FR4 Polar samples CO/001 FR4 Core 400-001 0.018 0.018 0.05 0.05
5 FR4 Polar Samples CO/002 FR4 Core 400-002 0.035 0.035 0.05 0.05
6 |FR4 Polar samples CO/003 FR4 Core 400-003 0.07 0.07 0.05 0.05
7 |FR4 Polar samples CO/004 FR4 Core 400-004 0.018 0.018 0.075 0.075
8 FR4 Polar Samples CO/005 FR4Core  400-005 0.035 0.035 0.075 0.075
9 |FR4 Polar samples CO/006 FR4 Core 400-006 0.07 0.07 0.075 0.075
10 FR4 Polar samples CO/007 FR4 Core 400-007 0.018 0.018 0.1 0.1
11 |FR4 Polar samples CO/008 FR4 Core 400-008 0.035 0.035 0.1 0.1

Sample Cores library file in Microsoft Excel format

* COres,,u555023030303333023333
*, 1122, 0ielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,,,,,,,,

*Type,Supplier,Supplier Description,Description,Stock Number,Upper Cu Thickness,lLower Cu Thickness,Base Thickness,Finished Thickness,
Content,Tg,Td,CAF Resistance,ZAxisExpansion,ExcessResin,Tolerance,Cost,Lead Time,Notes 1,Notes 2,Notes 3,Notes 4,Notes 5,5ize
FR4,Polar Samples,CO/@@l,FR4 Core,420-001,0.018,0.018,0.05,0.05,4.2,75,180,0,0,0,0,10,0,8,,,,,,*

FR4,Polar Samples,C0/@@2,FR4 Core,400-002,0.035,0.035,0.05,0.05,4.2,75,180,0,0,0,0,10,0,8,,,,,,*

FR4,Polar Samples,C0/@@3,FR4 Core,400-003,0.07,0.07,0.05,0.05,4.2,75,180,0,0,0,0,10,0,0,,,,,,*

FR4,Polar Samples,C0/e@4,FR4 Core,480-004,0.018,0.018,0.875,0.075,4.2,60,180,0,0,0,0,10,0,8

=
219900000

Sample library file in comma separated format

Files for importing into the library must be in the above
format, with columns in the correct order.

Specify the delimiter if necessary and choose the file type
(Foil, RCC, Prepreg, etc.) and units for import and click
Import and Clear or Append as required.

Choose the file from the list displayed in the Open dialog and
click Open. Repeat the procedure for every file type. Save
the file as a .mlbx library file.

Exit the library manager when all file types have been
imported.

Adding material data to an existing library

To add material data to an existing library, open the library
click Import CSV Library, click the Append to Existing Data
Table and click Import.

Choose the .csv or .txt file and click Open. Save the modified
Library file as a .mlbx file.

Selecting Materials from the Library

Column Order (Materials Library)

The default setting displays all columns. The columns
displayed and the order they are displayed can be set in the
materials Library form.
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Arranging Columns in Library Forms
The Library windows can be customised in respect of which
columns to display and in which order.

Columns; the dialog associated with the selected material

nsea Click the Go to Materials Library button and select Arrange
Arrange Columns tab (Foils, Prepregs, etc.) is opened.

Select Prepreg Fields

Selected Columns Available Columns

Supplier ~
SupplierDescription

Description .
Stock Number -
Base Thickness
Finished Thickness Up
DielectricCaonstant
Loss Tangent
ResinContent

Ta

Daown

ddddas

Td Delete
CAFResistance

ZhuisExpansion .
ExcessResin v Clear All

oK | Cancel |

The Left box of the dialog shows the columns that will be
displayed and the order top to bottom is the order they will be
displayed left to right in the library window.

Click OK to return to the Materials Library, which will show
the columns as set.

Until the column order is saved the column order is only

ITITITI available during the current session. Click Save Column

Ad Save Column Order  Order to define the selected column order as the default
order whenever the program is run.

E Load Col ord Click Load column Order to apply a saved column
oad Lolumn Lrder arrangement.

Filtering Materials

When adding or swapping materials, available materials
(Foils, Prepregs, etc.) are listed in the associated material
library dialog. Lists can be filtered for materials matching
desired parameters (dielectric thickness, Er, etc.)

In the library window click the Set Filter to display the Set
‘ﬁ- Filter String dialog.

.Set Filter
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Clear Filter

Set Filter String

Dielectric Finished Thickness ﬂ |:= j |7| |AND j
Field Operand Criteria ANDIOR
» Dielectric Finished Thicknes == 5 AND
Dielectric Finished Thicknes <= 7 (null}
*
Up | Down Delete Row Clear All |

Dielectric Finished Thickness »=5 AND Dielectric Finished Thickness <=7

FinishedThickness == 5 AND FinishedThickness <=7

SaveFilter | Load Filter | oK | cancel |

Filter strings can be created and saved for future use. To
save click Save Filter, to recall an existing filter click the Load
Filter button, choose the filter (.mlf) file and click OK.

Building the filter string

Build the filter string by selecting parameters, operands and
criteria from the drop-down boxes. If the AND/OR box is
selected another row is automatically added to the grid. The
filter language is a sub-set of common database commands.

Use the Up/Down buttons to select a row for deletion. The
arrowhead at the side of the grid indicates the selected row.

Click OK to apply the filter immediately to the selected
library. If desired, save the filter string for future use. (The
Speedstack provides for interaction between the library
dialog and filter form. This allows complex strings to be built
line-by-line and tested without saving until the string is
completed.)

When saving the filter choose a descriptive name for the file
that reflects the purpose of the filter. The Speedstack
automatically names the files for the material type.

Using the Like operator

Use the Like operand to filter results via wild card characters.
The characters * and % can be used to represent groups of
starting or ending characters.

For example, specifying Like ‘Po%’ or ‘Po* as the criterion for
the Suppliers field will show all suppliers beginning with ‘Po’.

Similarly, specifying Like ‘%es’ or “*es’ as the criterion for the
Suppliers field will show all suppliers ending with ‘es’.

Click the Clear Filter to remove the filter and display all
materials of the selected type.
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Locking the library

The materials library can be locked and password
protected to prevent unauthorised or accidental editing. If
no password has been set the Material Library remains
open for any changes and modifications.

Library Lock

To lock the library, click the Library Lock button and supply
a password; the library is then locked and any editing
requires the password to be entered (via clicking on the
padlock). Once unlocked it will remain unlocked until
Speedstack is closed or the padlock is clicked again.
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Printing stackup information

To print the stackup information, choose the Print command.
Print Technical Report includes stack details, controlled
impedance structures — with optional loss frequency graphs
for each structure, drill specifications, bill of materials
information, frequency dependent properties and information
entered into the Stack File Properties.

& Speedstack Report Printer - [m] X
File Options
EiEEE Il Y A Q " oD
ey L] MMM HERN-WE o™ L\ 28 DooiB N
C: Si Prototype 180c1201 Imperial w13 stk Units: Microns : -
n Oneas
Isolation
Base Fimish Copper Isolation | Distance:
Layer Stack up Description Thickness | Thickness | Excess Resin | ResinConlent| Coverage| & | Impedance ID| Distance | (Summed)
I Lo id Pholsimageabie Mask 400
1 F wii] M M A A Copperfoi 17.780 17.780 0.000 1.2
[ PrePreg 1080 76.200 76.200 0.000 60.000 4200 43 530 45530
2 0.000
FR4 Core 0.000 60000 4.200 76200 76200
0.000
= 0 PrePreg 3080 0.000 60000 4.200 70510 3852 552
§ a PrePreg 1651 0.000 47.000 4200 141021 -
T g PrePreg 1651 0.000 47.000 4200 141021 -
4 8 0.000
=3 ﬁ FR4 Core 0.000 46000 4200 304800  304.800
5 g 0.000
= [ PrePre 5 2. 0.000 47.000 4.200 141021 382 552
=l 0 F 5 2, 0.000 47.000 4.200 141021
2 g PrePreg 3080 2 0.000 60000 4.200 70.510 -
3 0.000
FR4 Core 76.200 76.200 0.000 60.000 4.20, 76.200 76.200
7 35560 35560 0.000
i PrePreg 1080 76.200 6.200 0.000 60.000 4.200 49,530 45530
8 PEi W W W W Copperfol 17780 17780 0,000
I Liouid Photolmageable Mask 4.000
Copper Thickness = 248 920 | Dielectric Thickness = 1261.364 | Solder Mask Thickness = 50.800 | Stack Up Thickness = 1510.284 | Stack Up Thickness with Soldermask = 1561.084 |
Stack Up Cost = 54.00 |
Lower | Upper Coating
Trace | Trace Trace Substrate | Substrate Ref. Ref. Above
Structure Target Width | Width | Thickness | 1Height [ 2Height | Plane 1| Plane 2| Subsirale
Image Structure Hame: Impedance | (W1) (wW2) (Ty (H1) (H2) in Layer | in Layer (c1y
l:’ Edge Coupled Coated Microstrip 18 100000 215300 190.500 17780 161290  0.000 3 0 25.400
l;| Coaled Microstrp 18 75.000 114300 88500 17780 161290  0.000 3 0 25400
E Edge Coupled Offset Stripline 1BTA 100080 191970 166570 35550 692912  38ami2 3 6 0.000
E Coated Microstnp 18 75.000 114300 88500 17.780 161290 0.000 [ 0 25.400
Version: Rew Modification: Date of Revision Editor
ted Document:
age
" 1

Speedstack Report Printer toolbar

The Speedstack Report Printer toolbar provides shortcut
access to the most commonly used printing commands.

R E RN E CEHIEET:

Use these commands to set up the printer, page orientation
and margins, font size and printing order, select data columns
for display, display or suppress data tables and choose the
on-screen zoom levels. Button functions are described below.
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3

Send report to printer

Print set up — choose printer, print range, copies

Page set up — orientation and margins

Select stack data columns

Select impedance data columns

eI i -

Select drill data columns

" | Select BOM data columns

Change font size

=
K

Select stack/drills/impedance/notes print order

]

Set note field aliases

:.'.I
_-_'

Toggle suppress stack data table

=

Toggle suppress controlled impedance data table

Toggle suppress frequency dependent loss graphs

=
H? Toggle suppress drill data table

Toggle suppress BOM data table

x‘_"l “'-_1@.

Zoom in / Zoom out
[ |
@ W

Fit page to viewer

D||ee||Bg).
Preview one / two / four pages
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Display Page |'I hd

Display Page select

Speedstack Report Printer menu system

File menu

Use the File menu under the Printing window to save and
load print settings.

Save Print Settings
Load Print Settings

Exit Ctrl+ 0

Whichever settings were last used in a session will become
the default when the Printing window is next loaded.

Options menu

The Speedstack Report Printer Options menu contains all
the settings for printing.

Print Setup

Page Setup

Stack Data Table >
Controlled Impedance Data Table >
Frequency Dependent Loss Graphs -]
Drill Data Table -]
B.Q.M. Data Table >
Footer >

Mote Field Aliases
Print Order
General >

Restore Default Settings
Restore Default Table Fields
Restore Default Table Fields (Legacy)

Print Setup

Use the Print Setup command to choose the target printer,
along with its properties, the range of pages to print and
number of copies. Optionally, click the Print to file check box
to save the output to a file (e.g. to save the file as a
document in PDF format) when printed.
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Page Setup
Page Setup displays the Page Setup dialog to change the
size and orientation, paper source and margins.

Stack Data Table
The Stack Data Table commands allow for optional display
of stack parameters, drills, thickness totals and tolerances.

Suppress

Stack Data Columns...
Show Drills (5tack Table)
Show Thickness Totals
Show Stackup Cost
Show Hatch Profile Data

Show Stackup Thickness...
Show Stackup Thickness Tolerance Value As...
Show Stackup Thickness (Solder mask-5Solder mask)

Show Stackup Thickness (Laminate-Laminate)

Stackup Thickness Decimal Accuracy

Stack Data Columns: select, combine and order the data
columns available for the stack as desired.

g Select Stack Table Columns — | ot
Selected Columns Ayailable Columns
Description < | Supplier ~
Copper Layer Type Supplier Description
Base Thickness » Stock Mumber
Processed Thickness - Type
Resin Contert Min Trace Width
er Up Tolerance
Loss Tangent Tg
Impedance D 0 Td
Finish Thickness Lol Ink Thickness
Copper Coverage Color
Isolation Distance Delete Mask Thickness
Isolation Distance (Summed) Data Filenames
A Cost
Clear All Lead Time o
OK Cancel

The stack data table is displayed in selected column order:
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‘ Description ‘ Type Thickness

Isolation
Distance

Thﬂnnss‘ Resin Content umranp-‘ [} Tll'nln!ss‘ Coverage | Distance

Copperlayer| Base | Processed Finish | Copper | Isolation
Stack up o (Summed)
I i1 Photolmageable Mask 25400 4000 00195
1 £WN AR AR A M CopperFoil Signal 17.780 17.780 1.2 17780 0.000
PrePrag 1080 76200 49530 60.000 4200 00195 76.200 49530 49530
H signal 35,560 35.560 35560 0.000
| FRd Core 76.200 76.200 60.000 4200 00195 76.200 76200 76200
3 | Plane 35.560 35560 35560 0.000
] Prafreg 3080 76.200 70,510 60.000 4200 00195 76.200 70510 352,352
| Prefreg 1651 152400 141021 47.000 4200 00185 152,400 141021 -
] Prefreg 1651 152400 141021 47.000 4200 0.0195 152,400 41021 -
4 ] Signal 35.560 35.560 3 35560 0.000
= | FR4 Core 304800 304800 46000 4200 00195 304.300 304800 304800
5 ] Signal 35.5680 35580 35560 0.000
| Prafreg 1651 152400 141021 47.000 4200 0.0195 152,400 141021 352552
| Frefreg 1651 152400 141021 47.000 4200 00185 152400 141021 -
| Prefreq 3080 76.200 0510 50.000 4200 00195 76.200 70510
& | Flane 35.560 35.560 35560 0.000
| FR4 Core 76.200 76.200 60.000 4200 00195 76.200 76200 76200
7 Signal 35.560 35560 35560 0.000
Prefreg 1080 76200 49530 50.000 4200 00195 76.200 49.530 43530
8 2| W W W W CoperFoll Signal 17.780 17.780 4 17780 0.000
I Liquis Phowimageable Mask 25400 4000 00135

Copper Thickness
Stack Up Cost =

=248 570 | Dielectric Thickness = 1261.364 | Solder Mask Thickness =50 800 | Stack Up Thickness = 1510.284 | Stack Up Thickness with Soldermask = 1561084
S4.00

Use the Dirills (Stack Table) command to show or hide the
drills in the stackup graphic in the Stack Table.

The Thickness Totals provides optional display of the sum of
materials thicknesses, copper, dielectric, solder mask and
the stackup — with and without the solder mask thickness.

Use the Show Stackup Cost option to display the cost in the
stack summary.

Select Show Hatch Profile Data to include the hatch pitch and
width and copper area percentage in the stack summary.

Use the Show Stackup Thickness commands to display or
hide the target or calculated values of total stack thickness.

Values can optionally include solder mask and laminate
thicknesses.
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When the target value of the Stackup thickness is chosen the
Stackup Thickness Tolerance values can be displayed as
percentages of the target stack thickness or as actual values.

Choose Stackup Thickness Accuracy to display accuracy by
number of decimal places.
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Controlled Impedance Data Table
Use the Controlled Impedance Data Table options to show or
hide the controlled impedance structures and parameters.

Suppress

Impedance Data Columns...
Show Structures-by-Layer Separator
Sort Structures in SE/Diff Order Per Layer

Impedance Data columns can be selected for display and
ordered as required. Choose the parameters for display from
the Available Columns pane and change the order of display
using the Up and Down buttons.

g% Select Controlled Impedance Table Columns — O >
Selected Columns Ayvailable Columns
Structure Image = Impedance 1D ~
Structure Name Impedance Signal Layer
Target Impedance . Broadside 2nd Layer
Lower Trace Width (W1) o Trace Separation (51)
Upper Trace Width (W2) Trace Pitch (S1+ W1)
Trace Thickness (T1) Up Lower Ground Strip Width {G1)
Substrate 1 Height (H1) Upper Ground Strip Width {G2)
Substrate 2 Height (HZ) D Trace Offset {01)
Ref. Plane 1in Layer Lol Ground Strip Separation (D1)
Ref. Plane 2in Layer Calculated Impedance
Coating Above Substrate (C1) Delete Tol {+/- %)
Substrate 3 Height (H3)
R Substrate 4 Height (H4)
L= Substrate 1 Dielectric (Er1) v
OK Cancel

Grouping structures by layer

Within the Impedance Data Table structures can be grouped
by layer; choose Show Structures-By-Layer Separator. The
Separator will add a black structure separator bar on the
print out between structure groups, allowing the structures to
be sorted by layer number rather than the order that the
structures are added to the stack.

Lower | Upper Coating
Trace | Trace Trace Subsirate | Subsirate Ref. Ref. Above
Structure Target Calculated | Width | Width | Thickness | 1Height | 2 Height | Plane 1 | Plane 2 | Substrate
Image Struciure Name Impedance | Impedance | (W1) {wa2) {T1) {H1) (H2) in Layer | in Layer {C1)
Coated Microstrip 128 75.000 75870 114.300 B8.500 17.780 161.250 0.000 3 o 25.400
100,000 100,350 213,800 120,000 17,780 161.250 D000 d o 23400

: sdge Coupled Coated Mirasing 1B
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Sorting impedance structures by type
The technical report, by default, prints the structures within a
layer in the order in which they were added to the stack.

In the example stack below the structures were added to the
stack in the order shown.

Lower Upper
Impedance Ref. Ref. Trace Trace Trace
Impedance | Structure Signal Plane 1 | Plane2 | Width Width | Separation T
[+ Image Siruclure Mame Layer in Layer | in Layer| (W1} {W2) 151} Imip

1 E Edge Coupled Coatad Microstrip 18 1 3 a 4.500 7.500 B115 100
E Coated Micrastrip 18
E Coated Microstrip 18
E Edge Coupled Coated Microstrip 18 1 3 ] 12.542 11.542 10.000

Structures within each layer can be grouped by type, single
ended and differential.

1 3 ] 4.500 3.500 0.000

1 3 Q 11476 10476 0.000

To sort the structures by type choose the Sort Structures by
SE/Diff Order per Layer; the structures within each layer will
be ordered in single ended then differential order as shown
in the graphic below.

Lower Upper
Impedance Ref. Ref. Trace Trace Trace

Impedance | Structure Signal Plane 1 | Plane2 | Width | Width | Separation T
[ Image Struclure Name Layer in Layer | in Layer | (W1} {W2) (51) Imip
2 Coatad M ip 1B 1 3 0 4.500 3.500 0.000 75.0

Coated Micrastrip 1B 1 3 a 11.476 10,476 0.0

Edge Coupled Coated Microstrip 18 1 3 a a.500 7.500 B.115

Edne Coupled Costed Microstrip 1B 1 3 ) 12.542 11.542 10.000
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Frequency dependent loss graphs

Speedstack Si provides graphing and tabular display of the
frequency dependent properties of each controlled
impedance structure in the stackup. The technical report
includes the option of displaying the loss v frequency graph
of every structure in the stackup — see below.

C:\Program Files (6)! 7.56i Units: Mils.

Offset Stripline 1B1A

Length of Line: 1000 Freq(Hz) | RefEr | RefTanD Surface 1 Roughness (RMS)} R1:0.2 Frequency of Interest: 1000 MHz
Trace Conductivity: S 8E+07 Sim  [H1 TO00E+0S _[4:2000 00755 Surface 2 Roughness (RMS) R2: 0.2 Conductor Loss: -7.465€-02 dBlline
Freguency Minimum: 500 MHz HZ 1.000£208 42000 0.0185 Surface 3 Roughness (RMS) R3: 0.2 Dielactric Loss: -9.312E-02 dBlline
Frequency Maximum: 10 GHz Hi Surface 4 Roughness (RMS) R4: 0.2 Atienuation: -1.678E-01 dBline
Frequency Steps: 20 REF Conductor Loss with Roughness: -1
cEr Atienuation with Roughness: -2.022

02

2.04

-d8

06

S

”Hi oy

All Losses with Roughness

xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
1000 2000 3000 4000 5000 6000 7000 8000 900
Frequency - MHz

When the technical report is selected for print Speedstack
recalculates and displays the loss v frequency for the
frequency dependent properties of each structure in the
stackup.

The display for each structure includes the structure graphic
and the associated frequency dependent parameters, the
substrate causal extrapolation reference points, the surface
roughness method and settings and the losses and
attenuation at the user defined frequency of interest.

From the Options menu, choose Frequency Dependent Loss
Graphs|Suppress to toggle display of frequency dependent
loss graphs and tables.
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Drill DataTable
Use the Drill Data Table command to show or hide the table
of drill parameters and to select and order parameter values

for display.
g Select Drill Table Columns — | 4
Selected Columns Loszilable Columns
Drill Image: < Fill Type
1st Layer Hole Count
2nd Layer . Different Hole Sizes
Column Position - Minimum Size
Crill Type Data Filenames
Up
Down
Delete
Clear All
QK Cancel
Use the Sort Dirills... command to order the drill table — drills
can be sorted by start-end layer order or creation order.
Drill Data Table J Suppress
Drill Data Coelumns...
Sort Drills... r Creation Order
Start - End Layer Order
Bill of Materials Table
Speedstack’s Technical Report incorporates the Bill of
Material (BOM) table with the stock-number displayed
optionally as a barcode. The table contains fields for Total
Quantity (No. Panels * Stack Quantity) and Total Cost (Unit
Cost * Total Quantity.)
Supgplier Stack Total
Suppli Descripti Description Type Stock Humber | Quantity | Unit Cost| Stack Cost| Quantity| Total Cost
Folar Samples SM007  Liguid Photoimageable Mask  SoldertMask |||||I|||| z 0,00 0.00 z 0.00
Polar Samples FOM0 Copper Foil Copper IIIII .IIII 2 1.00 2.00 2 2.00
Folar Samples PPID01 PrePreg 1080 Diglectric |||||l|||| 2 1.00 2.00 2 2.00
Folar Samples Co/00s FR4 Core Frd |||||||||| 2 5.00 10.00 2 10,00
Folar Samples FPIDOZ FrePreg 3080 Dielectric l“ll lll'l 2 2,00 4.00 2 4.00
Folar Samples PPID04 FreFreg 1651 Dislectric |||I|l|||| 4 400 16.00 4 18.00
Polar Samples comzo FR4 Care Fre AN 1 20,00 20.00 1 20,00
54.00 =00

Ho. of Panels = 1 | Circuits Per Panel = 1 | Price Per Circuit = 54.00 |
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The table includes totals for the Stack Cost and the Total
Cost columns.

A summary section presents 3 values: No. of Panels, Circuits
Per Panel and Price Per Circuit. The No. of Panels and
Circuits Per Panel can be entered by the user at any time or
optionally at the start of each print session.

From the Options menu choose B.O.M. Data Table |
Panels / Circuits per Panel...

B.0.M. Data Table ¥ Suppress

Stock Mumber H]
Panels / Circuits per Panel...

— O >
Enter the following data required for the Bill of Materials
[BEOM] table.
Mumber of Panels |i]
Circuits per Panel |1

| Always show this at the start of a print session
Ckay

Price Per Circuit is a calculated value (Total Stack Cost /
Circuits Per Panel).

Bill of Materials Table columns can be selected for display
and ordered as required. Choose the parameters for display
from the Available Columns pane and change the order of
display using the Up and Down buttons.

g= Select Bill of Materials Table Columns — O x
Selected Columns Awailable Columns
Supplier «

Supplier Description
Description .
Type s
Stock Mumber
Stack Quantity Up
Unit Cost
Stack Cost o
Total Quantity o
Total Cost

Delete

Clear All

OK Cancel
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From the Options menu choose B.O.M. Data Table to display
or suppress the table. The Suppress command toggles the
B.O.M. table on and off in the report.

B.0.M. Data Table » Suppress
Stock Number » | ¥ Show as Barcode
Panels / Circuits per Panel... Barcode Font and Start,

Stock numbers can be displayed in alpha-numeric form or as
barcodes. Choose Stock Number|Show as Barcode to toggle
the Stock Number display between barcodes or alpha-
numeric text.

Stack

Description Type | Stock Number | Quantity | Unit Cost
Liquid Photolmageable Mask - SolderMask {1 Il 2 0.00
Copper Foil - Copper [ [N 2 1.00

PrePreg 1080 Dielectric [ [F NI 2 1.00

FRé Core FRa IO 2 5.00

Prefreg 3080 - Dietectric | IIII 2. 200

PrePreg 1651 Dielectric [ [F I 4 4.00

FRé Core PR I T 2000

Choosing the bar code font

From the Stock Number command choose Barcode Font and
Start/Stop Character. The Select Barcode font and Start/Stop
Marker Characters dialog is displayed.

8 -
9
10
11
Angsana New
AngsanallPC 13
Aparajita 14
Arabic Typesetting 15
Arial 16
Arial Black i 17 %,
3 of 9 Barcode 12
Include Stop / Start Character
" None
(¥ Asterisk -~
" Exclamation - !
" Other
Reset Close

Choose the font and font size and the start / stop character
as appropriate. (The barcode font must already installed on
the host computer.)

Printing stackup information e 165



Choosing the start/stop character

The Start/Stop character is a requirement for certain barcode
types such as Code 39 (also referred to as Code 3 of 9,
Code 3/9, Type 39, etc.) The Code 39 asterisk character is
normally reserved as a start/stop character rendering the
data a valid barcode.

As an example, if the Stock-Number is 123-456, selecting
the Asterisk option will add enclosing asterisks to the Stock-
Number so that the barcode is valid.

(In some instances asterisks may already be included in the
Stock-Number in which case choose the None option.)

There are other situations where another character may be
used. Exercise caution when determining the appropriate
font choice and start/stop character to use. In the event that
an inappropriate font is chosen, the results may be
unpredictable.

Footer
The report footer section is an optional item and may be
displayed or suppressed (hidden).

Footer > Suppress

Enable Expanded Footer

Ovwerride Footer Label...

Suppressing the footer

When the Footer section is suppressed the space is used for
other data, often reducing the number of pages required for
the technical report.

Version: vises  [Rewsen Wodiicaton Date of Revision. | Editor
=so0i5ted Documents: Revel |cel TDec 2018
Rev#2 |Data et TApra0ie I8 e

@

E
[}
Aut
D
Si

Using the expanded footer
Use the Expanded Footer option to allow longer and more
descriptive stack names to be displayed.

StackName: Controller M-Board MWFD1836

Wersion: V19.05 Associated Documents: Revision: | Modification

Date: 12 June 2018 Reawv #1 Call
Author: B Johnson Rev #2 Data Met
Department Eng
Site: North Side

Overriding the footer labels
The labels in the footer may be changed to reflect the
stackup design workflow and organisational structure.

Choose Footer | Override Footer Label...
The Override Footer Labels dialog is displayed:
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HE Override Footer Labels — O >

Owerride the labels shown in the footer of the printout

‘Yersion

Drowing ol

Date

Author
|Designer

Department

Site
|0Hice

Clear Okay

The new labels will be reflected in the footer:

Crrawing Mo:| 15.03
Date: 12 June 20189
Eesigner:l B Johnson

Cepartment Eng
Office:| North Side

Note Field Aliases

Note Field Aliases allows for the free-text note fields (for the
Stack and Controlled impedance tables) to be given
descriptive names.

Print Order

Use the Print Order dialog to move the Controlled
Impedance Table, Drill Tables and Notes sections up or
down within the report.

Print Order —

Stackup Table P
Controlled Impedance Table
Drills Table Down
Bill of Materials (B.0.M.) Table
Motes
Motes

Restare

i

Close

Note: the Stack/Materials data Table cannot be reordered
and must remain the first item in the print order.

Printing stackup information e 167



General options
Use the General Options to specify

Polar Logo 2
User Logo 3
Copyright 3
Data Mumber Format k
Data Alignment 2
Stack Alignment (Flex-Rigid only] k
Font Size k
Colours

File Path 3
Margin Guides 3

Polar Logo: toggles on and off the Polar Instruments logo.

User Logo: toggles on and off the user-defined logo (as set
in the application configuration).

Copyright: toggles on and off the copyright information and
allows copyright test to be edited.

Data Number Format: sets the precision of numeric data in
the printout.

Data Alignment: specifies alignment (left, centre, etc.) for
stack, impedance and drill data.

Stack Alignment (Flex-Rigid only): — Align to Master Stack
allows the vertical position of sub-stacks (printed on separate
pages within the report) to be preserved with respect to the
master stack; Align to Page Top presents each sub-stack at
the top of each page.

Colours: allows for the colours of items within the report to be
customised. Click Override Default Colours and Change to
specify the new colour. Click Reset All to return to the default
colours.

File Path: toggles on and off the file path/file name

Margin Guides: toggles on and off boundary markings (in the
user selected units.) These match the Speedstack units
selected within the Stackup Editor | Units menu.

The margin guides allow for display of the printable area of
the page — which can vary depending upon the device —
even though the page size remains the same. (With some
devices the report cannot use the full extents of the page.)
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